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Kitabda Mathcad-11, MATLAB-7, Scientific Work 
Place 5.0 proqram paketləri haqqında məlumat verilmiş, bu 
paketlərin riyaziyyatın ayrı-ayrı sahələrinə tətbiq etmək üsulları 
şərh olunmuşdur. Kitabda həmçinin, iki və üçölçülü koordinat 
sistemlərində qrafiklərin qurulması, beynəlxalq nəşriyyat 
sistemi-LATEX əsasında elmi məqalələrin, kitabların hazır-
lanması, tələbəlrin biliyini qiymətləndirmək üçün elektron 
testlərin yaradılması üsulları şərh olunmuşdur.    
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Unudulmaz  insanlar‐Əli və Əsgər 
Hüseynovların əziz xatirəsinə ittihaf olunur. 

 

 
GİRİŞ 

 
Riyaziyyat, fizika, geologiya, astronomiya və digər 

təbiət elmlərinin nəzəri porblemlərinin həlli zamanı, mühəndis-
texnoloji və iqtisadi layihələrin hazırlanması prosesində çox 
zaman həlli yalnız ədədi üsullarla mümkün olan riyazi məsələr 
həll etmək, böyük həcmli hesablamalar aparmaq zərurəti 
meydana çıxır.  Əvvəllər bu tip məsələrin həlli tədqiqatçıdan 
ədədi üsulları bilməklə yanaşı, mütləq  müəyyən alqoritmik 
dildə proqramlar tərtib etmək bacarığı tələb edirdi. Bundan 
əlavə, bir məsələnin həlli üçün saatlar, bəzən də günlər tələb 
olunurdu. Bu gün isə, hər bir şəxs  xüsusi tətbiqi proqramlar-
riyazi proqram paketləri vasiətsilə ən mürəkkəb riyazi 
məsələləri qısa bir müddətdə həll edə bilər.  

Riyazi proqram paketlərinin yaradılmasına keçən əsrin  
70-ci illərinin sonlarında başlanmışdır. Onlar təkmilləşərək bu 
gün alimlərin, mühəndislərin, tələbələrin,  iqtisadçi 
menecerlərin  və əqli əməklə məşğul olan digər peşə 
sahiblərinin avtomatlaşmış  işçi yerlərinə çevrilmişlər. Riyazi  
proqram paketlərindən istifadə etməklə nəinki müxətlif riyazi 
məsələlər, o cümlədən, kvant mexanikası, idarəetmə, qeyri-
səlis çoxluqlar, kütləvi-xidmət nəzəriyyələrinin, statistika   
məsələrini həll etmək olar, həmçinin məqalələr, elektron 
kitablar və tədris prosesində istifadə olunan öyrədici sistemlər 
yaratmaq mümkündür. Bu sahədə kifayət qədər xarici 
ədəbiyyatın olmasına baxmayaraq, təəssüf ki, Azərbaycan  
dilində tədris vəsaiti, kitablar yox dərəcəsindədir. Təqdim 
olunan  «Riyazi proqram paketi» adlı dərs vəsaiti bu sahədə 
informasiya  qıtlığını xeyli azaldacaqdır. 
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Dərs vəsaiti müəlliflərin,  Bakı Dövlət Universitetinin 
«Mexanika-riyaziyyat» fakültəsində «Elmdə və təhsildə 
kompüter texnologiyası» fənni üzrə təhsil alan  magistrlər üçün 
oxuduqları mühazirələr əsasında hazırlanmışdır və üç fəsildən 
ibarətdir. Birinci fəsildə oxucular Mathcad proqram paketi ilə 
tanış olacaq, paketin riyaziyyatın ayrı-ayrı sahələrinə tətbiq 
etmək üsullarını, hesablamaların nəticələrinin qrafiki və mətn 
sənədləri şəkilində hazırlanması  və s. üsulları ilə tanış 
olacaqlar. İkinci fəsil  MATLAB 7 proqram paketinə həsr 
olunmuşdur. Bu fəsillə tanış olan oxucular paketi öz elmi 
fəaliyyətlərində  geniş tətbiq edə biləcəklər. Üçüncü fəsildə isə 
elmi məqalələrin hazırlanması üçün geniş istifadə olunan 
Scientific Work Place 5.0 proqram paketi şərh olunmuşdur. Bu 
paket beynəlxalq nəşriyyat sistemi-LATEX əsasında elmi 
məqalələrin, kitabların hazırlanmasını təmin edir. Qeyd edək 
ki, dünyanın aparıcı nəşriyyatları, əksər elmi jurnalların 
redaksiyaları yalnız bu sistemdə hazırlanmış materialları nəşr 
üçün qəbul edir. Buna görə də, hesab edirik ki, Scientific Work 
Place 5.0 paketinin iş prinsipilə  tanışlıq tələbələrlə yanaşı, 
elmi fəaliyyətlə məşğul olan geniş oxucu kütləsi üçün də 
gərəkli  olacaqdır. 

  «Riyazi proqram paketi»  dərs vəsaiti olduğundan 
mövzular tədris proqramına, tələbə və magistrlərin ixtisas 
yönümünə uyğun şərh olunmuşdur. Ona görə də şərh olunan 
paketlərin bir sıra əlavə imkanları haqqında  məlumat 
verilməmişdir. Oxuculardan bunu nəzərə alımağı  xahiş edirik.     
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FƏSİL 1 
 
 

MATHCAD 12 PROFESSIONAL 
 

Mathcad riyazi proqram paketi 1988-ci ildə Math Soft 
Inc firması tərəfindən riyazi məsələlərin ədədi üsullarla həll 
etmək üçün yaradılmışdır. 1994-cü ildə Maple paketinin 
simvolik hesablama vasitələrinin Mathcad paketinə 
inteqrasiyası və paket üzərində edilən təkmilləşmələr 
nəticəsində o, bu gün geniş istifadəçi kütləsinin: şagird, tələbə, 
müəllim, elmi işçi, mühəndis texnoloqların, iqtisadçı 
menecerlərin və s.əməyini avtomatlaşdıran və yüngülləşdirən 
əvəzolunmaz bir vasitəyə çevrilmişdir. Digər riyazi proqram 
paketlərindən fərqli olaraq, paket WYSIWYG (What You See 
Is What You Get1)  prinsipi əsasında yaradılmışdır və 
məsələnin qoyuluşu ənənəvi riyazi yazılışla-riyaziyyatda qəbul 
edilmiş işarələrin köməyi ilə təsvir edilir.  Məsələ  analitik və 
ya ədədi  üsullarla həll edilir.  

Mathcad 12 Professional  paketi inteqral sistem olub, 
özündə hesablama prosessoru ilə yanaşı mətn, düstur, qrafiki 
redaktorları birləşdirir. Bunun nəticəsində proqramdan  
hesablama məqsədilə yanaşı, çap məhsullarının, elektron 
kitabların və hipermətn sənədlərin yaradılmasında geniş 
istifadə olunur. Qeyd edək ki, Mathcad-la nəinki hesablamalar 
aparmaq, həmçinin teorem və lemmalar isbat etmək olar. Bu 
keyfiyyət onu riyaziyyatın tədrisində öyrədici sistem və distan 
təhsil vasitəsi kimi əvəzsiz edir. 

 
                                                           
1 Azərbaycan dilinə tərcümədə «Nə edirsən, onu da görürsən» deməkdir  
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1.1 MATHCAD 12 PROFESSIONAL: ƏSAS 
ANLAYIŞLAR VƏ İNTERFEYS  ELEMENTLƏRİ. 

 
Mathcad Professional 12 bütün Windows əlavələri kimi 

Baş menyunun Proqramlar bölməsinin Mathsoft Apps proqram 
qrupunun Mathcad Professional 12 əmrini yerinə yetirməklə 
və ya kursoru İşçi stolda yerləşən proqram yarlığının üzərinə 
qoyub siçanın sol düyməsini iki dəfə sıxmaqla yüklənir. Bu 
zaman ilk öncə ekranda proqramın «loqotipi», sonra isə əsas 
interfeys pəncərəsi açılır (şək.1.1-1). 

 
şək.1.1-1 

Mathcad Professional 12 olduqca sadə və Windows 
əlavələri üçün vahid standart interfeysə malikdir.  Belə ki, 
proqramın əsas interfeys pəncərəsi aşağıdakı elementlərdən 
ibarətdir:  

Başlıq sətiri; 
Menyu sətiri; 
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Standart alətlər və formatlaşma paneli; 
Xüsusi alətlər panelləri; 
İşçi sahə; 
Cari vəziyyət sətiri.  
Başlıq sətiri vasitəsilə proqramın interfeys pəncərəsini 

bağlamaq, bütün ekran boyu böyütmək və ya normal ölçüsünə 
nail olmaq, qapamaq və  ekranda yerini dəyişmək olar.  

Proqramın «intellektual» imkanları menyu sətiri və 
alətlər panelləri vasitəsilə reallaşır. Menyu sətiri 9 ədəd 
menyudan: File (Fayl), Edit (Redaktə), View (Görünüş), 
İnsert (Daxiletmə), Format(Format), Math (Riyazi), 
Symbolics (Simvollar) Window (Pəncərə), Help (Arayış) 
menyularından ibarətdir. Hər bir menyu əmrlər sistemindən 
ibarətdir. Bəzi menyular iyerarxik sistemə malikdir. Belə ki, 
menyunun   işarəsinə malik əmrini yerinə yetirdikdə 
altmenyu açılır. Bundan əlavə, paket kontekst menyu sisteminə 
də malikdir.  

Konkret alətlər panelinin  ekranda əks olunması  View  
menyusunun Toolbars əmrini yerinə yetirdikdə açılan 
altmenyuda müvafiq alətlər panelini aktivləşdirməklə 
tənzimlənir. Xüsusi panellərin  ekranda əks olunması Math 
panelinin müvafiq alətləri vasitəsilə də təmin edilir. Xüsusi 
panellər «sürüşkən» olub, ekranda istənilən yerdə yerləşdirilə 
bilər. Bunun üçün kursoru panelin başlıq sətirinin üzərinə 
qoyub siçanın sol düyməsini sıxmaqla hərəkət etdirmək 
lazımdır. Siçanın sıxılmış düyməsini buraxdıqda alətlər paneli 
ekranda yeni yerdə bərqərar olacaqdır. Alətlər panelinin  
düyməsini sıxmaqla alətlər panelini gizlətmək olar. Alətlər 
panelinin ekrandan «gizlədilməsi» həmçinin kontekst 
menyunun Hide əmri vasiləsilə də təmin olunur. Qeyd edək ki, 
Standart və Formatlaşma panelinin alətlərinin sayını istifadəçi 
öz tələbatına uyğun tənzimləyə bilər. Belə ki, istifadəçi kursoru 
panelin üzərinə qoyub, siçanın sağ düyməsini sıxdıqda açılan 
kontekst menyunun Customize əmrini yerinə yetirməklə açılan 
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dialoq pəncərəsində (şək.1.1-2) yeni alətlər əlavə edə bilər və 
ya qeyd olunmuş aləti paneldən ləğv edə bilər.  

 
şək.1.1-2 

Proqramın interfeys pəncərəsinin işçi sahəsində sənəd 
pəncərəsi əks olunur1. Proqram yükləndikdə adətən, ilk öncə 
sənəd pəncərəsinin mərkəzində istifadəçini  proqramın 
imkanları ilə tanış etmək üçün nəzərdə tutulmuş Tip of Day 
dialoq pəncərələr sisteminin ilk pəncərəsi əks olunur2. 
İstifadəçi Mathcad haqqında informasiya ilə tanış olmaq üçün 
Next düyməsini, dialoq pəncərəsini bağlamaq üçün isə Close 
düyməsini sıxmalıdır. Sənəd pəncərəsi öz növbəsində başlıq 
sətirinə, üfüqi və şaquli səhifə sürüşdürücülərinə və 
istifadəçinin təlabatından asılı olaraq  xətkeşə malikdir3. Sənəd 
pəncərsində riyazi hesablamalar, mətn və qrafiki informasiyalar 
əks olunur. Proqram informasiyaya müxtəlif miqyasda 
baxmağı təmin edir. Bunun üçün  View →Zoom əmrini yerinə 
yetirib, açılan pəncərədə miqyas vahidini seçmək lazımdır. 
                                                           
1 Sənəd pəncərəsi avtomatik olaraq proqram yükləndikdə və ya istifadəçi 
tərəfindən açılır.  
2 Proqramın sonrakı yüklənmələri zamanı onun ekranda əks olunmamasına 
nail olmaq üçün Show Tips on Startup parametrini qeyri-aktiv etmək 
lazımdır. 
3 View →Ruler əmri vasitəsilə xətkeşin sənəd pəncərəsində əks olunması 
tənzimlənir. 
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Cari vəziyyət sətiri isə yardımçı informasiyanın əks 
olunmasına xidmət edir və onun ekranda əks olunması View → 
Status Bar əmri vasitəsilə tənzimlənir. 

Mathcad 12 Professional riyazi proqram paketi olduğuna 
görə onun əsas hesablama obyekti riyazi ifadələrdir. Riyazi 
ifadələr dəyişənlər, sabitlər və funksiyalardan istifadə etməklə 
operatorlar vasitəsilə tərtib olunur. Onlar sənədə klaviaturadan 
və ya alətlər panelindən istifadə etməklə daxil edilir. Mathcad-
da bu məqsədlə  Evalution, Matrix, Calculus, Calculator, 
Boolean alətlər panelləri nəzərdə tutulmuşdur.   

Dəyişənin adına ədəd və ya ifadə mənimsətmək üçün 
dəyişəni sənədə daxil etdikdən sonra Calculator və ya 
Evalution alətlər panelərlinin := alətini və ya «Shift+:»  qızğın 
düyməsini sıxmaq lazımdır1. Dəyişənin adı həmişə hərflə 
başlamalıdır2 və bunun üçün riyaziyyatda qəbul olunduğu kimi 
əsasən latın və ya yunan  əlifbasından3 istifadə olunur. Qeyd 
edək ki, paket dəyişəni onun adındakı böyük və kiçik hərflərə, 
hərfin şriftinə görə fərqləndirir. Belə ki,  paket M, m , m  və m  
dəyişənlərini   müxtəlif dəyişən kimi qəbul edir. Dəyişənin 
aldığı qiymətlərə uyğun olaraq onlar ədədi, sətir, indeksli, 
diskret və s. tiplərə  bölünürlər. İndeksli dəyişənlərə massivlər  
aiddir. Diskret  dəyişənlər müəyyən  addımla artan qiymətlər 
alır. Dəyişənlər həmçinin  ölçü vahidinə də malik ola bilərlər. 
Paketdə həmçinin bir sıra sistem dəyişənləri, o cümlədən  Tol, 
Ctol4, Origin5 və s. nəzərdə tutulmuşdur.  

                                                           
1 Mənimsətmə işarəsinin çap məhsullarında adi bərabərlik formasında  əks 
olunması üçün kontekst menyunun View Definition As → Equal əmrini 
yerinə yetirmək lazımdır 
2 Dəyişənlərin adı olaraq standart funksiyalar, xüsusi sözlər (məs.: Tol, ölçü 
vahidləri, For , if və s.) istifadə oluna bilməz. Dəyişənin adı həmçinin  “” 
işarəsi ilə də başlaya bilər. 
3 Yunan əlifbasından istifadə etmək üçün Greek alətlər paneli nəzərdə 
tutulmuşdur. 
4 Tol, Ctol dəyişənləri hesablamanın dəqiqliyini təyin edir. 
5 ORİGİN dəyişəni massivin başlanğıc indeksini müəyyən edir.  
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Mathcad həqiqi, kompleks, tam, rasional ədədlərlə 
işləməyi təmin edir. Həqiqi ədədlər müxtəlif formatda: 
sürüşkən vergüllü, mühəndis, eksponensial formatda daxil 
oluna bilər. Həqiqi ədədlər 307 30710 10  intervalında dəyişir. 
Kompleks ədədlər riyaziyyatdan məlum yazılış formasında 
daxil olunur. Kompleks ədədin xəyali vahidi  i və ya j hərfi ilə 
işarə olunur. Ədədlər həmçinin səkkizlik və on altılıq say 
sistemində ola bilər. Səkkizlik say sistemində  ədədin 
yazılışının sonunda «O»,  on altılıq say sistemində isə ədədin 
yazılışının sonunda «H» və ya «h» işarəsi  olmalıdır.  

İstifadəçi tərəfindən təyin olunan funksiyanı sənədə daxil 
etmək üçün ilk növbədə funksiyanın adını və mötərizədə 
arqumentini, sonra «:=» işarəsini və riyazi ifadəni daxil etmək 
lazımdır. Standart funksiyalar isə İnsert→Function əmrini 
yerinə yetirməklə açılan dialoq pəncərəsinin funksiya 
siyahısından İnsert düyməsini sıxmaqla daxil olunur. Qeyd 
edək ki, funksiya siyahısında funksiyalar aşağıdakı 
kateqoriyalar üzrə qruplaşmışdır, bu isə tələb olunan 
funksiyanın seçilməsini asanlaşdırmaq məqsədi daşıyır: 

Bessel – Bessel funksiyaları; 
Complex Numbers –Kompleks ədədlərlə iş üçün;  
Differential Equation Solving – Diferensial tənliklərin həlli 
üçün; 
File Access – Fayllarla işləmək üçün; 
Fourier Transform – Furye çevrilməsi üçün;  
Hyperbolic – Hiperbolik funksiyalar; 
Image Processing –  Şəkillə işləmək üçün; 
Interpolation and Prediction – İnterpolyasiya və 
proqnozlaşdırma funksiyaları;  
Log and Exponential – Loqarifmik və eksponensial 
funksiyalar; 
Number Theory / Combinatorics – Ədədlər nəzəriyyəsi və 
kombinatorika funksiyaları; 
Piecewise Continuous – Şərt və pillə funksiyaları; 
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Solving – Cəbri tənlik və sistemlərin həlli üçün; 
Special – Xüsusi funksiyaları; 
Statistics – Statistik funksiyaları; 
Triqonometric – Triqonometrik funksiyaları; 
Vector and Matrix – Vektor və matrislərlə işləmək üçün. 

 
 
 
1.2 SƏNƏDİN YARADILMASI VƏ YADDAŞDA 

SAXLANILMASI 
 

Yeni sənəd avtomatik olaraq proqram yükləndikdə 
açılan boş sənəd pəncərəsində yaradılır. Sistem sənədi şərti 
olaraq Untitled:1 adlandırır. Mathcad  ilə seans müddətində 
yeni sənəd  «Ctrl+N» düyməsini sıxdıqda və ya standart alətlər 
panelinin ilk alətini sıxdıqda açılan boş sənəd pəncərəsində 
yaradılır. Bundan əlavə sənəd MS Word proqramında olduğu 
kimi şablon əsasında da yaradıla bilər. Bunun üçün File→New 
əmrini yerinə yetirmək və bu zaman açılan New dialoq 
pəncərəsində  əks olunan müvafiq sənəd şablonunu şablonlar 
siyahısından seçib OK düyməsini sıxmaq lazımdır.  Qeyd edək 
ki, proqram yükləndikdə,  standart alətlər panelinin ilk 
düyməsini  sıxdıqda açılan yeni sənəd pəncərəsi Blank 
Worksheet şablonu əsasında yaranır.  
  Sənəd hesablama, mətn və ya qrafiki tip bloklardan 
təşkil edilə bilər. Hər bir blok düzbucaqlı çərçivə ilə əhatə 
olunmuşdur.1 
  Mətn blokunda mətn tipli informasiya əks olunur. Mətn 
bloku daxil etmək üçün İnsert→Text Region əmrini yerinə 
yetirmək və ya «Shift+“» qızğın düyməsini sıxmaq lazımdır. 
Bu zaman ekranda mətn blokunun çərçivəsi əks olunur ki, 
istifadəçi bura mətni klaviaturadan daxil edə bilər və ya 
mübadilə buferindən «Ctlr+V» qızğın düyməsini sıxmaqla və 
                                                           
1 Kursor blokdan kənarda yerləşdikdə çərçivə ekranda əks olunmur. 
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ya Edit→Paste əmrini yerinə yetirməklə daxil edə bilər. Mətn 
daxil edilməzdən əvvəl Format→Style əmrini yerinə yetirmək 
və açılan pəncərədən  mətn üçün tələb olunan stil formasını 
seçmək məsləhətdir. Əgər təqdim olunan stillər istifadəçini 
qane etməsə, o, pəncərənin Modify düyməsini sıxmaqla açılan 
növbəti Define Style pəncərəsində Font düyməsini sıxıb, şriftin 
növünü, ölçüsünü, rəngini və effektlərini müəyyən edə bilər. 
Bu zaman daxil olunacaq mətn seçilmiş stildə nəzərdə tutulmuş 
parametrlər əsasında olacaqdır. Çox zaman praktikada mətn 
daxilində riyazi düsturlardan istifadə etmək tələb olunur. 
Bunun üçün İnsert→Math Region əmrini yerinə yetirmək 
lazımdır. Bu zaman düstur şablonuna uyğun kiçik qara rəngli 
kvadrat əks olunacaqdır və istifadəçi onun daxilində riyazi 
düsturu, tənliyi, bərabərsizlikləri və s. yaza bilər. Qeyd edək ki, 
informasiya daxil olunduqca blokun ölçüləri informasiyanın 
həcminə uyğun böyüyəcək. 

Hesablama blokunda riyazi ifadələr, tənliklər, 
bərabərsizliklər, standart və istifadəçi tərəfindən müəyyən 
olunan funksiyalar və hesablamanın nəticələri əks olunur. 
Qrafiki blokda isə sənədə daxil olunan və bmp genişlənməsinə 
malik şəkillər, hesablamanın nəticəsinin və funksiyaların 
qrafikləri əks olunur.  

Yaradılmış sənəd çoxsəhifəli ola bilər. Qeyd edək ki, 
yeni səhifəyə keçid avtomatik olaraq informasiyanın həcmi 
çoxaldıqda baş verir. Məcburi olaraq yeni səhifəyə keçid isə 
İnsert→Break əmri vasitəsilə təmin olunur. Çoxsəhifəli 
sənədin səhifələrinin nömrələnməsi və kolontitulların daxil 
olunması üçün Format→Headers/Footers əmrini yerinə 
yetirmək lazımdır. Əmr sənədə səhifənin yuxarı və aşağı 
hissəsində nömrə və kolontitulların daxil edilməsini təmin edir. 
Əmri yerinə yetirdikdə açılan dialoq pəncərəsinin Header 
bölməsi səhifənin yuxarı hissəsində, Footer bölməsi isə 
səhifənin aşağı hissəsində kolontitul və nömrə daxil edilməsini 
təmin edir (şək.1.2-1).  
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şək.1.2-1 

Kolontitul və nömrə səhifənin solunda, mərkəzində və sağında 
yerləşə bilər. Bunun üçün kursoru müvafiq sahədə yerləşdirib 
kolontitul üçün mətn daxil etdikdən və ya Tools sahəsində  
düyməsini sıxdıqdan sonra OK düyməsini sıxmaq lazımdır. 
Ehtiyac olarsa, pəncərənin Start at Page number siyahısından 
səhifə nömrələnməsi üçün başlanğıc qiymət müəyyən etmək 
olar. Qeyd edək ki, Format→Repaginete Now əmri vasitəsilə 
sənədin yenidən nömrələnməsinə nail olmaq olar. Bu zaman 
sənədin səhifələrə bölünməsi elə həyata keçirilir ki, hər bir blok 
kəsilməz olub bir səhifədə  qalır. Sənədin ilk səhifəsinə fərqli 
kolontitul müəyyən etmək lazım olduqda Diferent header and 
footer on first page parametrini aktiv etmək lazımdır. 
Kolontilul üçün tələb olunan şrift isə Format düyməsini 
sıxdıqda açılan pəncərədə  şriftlər siyahısından təyin edilir. 
Tools sahəsinin müvafiq düymələri vasitəsilə kolontitul olaraq 
həmçinin sənədin adını, sənəd faylının ünvanını, səhifələrin 
ümumi sayını, sənədin yaddaşda saxlanıldığı tarix və vaxtı 
müəyyən etmək olar. Pəncərənin İmage düyməsi kolontitul 
kimi şəkildən istifadə edilməsini təmin edir, səhifənin və 
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kolontitulların çərçivəyə alınması isə Frame sahəsinin müvafiq 
seçim sahələri vasitəsilə təmin olunur. 
  Yaradılmış yeni sənədin və sənəd üzərində edilmiş 
dəyişikliklərin yaddaşda saxlanılması üçün File→Save əmri 
yerinə yetirilməlidir. Yeni sənədi yaddaşda saxladıqda açılmış 
Save As pəncərəsində sənədin adı1 və tipi, sənədin saxlanılmalı 
olduğu disk və ya qovluq müəyyən olunduqdan sonra Save 
düyməsi sıxılmalıdır2. Əgər mövcud sənədi başqa adla, başqa 
yerdə (digər qovluqda, diskdə) və başqa parametrlərlə 
yaddaşda saxlamaq tələb olunsa, File→Save As əmri yerinə 
yetirilməlidir. Əmri yerinə yetirdikdə Save As pəncərəsi açılır 
və istifadəçi sənədin yeni ünvanını müəyyən edib Save 
düyməsini sıxmalıdır. 
 Hazır sənədi çap etməzdən əvvəl səhifənin 
parametrlərini müəyyən etmək lazımdır. Bunun üçün File → 
Page setup əmrini yerinə yetirmək və bu zaman açılan dialoq 
pəncərəsinin müvafiq elementləri vasitəsilə səhifənin sağ, sol, 
yuxarı və aşağı kənarlarından buraxılan boş məsafələri, kağızın 
hər iki tərəfində sənədin çapını təmin etmək üçün «güzgülü 
inikas» parametrini, səhifənin ölçüsünü, çapın istiqamətini 
(kitab və ya albom formasında) müəyyən etmək lazımdır. Daha 
sonra File → Print Preview əmrini yerinə yetirməklə sənədin 
səhifələrinin görünüşünə baxmaq məsləhətdir. Əgər sənədin 
görünüşü qənaətbəxş deyilsə, alətlər panelinin Close düyməsini 
sıxıb sənədi yenidən redaktə etmək gərəkdir. Əks halda alətlər 
panelinin printer düyməsini sıxmaqla onu çap etmək olar. 
Printer düyməsini sıxdıqda açılan pəncərədə istifadəçi çap 
parametrlərini müəyyən edib OK düyməsini sıxmalıdır. Çap 
parametrləri sənədin cari səhifəsini, konkret səhifələri, qeyd 

                                                           
1 Adətən sənədin ilk sətiri avtomatik olaraq sənədin adı kimi təklif olunur. 
Lakin, məsləhətdir ki, hər bir sənədə unikal ad verilsin. 
2 Dialoq pəncərsinin və onun interfeys elementlərinin adı Windows 
əməliyyat sisteminin hansı dildə olmasından asılıdır. Buna görə də adlar 
mötərizədə rus və azərbaycan dilində verilmişdir.  
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olunmuş mətn fraqmentini və sənədi bütövlükdə bir və ya bir 
neçə nüsxədə çap etməyi təmin edir. Qeyd edək ki, sənədi 
həmçinin File→Print əmrini yerinə yetirməklə də çap etmək 
olar. Bu halda da dialoq pəncərəsi açılır və istfiadəçi çap 
parametrlərini müəyyən edib OK düyməsini sıxmalıdır. 

İstifadəçi sənəd üzərində işi bitirdikdən sonra 
File→Close əmrini yerinə yetirib sənəd pəncərəsini 
bağlamalıdır. Əks halda proqramla işi bitirdikdə1 proqram 
bağlanmamış sənəd pəncərələrinin bağlanmasını  tələb edir. 
Əgər sənəd üzərində edilmiş son dəyişikliklər yaddaşda 
saxlanmamışsa, bu haqda xəbərdarlıq pəncərəsi açılır. 
Pəncərənin Yes, No, Cancel  düymələri müvafiq olaraq bu 
dəyişikliklərin yaddaşda saxlanılmasını, saxlanılmamasını və 
sənəd pəncərəsinin bağlanılmasından imtina edilməsini təmin 
edir. 

 
 
 
 

1.3  HESABLAMA REJİMLƏRİ 
 
 Mathcad-da hesablama əməliyyatı adətən avtomatik 
hesablama rejimində, ədədi və ya analitik-simvolik olaraq 
həyata keçirilir. Bu rejimdə dəyişənin müəyyən qiymətlərində 
riyazi ifadənin və funksiyanın ədədi qiymətinin hesablanması 
üçün riyazi ifadəni və ya funksiyanı daxil etdikdən sonra 
klaviaturanın ”=” düyməsini sıxmaq kifayətdir.  Hesablamanın 
nəticəsi “=” işarəsinin sağında əks olunacaqdır. Əgər 
hesablamanı yerinə yetirmək mümkün deyilsə, hesablama 
blokunun aşağısında sarı fonlu düzbucaqlı çərçivədə səhv 
haqqında məlumat əks olunacaqdır (şək.1.3-1). 

                                                           
1 Bunun üçün File→Exit əmrini yerinə yetirmək lazımdır. 
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şək. 1.3-1 

 Riyazi ifadəni və ya funksiyanı simvolik hesablamaq 
üçün kursoru Symbolic alətlər panelində yerləşən «→» alətinin 
üzərinə qoyub siçanın sol düyməsini sıxmaq lazımdır. «→» 
işarəsi cari hesablama blokunda ifadənin sağında əks 
olunduqdan sonra isə Enter düyməsini sıxmaq lazımdır. 
Bundan sonra hesablamanın nəticəsi işarənin sağında əks 
olunacaqdır. İfadəni simvolik hesablamaq mümkün olmadıqda  
«→» sağında ifadə təkrar əks olunur.  

Avtomatik hesablama rejimində sənədin redaktəsi 
zamanı dəyişənin qiymətində və ya ifadənin yazılışında 
dəyişiklik olduqda avtomatik olaraq hesablamanın nəticəsi 
yeniləşəcək. İfadənin hesablanması tələb olunmadıqda 
istifadəçi kontekst menyunun Disable Evaluation əmri 
vasitəsilə cari ifadə üçün hesablama rejimindən imtina edə 
bilər. Bu zaman dösturun sağ yuxarı küncündə  qara rəngli 
nişan yaranır (şək.1.3-2). Kontekst menyunun Enable 
Evaluation əmrini yerinə yetirməklə isə hesablama rejimindən 
imtina edilmiş ifadə üçün hesablama rejimini yenidən aktiv 
etmək olar.  

f sin x( )
0

1

x3




 

şək. 1.3-2 

İstifadəçi yalnız özü istədiyi vaxt və özü istədiyi ifadə və ya 
funksiyalarla hesablama əməliyyatı aparmaq istədikdə o, ilk 
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öncə Math menyusuna daxil olub Automatic Calculation 
əmrinin sol kənarındakı «√» işarəsini götürməklə avtomatik 
hesablama rejimindən imtina etməlidir. Bundan sonra 
hesablanacaq ifadəni və ya funksiyanı qeyd edib klaviaturanın 
F9 düyməsini sıxmalı və ya Math→Calculate əmrini yerinə 
yetirməlidir. Sənəddə edilmiş düzəlişləri nəzərə almaqla 
yenidən hesablamaq üçün isə Math → Calculate Worksheet 
əmri yerinə yetirilməlidir. 

Ədədi hesablamaları sürətləndirmək üçün proqramda 
həmçinin hesablamanın optimallaşma rejimi nəzərdə 
tutulmuşdur. Rejim Math→Optimization əmrini yerinə 
yetirməklə müəyyən edilir. Bu rejim müəyyən olunduqda ifadə 
avtomatik olaraq ilk öncə sadələşir və sonradan hesablama 
əməliyyatı yerinə yetirilir. Sadələşmiş ifadənin sağında qırmızı 
rəngli «» işarəsi əks olunur. Kursoru ifadənin üzərinə qoyub 
siçanın sağ düyməsini sıxmaqla açılan kontekst menyunun 
Show Popup əmrini yerinə yetirməklə açılan pəncərədə 
ifadənin sadələşmiş forması ilə tanış olmaq olar (şək.1.3-3).  

 

 
şək.1.3-3 

İstifadəçi həmçinin paketdə nəzərdə tutulmuş bir sıra 
standart hesablama parametrlərini dəyişə bilər. Bunun üçün o, 
Math→Options əmrini yerinə yetirməlidir. Əmri yerinə 
yetirdikdə 4 bölməli pəncərə açılır. Pəncərənin: 
 Bulit – in Variables bölməsində vektor və matrislər üçün 

indeksin başlanğıc qiymətini (Origin), iterasiya və limitlər  
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üçün xətanın qiymətini (Convergence Tolerance), təqribi 
hesablama xətasının qiymətini (Constraint Tolerance), 
təsadüfi ədədlər üçün başlanğıc qiymət (Seed value for 
random numbers), hesablamanın nəticəsinin ASCII 
faylında saxladıqda fayla yazılan yazıların sayını 
(Precision), ASCII faylına yazılan yazıların enini (Column 
Width); 

 Calculation bölməsində proqram yükləndikdə avtomatik 
hesablama (Recalculate automatically) və optimizasiya 
rejimlərini;  

 Display bölməsində hasil (Multiplication), törəmə 
(Derivative), aşağı indeks (Literal Subscript), mənimsətmə 
operatoru (Definition), bərabərlik əməliyyatı (Equality), 
qlobal və lokal dəyişənlər (Global Definition, Lokal 
Definition) üçün  simvolları; 

 Unit System bölməsində fiziki parametrlər üçün vahidlər 
sistemini (SI- Beynəlxalq vahidlər sistemi, MKS – 
mexaniki və akustiki vahidlər sistemi, CGS -sm, q, san, US 
- ABŞ vahidlər sistemi, None); 

 Dimension bölməsində isə ölçü dəyişənlərinin adını 
dəyişmək olar.     

 
 

1.4 SİMVOLİK  HESABLAMA  
 

Mathcad-da hesablama əməliyyatı çevirmə, rekkurent, 
triqonometrik və s. düsturlardan istifadə etməklə simvolik 
hesablama  üsulu  ilə yerinə yetirilə bilər. Bu məqsədlə 
proqramda Symbolics menyusu və Symbolic alətlər paneli 
nəzərdə tutulmuşdur. Symbolics menyusunun əmrləri vasitəsilə 
simvolik hesablama apardıqda həllin nəticəsi adətən riyazi 
ifadənin altında, Symbolic alətlər panelinin alətləri vasitəsilə, 
yerinə yetirdikdə isə ifadənin sağında, «→» işarəsindən sonra 
əks olunur.  İstifadəçi ehtiyac duyarsa Symbolics menyusunun 
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əmrləri vasitəsilə simvolik hesablama apardıqda həllin 
nəticəsinin ekranda əks olunmasını tənzimləyə bilər. Bunun 
üçün o, Symbolics →Evaluation Style əmrini yerinə yetirib,  
açılmış dialoq pəncərəsində stil variantlarından birini 
seçməlidir. Vertically, inserting lines stil variantı hesablamanın 
nəticəsini  boş sətir buraxılmaqla ifadənin aşağısında, 
Vertically, without inserting lines stil variantı hesablamanın 
nəticəsini  boş sətir buraxılmadan ifadənin aşağısında, 
Horizontally stil variantı hesablamanın nəticəsini ifadənin 
solunda,  Show Comments stil variantı hesablamanın nəticəsi  
ilə birlikdə şərhin,  Evaluate in Place stil variantı hesablamanın 
nəticəsinin  ifadənin yerində əks olunmasını təmin edir.  

Mathcad-da ifadəni sadələşdirmək, vuruqlara ayırmaq, 
hədlərə görə qruplaşdırmaq, çoxhədlinin əmsallarını tapmaq, 
tənlik və bərabərsizlikləri həll etmək, differensiallamaq və 
inteqrallamaq, Furye sırasına ayırmaq, matrisin tərs matrisini, 
determinantını hesablamaq, Furye, Laplas, Z çevirməsi və 
onların tərsini tətbiq etmək və s. olar. Bu əməliyyatlar 
aşağıdakı qaydada yerinə yetirilir: 

 İfadəni sadələşdirmək üçün kursoru ifadənin sağında 
yerləşdirib Symbolic alətlər panelinin simplify aləti vasitəsilə 
simplify operatorunu daxil etmək və Enter düyməsini sıxmaq 
lazımdır. Eyni əməliyyatı ifadəni qeyd edib Symbolics→ 
Simplify əmrini yerinə yetirməklə də həyata keçirmək olar.  

 Riyazi ifadənin çevirmə düsturları vasitəsi ilə 
«açılması»  (məsələn; mötərizələrin vurulması, triqonometrik 
düsturların çevrilməsi, binomial açılış və s.) üçün onu qeyd 
etmək və Symbolics→Expand əmrini yerinə yetirmək 
lazımdır.  Eyni əməliyyatı Symbolic alətlər panelinin alətləri 
vasitəsi ilə yerinə yetirmək üçün  kursoru ifadənin sağında 
yerləşdirib, Symbolic panelinin expand aləti vasitəsilə  Expand 
operatorunu daxil etmək, arqumenti müəyyən etmək və Enter 
düyməsini sıxmaq lazımdır. 
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 Riyazi ifadəni vuruqlara ayırmaq və ədədləri sadə 
ədədlərin hasili kimi göstərmək üçün ifadəni və ya ədədi qeyd 
edib Symbolics→Factor əmrini yerinə yetirmək lazımdır. Eyni 
əməliyyatı kursoru ifadənin və ya ədədin sağında yerləşdirib, 
Symbolic panelinin Factor aləti vasitəsilə  Factor operatorunu 
daxil etdikdən sonra Enter düyməsini sıxmaqla da yerinə 
yetirmək olar.  

 İfadəni qeyd olunmuş dəyişənə görə qruplaşdırmaq 
üçün Symbolics→Collect əməliyyatını yerinə yetirmək 
lazımdır. Eyni əməliyyatı kursoru ifadənin  sağında yerləşdirib 
Symbolic panelinin Collect aləti vasitəsilə Collect operatorunu 
daxil edib, arqumenti müəyyən etdikdən sonra Enter düyməsini 
sıxmaqla da yerinə yetirmək olar.  

 Çoxhədlinin əmsalını vektor şəklində əks etdirmək 
üçün Symbolics→Poyinomial Coefficients əmrini yerinə 
yetirmək lazımdır. Eyni əməliyyatı kursoru çoxhədlinin 
ifadəsinin  sağında yerləşdirib Symbolic panelinin Coeffs aləti 
vasitəsilə  Coeffs  operatorunu daxil edib, arqumenti müəyyən 
etdikdən sonra Enter düyməsini sıxmaqla da yerinə yetirmək 
olar (şək.1.4-1 Misal 3).  

 Qeyd olunmuş dəyişənə görə tənlik və bərabərsizlikləri 
həll etmək üçün Symbolics→Variable →Solve əmrini yerinə 
yetirmək lazımdır. Eyni əməliyyatı kursoru ifadənin  sağında 
yerləşdirib Symbolic panelinin Solve aləti vasitəsilə Solve 
operatorunu daxil edib, arqumenti müəyyən etdikdən sonra 
Enter düyməsini sıxmaqla da yerinə yetirmək olar (şək.1.4-1 
Misal 1-2).  

 İfadənin qeyd olunmuş dəyişənini mübadilə buferində 
olan yeni ifadə ilə əvəz etmək üçün Variable →Substiture 
əmrini yerinə yetirmək lazımdır. Əvəzetmə əməliyyatını 
Symbolic panelindən Substiture aləti vasitəsilə də yerinə 
yetirmək olar. Bunun üçün kursoru ifadənin  sağında 
yerləşdirib Symbolic panelinin Substiture aləti vasitəsilə 
Substiture operatorunu daxil edib, əvəz olunacaq arqumenti və  
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“=” işarəsindən sonra yeni ifadəni  müəyyən etdikdən sonra 
Enter düyməsini sıxmaq yerinə yetirmək lazımdır. 

 Mürəkkəb kəsrləri daha sadə kəsrlər vasitəsilə ifadə 
etmək üçün kəsri qeyd edib Symbolics → Variable → Convert 
to Partial Fracton əmrini yerinə yetirmək lazımdır. Eyni 
əməliyyatı kursoru ifadənin  sağında yerləşdirib Symbolic 
panelinin Parfrac  aləti vasitəsilə Parfrac operatorunu daxil 
edib, arqumenti müəyyən etdikdən sonra Enter düyməsini 
sıxmaqla da yerinə yetirmək olar (şək.1.4-1 Misal 4).  

Misal 1 Misal 3

x 2 4 0 solve x
x 2

2 x









 x2 7x x3
 6 coeffs x

6

7

1

1

















Misal 2

sin x 1( ) 1 solve x 1
1
2

 2.571

Misal 4

x2 6x 2

x 4
convert parfrac x x 2

10
x 4( )



 
şək.1.4-1 

 İfadənin qeyd olunmuş dəyişənə görə törəməsini 
tapmaq üçün Symbolics → Variable→ Differentiate əmrini 
yerinə yetirmək lazımdır.  

 İfadəni qeyd olunmuş dəyişənə görə inteqrallamaq üçün 
Symbolics→Variable→İntegrate əmrini yerinə yetirmək 
lazımdır.  

 İfadəni qeyd olunmuş dəyişənə görə Teylor sırasına 
ayırmaq üçün  Symbolics→Variable→Expand to Series 
əmrini yerinə yetirmək lazımdır. Bu zaman açılan dialoq 
pəncərəsində sıranın hədlərinin sayını müəyyən etmək 
lazımdır. Eyni əməliyyatı kursoru ifadənin  sağında yerləşdirib 
Symbolic panelinin Series aləti vasitəsilə Series operatorunu 
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daxil edib, arqumenti müəyyən etdikdən sonra Enter düyməsini 
sıxmaqla da yerinə yetirmək olar (şək.1.4-2 Misal  1) . 

Misal 1

sin x( ) cos x( ) x
2

 series x 1 x
1

2
x
2


1

6
x
3


1

24
x
4


1

120
x
5



Misal 2 

cos x( ) x
2

 fourier x  Dirac  1( )  Dirac  1( ) 2  Dirac 2 ( )

Misal 3  

cos x( ) x
2

 laplace x
s

s
2

1





2

s
3



Misal 4 

s

s
2

1





2

s
3

 invlaplace s cos t( ) t
2



Misal 5

1 x
2

 ztrans x z
2 z 3( )

z 1( )
3



Misal 6

z
2 z 3( )

z 1( )
3

 invztrans z 1 n
2



 şək.1.4-2 

 İfadəyə qeyd olunmuş dəyişənə görə Furye, tərs Furye, 
Laplas, tərs Laplas, Z və tərs Z çevrilməsi tətbiq etmək üçün 
müvafiq olaraq Symbolics→Transform→Fourier, Symbolics 
→ Transform → Inverse Fourier,  Symbolics → Transform 
→ Laplace, Symbolics→Transform→ Inverse Laplace, 
Symbolics → Transform →  Z, Symbolics → Transform → 
Inverse Z  əmrlərindən birini yerinə yetirmək lazımdır.  Eyni 
əməliyyatları kursoru ifadənin  sağında yerləşdirib Symbolic 
panelinin fourier, invfourier, laplace, invlaplace, ztrans, 
invztrans alətləri vasitəsilə eyniadlı operatorları daxil edib, 
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arqumenti müəyyən etdikdən sonra Enter düyməsini sıxmaqla 
da yerinə yetirmək olar (şək.1.4-2 Misal 2-6) .  

 Qeyd olunmuş matrisin transponirə olunmuş matrisini 
təyin etmək üçün Symbolics→Matrix→Transpose, qeyd 
olunmuş matrisin tərs matrisini təyin etmək üçün  
Symbolics→Matrix→Invent, qeyd olunmuş matrisin 
determinatını  hesablamaq üçün Symbolics → Matrix →  
Determinat əmrini yerinə yetirmək lazımdır1. Eyni 
əməliyyatları matrisi təyin etdikdən sonra, kursoru ifadənin  
sağında yerləşdirib Symbolic panelinin TM  , -1M  , 
M alətləri vasitəsilə eyniadlı operatorları daxil edib, 

arqument olaraq matrisin adını müəyyən etdikdən sonra Enter 
düyməsini sıxmaqla da yerinə yetirmək olar. 

Qeyd edək ki, dəqiq hesablama aparmaq tələb olunduqda, 
Symbolica→  Evaluate → Floatinq Paint və  Symbolica → 
Evaluate → Complex əmrlərini yerinə yetirməklə həmçinin 
qeyd olunmuş riyazi ifadənin qiymətlərini müvafiq olaraq 
sürüşkən vergüllü və kompleks ədəd şəklində hesablamaq olar. 
İfadənin ədədi qiymətlərinin müvafiq olaraq sürüşkən vergüllü 
və kompleks ədəd şəklində hesablanmasını həmçinin, kursoru 
ifadənin sağında yerləşdirib, Symbolic panelinin float, complex 
alətləri vasitəsilə eyniadlı operatorları daxil edib, arqumenti  
müəyyən etdikdən sonra Enter düyməsini sıxmaqla da yerinə 
yetirmək olar (şək.1.4-3).  

x 5 sin x 12( ) float x .65699

sin x 12( ) 0.657

e
x 2i

complex exp 5( ) cos 2( ) i exp 5( ) sin 2( )

 
şək.1.4-3 

 

                                                           
1 Matrislər üzərində əməliyyatlar Matrislər cəbri paraqrafında geniş izah 
olunmuşdur. 
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1.5 QRAFİKLƏRİN QURULMASI VƏ  
FORMATLAŞDIRILMASI  

 
 Mathcad hesablamanın nəticəsini Dekart və Polyar 

koordinat sistemlərində ikiölçülü qrafik şəklində əks 
olunmasını,  funksiyanın qrafiklərini qurulmasını təmin edir. 
Dekart koordinat sistemində funksiyanın qrafikini qurmaq üçün 
istifadəçi İnsert→Graph-X-Y Plot əmrini, Polyar koordinat 
sistemində funksiyanın qrafikini qurmaq üçün isə 
İnsert→Graph→Polar Plot əmrini yerinə yetirməlidir. Hər iki 
halda işçi vərəqdə müvafiq qrafik sahəsi əks olunur (şək.1.5-1).  

 
şək.1.5-1 

İstifadəçi qrafik sahəsində funksiyanın arqumentini və 
funksiyanın adını daxil etməlidir. Kursoru qrafik sahəsindən 
kənarda yerləşdirib siçanın sol düyməsini sıxdıqda funksiyanın 
qrafiki qrafik sahəsində əks olunacaqdır (şək. 1.5-2 a,b). 



Riyazi proqram paketləri 25

 
şək.1.5-2 

Əgər funksiya əvvəlcədən düstur şəklində təyin olunmayıbsa, 
onda funksiyanın adının əvəzinə, funksiyanın ifadəsi aşkar 
şəkildə daxil edilməlidir. Funksiyanın təyin oblastı diskret, 
vektor şəklində və ya qrafiki sahədə arqument daxil olduqda 
əks olunan nişanlarda  istifadəçi tərəfindən daxil oluna bilər 
(şək. 1.5-3). 

N 100

n1 4 n2 5

p1 6.283
n1

N
 p2 6.283

n2

N


j 1 N 1

xj sin p1 j( ) yj cos p2 j( )  
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1 0 1
1

0

1

xj

yj  

şək. 1.5-3 

 Əgər istifadəçi funksiyanın təyin oblastını göstərməyibsə, 
avtomatik olaraq proqram Dekart koordinat sistemi üçün         
[-10,10], polyar koordinat sistemi üçün isə [0°,360°] müəyyən 
edir. Qeyd edək ki, bir qrafik sahəsində bir neçə funksiyanın 
qrafikinin əks olunması üçün digər funksiyaların adları bir-
birindən vergüllə ayrılmaqla yazılmalıdır. Bu zaman hər bir 
funksiyanın qrafiki konkret rəngə və xətt stilinə malik 
olacaqdır (şək. 1.5-2 c, d).  

Proqram həmçinin üçölçülü fəzada Z(X,Y) matris 
funksiyası ilə təyin olunan səthlərin, kontur qrafiklərinin, 
vektor sahələrinin və diaqramların qurulmasını təmin edir1.   
Bunun üçün ilk öncə X və Y vektorları təyin olunmalıdır. 
Sonra isə istifadəçi müvafiq olaraq İnsert→Graph→3D Plot, 
İnsert→Graph→ Contour Plot, İnsert→Graph →3D Scatter 
Plot, İnsert→Graph→ 3D Bar Plot əmrlərindən birini yerinə 
yetirməlidir. Bu zaman  işçi sahədə əks olunan üçölçülü qrafik 
sahəsində funksiyanın adını daxil etdikdən və kursoru qrafik 
sahəsindən kənarda yerləşdirib siçanın sol düyməsini sıxdıqdan 
sonra funksiyanın qrafiki əks olunacaqdır (şək. 1.5-4, 1.5-5). 

                                                           
1 X,Y vektorlardır 
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N 20 i 0 N  i i


N
 j 0 N  j j 2



N


Xi j sin  i  cos  j  Yi j sin  i  sin  j  Zi j cos  i 

X Y Z( )
X Y Z( ) b )  

şək.1.5-4 

i 1 10 j 1 10

a1 1 a2 10 b1 1 b2 10 xi
a2 1( )

20 a1
 yi b1

b2 10(

10


Mi j xi
yj

xi yj


Gi j
i

10
sin yj  tan xi 

 
 

G
M

b)  
şək.1.5-5 
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Qrafiklərin tələb olunan formaya salınması üçün proqram 
tərəfindən avtomatik müəyyən edilən parametrlər 
dəyişilməlidir. Bunun üçün qrafik sahəsində siçanın sol 
düyməsini 2 dəfə sıxmaq və ya kontekst menyunun Format 
əmrini yerinə yetirmək lazımdır. Bu zaman açılan çoxbölməli 
dialoq pəncərəsində cari qrafikin paket tərəfindən avtomatik 
müəyyən edilən parametrləri əks olunur. Qrafikin tipindən asılı 
olaraq bu parametrlər müxtəlif ola bilər. Əgər qrafik Dekart 
koordinat sistemində  qurulmuşsa, bu parametrlər qrafikin 
Format dialoq pəncərəsinin  X-Y Axes, Traces, Labels, Defaults 
bölmələrində əks olunur. Belə ki, X-Y Axes bölməsində absis 
və ordinat oxları üçün parametlər əks olunur və onlar qrafik 
üçün aşağıdakıları  müəyyən edir: 
 Log Scale-koordinat oxları üçün loqarifmik miqyasın 

müəyyən olunmasını;  
 Grid Lines-koordinat oxları üçün şəbəkə xəttlərinin əks 

olunmasını; 
 Numbered-koordinat oxları üçün ədədi şkalanın əks 

olunmasını;  
 Autoscale-koordinat oxları üçün proqram tərəfindən 

avtomatik  miqyasin müəyyən olunmasını; 
 Show marker-koordinat oxları üçün markerlərin əks 

olunmasını; 
 Auto Grid-koordinat oxları üçün avtomatik şəbəkənin əks 

olunmasını; 
 Number of  Grids-koordinat oxları üçün şəbəkə xəttlərinin 

sayının istifadəçi tərəfindən müəyyən olunmasını; 
 Boxed-qrafik sahəsinin düzbucaqlı çərçivədə əks 

olunmasını; 
 Crossed-qrafik sahəsinin düzbucaqlı çərçivəsiz əks 

olunmasını; 
 None-düzbücaqlı çərçivə və koordinat oxlarının görünməz 

olmasını.  
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Format dialoq pəncərəsinin Traces bölməsində aşağıdakı 
parametrlər tənzimlənir: 
 Legend Label–hər bir qrafik əyrisi üçün nişan və əyrinin 

adı; 
 Symbol–hər bir qrafik əyrisi üçün nöqtələrinin simvollarla 

əks olması; 
 Line–hər bir qrafik əyrisi üçün xəttin stili (solid (bütöv), dot 

(punktir), dash (ştrix), dadot (ştrixpunktir)); 
 Color–əyrinin tipindən asılı olaraq hər bir qrafik əyrisi 

üçün xəttin və ya nöqtələrin rəngləri; 
 Weight– xəttin qalınlığı; 
 Type– qiymətlərin təsvir formaları. 

Labels bölməsi qrafikə sərlövhə və koordinat oxlarına 
ad yazmaq üçün istifadə olunur. Belə ki,  qrafikin sərlövhəsi 
üçün Title sətirində, X və Y oxlarına nişanlar  yazmaq üçün isə 
müvafiq olaraq X-Axis və Y-Axis sətirlərində mətni daxil etmək 
lazımdır. Qrafikin adının qrafikin yuxarı hissəsində əks 
olunması üçün Above, qrafikin  aşağısı hissəsində əks olunması 
üçün isə Below variantlarından birini seçmək lazımdır. 
Avtomatik müəyyən olunan parametrləri yenidən müəyyən 
etmək üçün isə Defaults bölməsində Change to Defaults  
düyməsini sıxmaq kifayətdir. 

Üçölçülü qrafikləri formatlaşdırmaq üçün isə qrafiki 
qeyd edib siçanın sol düyməsini 2 dəfə sıxmaq və ya 
Format→3-D Plot əmrini yerinə yetirmək lazımdır. Açılan 3-
D Format Plot pəncərəsinin General, Axes, Appearance, 
Lighting, Title, Backplanes, Special, Advanced, QuickPlot 
Data bölmələrində qruplaşmış çoxsaylı parametrlər vasitəsilə 
qurulmuş qrafikin tərtibatını dəyişmək olar.  Belə ki, General 
bölməsinin Display As sahəsində variant düymələrini seçməklə 
qrafikin tipini dəyişmək, View sahəsinin parametrlərini 
dəyişməklə qrafiki döndərmək və görünüş miqyasını dəyişmək, 
Axes Style sahəsinin  variant düymələri vasitəsilə koordinat 
oxları üçün müəyyən stillər müəyyən etmək, Frames sahəsinin 
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parametrləri vasitəsilə qrafikin rəngli düzbucaqlı çərçivəyə 
salınmasını tənzimləmək, koordinat fəzasının kub formasında 
əks olunmasını təmin etmək olar.  
  Axes bölməsinin koordinat oxlarına uyğun bölmələrində 
müvafiq olaraq koordinat oxları üçün, xətlərin tipini və rəngini, 
şəbəkə qiymətləri üçün dəyişmə intervalını, şkala və s. 
parametrləri dəyişmək olar. 
  Appearance bölməsində səth və kontur qrafikləri və 
koordinat oxları üçün parametrlər, rəngləmə parametrlərini 
müəyyən etmək olar. 
  Backplanes bölməsi koordinat şəbəkəsi üçün gizli 
müstəvidə proyeksiyanın əks olunmasını tənzimləyir. 
  Special bölməsində kontur qrafikləri üçün müxtəlif rəng 
sxemləri və s. parametrləri müəyyən edilir. 

Advanced bölməsi ilə qrafik üçün duman effekti və s. 
parametrləri, Title bölməsində isə qrafikin sərlövhəsini 
müəyyən etmək  olar. 

 
 
 

1.6 ANİMASİYAlARIN  YARADILMASI 
 

Praktikada bir sıra məsələlərin həllində (məsələn, cismin 
trayektoriyasının  öyrəniləmsində və s.) hesablamanın 
nəticəsinin animasiya şəklində əks olunmasına ehtiyac duyulur. 
Konkret misal üzərində animasiya yaradılmasını izah edək. 
Fərz edək ki, harmonik dalğanın yayılmasını nümayiş etdirmək 
lazımdır. Bunun üçün ilk növbədə harmonik funksiyanı təyin 
edirik: f(x,t):=sin(x-t). Sonra funksiyanın qrafikini Dekart 
koordinat sistemində qururuq. Bunun üçün İnsert→Graph-X-Y 
Plot əmrini yerinə yetirib, qrafik sahəsində funksiyanın 
arqumenti olaraq –x,  funksiyanın adı olaraq isə f(x,FRAME) 
daxil edirik. Animasiya ardıcıl əks olunan kadrlardan ibarət 
olduğundan FRAME parametri kadrların sayını təyin edir. 
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Növbəti addımda View→ Animate əmrini yerinə yetirib, açılan 
pəncərədə birinci və sonuncu kadr üçün nömrə və animasiyanın 
sürətini müəyyən edib, qrafiki qeyd edirik və dialoq 
pəncərəsinin Animate düyməsini sıxırıq (şək.1.6-1). Bu zaman 
qrafik sahəsində və dialoq pəncərəsinin animasiya sahəsində 
animasiya əks olunacaqdır. Daha sonra dialoq pəncərəsinin 
Save As düyməsini sıxmaqla yaradılmış animasiyanı video fayl 
şəklində yaddaşda saxlayıb dialoq pəncərəsini bağlayırıq. 
Yaddaşda saxlanılmış animasiyanı yenidən nümayiş etdirmək 
üçün isə View→Playback əmrini yerinə yetirdikdə açılan 
pəncərənin  düyməsini sıxıb animasiyanın ünvanını 
müəyyən edərək, onu animasiya pəncərəsinə çağırmaq və 
animasiya pəncərəsinin   düyməsini sıxmaq lazımdır. 

 
şək.1.6.-1 
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1.7 SƏNƏD ÜZƏRİNDƏ REDAKTƏ  ƏMƏLİYYATLARI 
 

Mathcad-da sənəd özərində aşağıdakı  redaktə əməliy-
yatlarını  aparmaq olar:  

 Yerinə yetirilmiş  son əmrin nəticəsini ləğv etmək;  
Bunun üçün  Edit→Undo əmrini yerinə yetirmək və ya 
«Ctrl+Z» qızğın düymələrini sıxmaq lazımdır. Məsələn, əgər 
istifadəçi səhvən sənəddə müəyyən fraqmenti ləğv etmişsə bu 
əmr vasitəsilə onu  bərpa edə bilər. 

 Yerinə yetirilmiş  son əmri təkrar yerinə yetirmək;          
Bunun üçün  Edit→Repeat əmrini yerinə yetirmək və ya 
«Ctrl+Y» qızğın düymələrini sıxmaq lazımdır. 

 Qeyd olunmuş sənədi və sənəd fraqmentini kəsib, 
mübadilə buferində saxlamaq; Bunun üçün ilk öncə sənəd və 
ya sənəd fraqmenti qeyd edilməlidir. Sənədi tamamilə   qeyd 
etmək üçün  Edit→ Select All əmrini yerinə yetirmək və ya 
«Ctrl+X» qızğın düymələrini sıxmaq lazımdır. Sənəddə 
müəyyən fraqmentləri qeyd etmək üçün isə «SHİFT» 
düyməsini sıxmaqla kursoru hissələrin üzərinə qoyub siçanın 
sol düyməsini sıxıb buraxmaq lazımdır. Qeyd edilmiş sahələr 
qırıq xəttli çərçivəyə alınmış olur. Bundan sonra Edit→ Cut 
əmrini yerinə yetirmək və ya «Ctrl+X» qızğın düymələrini 
sıxmaq lazımdır. Mübadilə buferində saxlanmış informasiyanı 
sonradan cari sənədin digər hissəsinə və ya digər sənədlərə 
daxil etmək olar.  

 Qeyd olunmuş sənədi və sənəd fraqmentinin surətini 
mübadilə buferində saxlamaq; Bunun üçün Edit→ Copy əmrini 
yerinə yetirmək və ya «Ctrl+C» qızğın düymələrini sıxmaq 
lazımdır.  

 Mübadilə buferində saxlanılan informasiyanın sənədə 
daxil etmək;. Bunun üçün Edit→Paste əmrini yerinə yetirmək 
və ya «Ctrl+V» qızğın düymələrini sıxmaq lazımdır.  

 Mübadilə buferində olan və digər Windows 
əlavələrində yaradılmış obyektləri kursorun durduğu mövqedən 
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sənədə xüsusi format əsasında  daxil etmək; Bunun üçün 
Edit→ Paste Special əmrini yerinə yetirmək və açılmış 
pəncərədə  format və tələb olunarsa, obyektlə onun yaradıldığı 
əlavə arasında əlaqəni müəyyən etmək, sonra isə OK 
düyməsini sıxmaq lazımdır. Qeyd edək ki, obyektlə onun 
yarandığı əlavə arasında əlaqə müəyyən olunarsa mübadilə 
buferindəki obyekti «nişan formasında» və ya əgər rəsm 
formatı seçilibsə, «mətnin üzərinə qoymaqla», sənədə kursorun 
durduğu mövqedən daxil etmək olar. 

 Qeyd olunmuş sənədi və ya sənəd fraqmentini ləğv 
etmək; Bunun üçün  Edit→Delete əmrini yerinə yetirmək və ya 
klaviaturanın Delete düyməsini və ya «CTRL+D» qızğın 
düyməsini  sıxmaq lazımdır.  

 Sənəddə müəyyən fraqmentlərin yerini dəyişmək və 
surətini yaratmaq. Bunun üçün qeyd edilmiş sahəni siçanın sol 
düyməsini sıxmaqla hərəkət etdirib, sənəddə tələb olunan yerə 
yerləşdirmək lazımdır. Siçanın sıxılmış düyməsini buraxdıqda  
sənəd sahəsi yeni yerdə əks olunacaqdır. Sənədin surətini 
yatarmaq üçün isə qeyd olunmuş hissəni Ctrl düyməsini 
sıxmaqla hərəkət etdirmək lazımdır. Bu əməliyyatları müvafiq 
olaraq ardıcıl yerinə yetirilən Edit→Cut , Edit→Paste və 
Edit→Copy,  Edit→Paste əmrləri vasitəsilə yerinə yetirmək 
olar. 

 Mətn sahələrində hər hansı simvolu, sözün və ya söz 
birləşməsini axtarmaq. Bunun üçün Edit→ Find əmrini yerinə 
yetirdikdə açılmış pəncərənin  Find what  sətirində axtarılan 
simvol və ya söz daxil edilməli və Find next düyməsi 
sıxılmalıdır. İstifadəçi sənəddə axtarış istiqamətini, registrlərin 
nəzərə alınması, tam sözün axtarılması, axtarışın mətn və ya 
hesablama blokunda aparılması  rejimlərini müəyyən edə bilər. 
Bunun üçün müvafiq olaraq Up-əvvələ, Down-geriyə 
istiqamətlərindən birini müəyyən etmək, Match case-registri 
nəzərə almaq, Matc Whole Word Only-tam söz, Find in Text 
Regions -mətn sahəsində axtarmaq, Find in Math Regions-
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hesablama sahəsində axtarmaq rejim variantlarını seçmək tələb 
olunur. 

 Sənəddə simvolu və ya sözü axtarıb, digər simvol və ya 
söz ilə əvəz etmək. Bunun üçün Edit→Replace əmrini yerinə 
yetirmək lazımdır. Bu zaman açılmış pəncərənin Find what  
sətirində axtarılan simvol və ya sözü, Replase sətirində isə yeni 
dəyişdirilən simvol və söz daxil edilməli və Find Next düyməsi 
sıxılmalıdır. Replace düyməsini sıxdıqda axtarış nəticəsində 
sənəddə tapılmış simvol və söz yeni simvol, söz ilə əvəz 
olunacaqdır. Axtarışı davam etdirmək tələb olunarsa, Find Next 
düyməsini sıxmaq lazımdır. Replace All düyməsi isə mətndə 
olan axtarılan  simvol, söz və ya söz birləşməsinin hamısını 
avtomatik olaraq   yeni simvol, söz və ya söz birləşməsi ilə 
əvəz edəcəkdir. Əgər tapılmış simvolu və ya sözü yeni simvol, 
söz və ya söz birləşməsi ilə əvəz etməyə ehtiyac duyulmursa, 
Find Next  düyməsini sıxmaqla axtarışı davam etdirmək 
lazımdır. Eyni qaydada, sənəddə axtarış istiqamətini, 
registrlərin nəzərə alınması, tam sözün axtarılması , mətn və ya 
hesablama blokunda axtarış aparılması rejimlərini müəyyən 
etmək olar.  

 Mətn sahəsində mətnlərin orfoqrafik yazılışının 
yoxlanılması. Bunun üçün Edit→Check Spelling əmrini yerinə 
yetirmək lazımdır.  Əmri yerinə yetirdikdə əgər səhv varsa, 
orfoqrafiyanın yoxlanılması öcön dialoq pəncərəsi açılır və bu 
dialoq pəncərəsinin variantlar bölməsində səhv hesab olunan 
sözün düzgün variantları əks olunur.  Bu variantlardan birini 
seçib, Change düyməsini sıxmaqla səhv sözü həmin sözlə əvəz 
etmək olar. Bəzi hallarda (termin, şəxs adı, coğrafi adlar və s.) 
sözün düzgün yazılışına baxmayaraq kompüter onu səhv kimi 
qəbul edə bilər. Bu halda Ignore  düyməsini sıxmaq kifayətdir. 
Add  düyməsini sıxmaqla isə kompüterin lüğət bazasını «səhv 
qəbul etdiyi» sözlə zənginləşdirmək olar.  

 Sənədə daxil edilmiş və digər əlavələrdə hazırlanmış 
hər hansı bir obyekti redaktə etmək. Bunun üçün kursoru 
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obyektin üzərinə qoyub siçanın sol düyməsini  iki dəfə sıxmaq 
lazımdır. Bu zaman obyekt və onun hazırlandığı əlavə işçi 
sahədə əks olunacaqdır və istifadəçi onun üzərində redaktə 
əməliyyatı apara bilər. 

 Sənədə daxil edilmiş obyekt və onun yarandığı əlavə 
arasında əlaqəni redaktə etmək; Bunun üçün Edit→Links 
əmrini yerinə yetirmək lazımdır. Açılmış dialoq pəncərəsində  
əlaqəni qırmaq, yeniləşdirmək, obyekti başqası ilə əvəz etmək 
olar. 

Yuxarıda qeyd olunan redaktə əməliyyatları müxtəlif 
səhifələrdə aparıla bilər. Çox səhifəli sənədlərdə redaktə 
prosessini sürətləndirmək məqsədilə səhifələrə avtomatik keçid 
üçün Edit menyusunda Goto to Page əmri nəzərdə 
tutulmuşdur. Əmr sənədin ilk, son və istifadəçi tərəfindən 
müəyyən edilən konkret səhifəsinə avtomatik keçidi təmin edir.  

 
 
 
 
   
1.8 SƏNƏD ÜZƏRİNDƏ FORMATLAŞMA 

ƏMƏLİYYATLARI 
 

Sənəd üzərində formatlaşma əməliyyatları Mathcad-da  
Ôîðìàò ìåíéóñónun əmrləri vasitəsilə yerinə yetirilir1. Format 
menyusu aşağıdakı  ÿìðëÿðäÿí èáàðəòäèð: 

 Equation. Əmr riyazi ifadələrdə dəyişən, sabitlər və 
istifadəçi tərəfindən daxil edilmiş obyektlər üçün yeni stil: yeni 
şrift, şrift üçün ölçü və rəng müəyyən etməyi təmin edir. 
Əmri yerinə yetirdikdə açılan dialoq pəncərəsinin Style Name 
açılan siyahısından  Variables, Constants, User1,…,User9 
parametrlərindən müvafiqini  seçib Modify düyməsini sıxmaq 
                                                           
1 Bir sıra formatlaşma əməliyyatlarını formatlaşma paneli vasitəsilə də 
yerinə yetirmək olar. 
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və açılan növbəti pəncərədə yeni şrift, onun ölçüsünü və 
rəngini müəyyən etmək lazımdır. Default Equation Color 
açılan siyahısından isə hesablama blokunda əks olunan ifadələr 
və onların nəticələri üçün proqram tərəfindən avtomatik 
müəyyən olunan rəngi digəri ilə əvəz etmək olar.  

 Result. Əmr hesablamanın ədədi nəticəsinin təsvir 
formatını müəyyn etməyə xidmət edir. Əmri yerinə yetirdikdə  
çoxbölməli Result  Format dialoq pəncərəsi açılır. Pəncərənin 
Number Format bölməsində hesablamanın ədədi nəticəsi üçün 
format (General, Decimal, Scientific, Engineering), ədədin 
onluq tərtibini (Number of decimal places), ədədin 
eksponensial yazılış parametrini (Exponential threshold), 
sıfrlarların və ədədin eksponensial formada əks olunması 
parametrini müəyyən etmək olar.  Dialoq pəncərəsinin Display 
Options bölməsində matrisin əks olunması üçün stili (Matrix 
display style),  xəyali vahid üçün yeni işarə (Imaginary value) 
və digər say sistemini (Radix) müəyyən etmək olar. Unit 
Display bölməsi  ədədi nəticənin yanında ölçü vahidinin 
(Format units) əks olunmasını və ölçü vahidinin daha sadə 
(Simplify units when possible) formada əks olunmasını 
tənzimləyir.  Tolerance bölməsində isə kompleks ədədlərdə 
rəqəmlərin (Complex threshold) və sıfırların sayı  üçün (Zero 
threshold) məhdudiyyəti müəyyən etmək olar. 

 Text. Əmr mətn blokunun  şriftini, şriftin ölçüsünü və 
rəngini  tənzimləyir. 

 Paragraph. Əmr mətn blokunda  cari abzas və ya qeyd 
olunmuş abzaslar üçün yeni parametrləri: sağdan, soldan və 
abzasın birinci sətiri üçün buraxılan boş məsafələr,  mətnin 
nizamlanma formalarını müəyyən etməyi təmin edir.  

 Style. Əmr vasitəsilə qeyd olunmuş mətn hissəsini və 
ya cari mətn blokunu seçilmiş mətn stili vasitəsilə 
formatlaşdırmaq olar. Bunun üçün açılan pəncərədən stili seçib 
Apply düyməsini sıxmaq lazımdır. Pəncərənin New düyməsini 
sıxmaqla yeni stil yaratmaq, Modify düyməsini sıxmaqla isə 
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seçilmiş stili redaktə etmək olar. New düyməsini sıxdıqda 
açılan pəncərədə yeni stilə ad verib, Font və Paragraph 
düymələrini sıxmaqla stil üçün şrift və abzas üçün parametrlər 
müəyyən etmək lazımdır. Modify düyməsini sıxdıqda isə açılan 
pəncərədə Font və Paragraph düymələrini sıxmaqla stil üçün 
müəyyən edilmiş şrifti və abzas üçün parametrləri yenisi ilə 
əvəz etmək lazımdır.  

 Properties. Əmri cari blokun rəngli fona və çərçivəyə 
malik olmasını1, cari mətn blokunun ölçülərini2, cari hesablama 
bloku üçün avtomatik hesablama rejiminin müəyyən 
olunmasını  tənzimləyir3.  

 ColorBackground. Əmr bütünlükdə işçi oblastın fona 
malik olmasını tənzimləyir.  

 ColorHighlight. Əmr  yalnız blokların fona malik 
olmasını tənzimləyir.  

 ColorAnnotation. Əmr sənədin redaktə olunmuş 
hissəsinin rəngli olmasını tənzimləyir. 

 ColorUse Default Palette. Əmr proqram tərəfindən 
avtomatik müəyyən olunan rəng effektlərini tənzimləyir.   

 Separate Regions. Əmr  bir-birini örtən blokları ayırır. 
 AlignAcross və AlignDown. Əmrlər  qeyd 

olunmuş blokların yerləşməsini nizamlayır.  
 AreaLock. Əmr bağlanmış sahəni parolla müdafiə 

edir. Əmri yerinə yetirdikdə açılan pəncərədə parolu daxil 
etmək lazımdır.  

 Area Unlock. Əmr parolla müdafiəni aradan qaldırır. 
                                                           
1 Bunun üçün əmri yerinə yetirdikdə açılan pəncərənin  Display bölməsində 
Highlight Region və Show Border parametrlərini seçmək, Choose Color 
düyməsini sıxıb açılan rəng palitrasından fon üçün rəng seçmək lazımdır. 
2 Bu xassə əmri yerinə  yetirdikdə açılan pəncərənin Text bölməsinin 
Occupy Page Width və Push Regions Down As You Type parametrləri ilə 
tənzimlənir. 
3 Bu xassə əmri yerinə yetirdikdə açılan pəncərənin Calculation bölməsinin 
Disable Evaluation, Enable Evaluation  parametrləri ilə tənzimlənir. 
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 Area Expand. Əmr qeyd olunmuş bağlı sahəni açır. 
 Area Collapse. Əmr qeyd olunmuş sahəni bağlayır. 

Qeyd: Menyunun Repaginete Now və Headear/Footers 
əmrləri haqqında məlumat  §1.2 verilmişdir. 

 
 
 
 
 
 

1.9 MATHCADDA PROQRAMLAŞDIRMA 
VASİTƏLƏRİ 

 
Mathcad-da nəzərdə tutulmuş proqramlaşdırma 

vasitələri paketin imkanlarını xeyli artırır. Xüsusilə, mürəkkəb 
məsələlərin həllində proqramlaşdırma vasitələrindən istifadə 
etmək lazım gəlir. Proqramlaşdırma vasitələri istifadəçilərə 
Mathcad-da proqram modulları hazırlamaqla, paketin alqoritm 
bazasını genişləndirə imkanı verir. Bunun üçün adətən proqram 
funksiya anlayışından istifadə olunur. Proqram funksiya 
aşağıdakı yazılış formasına malikdir: 

< Proqram funksiyanın adı> (<formal parametrlər siyahısı>):= 
<proqram funksiyanın gövdəsi>. 

Funksiyanın adı hərflə başlamalı, formal parametrlər isə bir-
birindən vergüllə ayrılmalıdır. Proqram funksiyanın gövdəsi 
Programming alətlər panelinin Add Line düyməsini sıxdıqdan 
sonra sənədə daxil olunan şaquli xəttin sağında bir və ya bir 
neçə sətirdə yazılan operatorlar və ifadələr siyahısından təşkil 
olunur. Gövdədə axırıncı ifadə  proqram funksiyasının adı ilə 
qaytarılan ifadə olmalıdır.  Məsələn,  
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f x( ) x x 2

z x

1

3


z



 
Proqram funksiya daxilində dəyişənə sabit və ifadə 
mənimsədilməsi üçün lokal mənimsətmə operatorundan 
istifadə olunur. Lokal mənimsətmə operatoru Programming 
alətlər panelinin  alətini sıxmaqla  daxil edilir. Müəyyən 
şərtlər daxilində konkret operatorların yerinə yetirilməsini 
təmin etmək üçün isə Şərti keçid operatorundan istifadə olunur.  
Şərti keçid operatoru aşağıdakı yazılış formasına malikdir: 

                  <operator>            if<şərt> 

<operator>         Otherwise 

Şərt Boolean  panelinin Bul operatorları (<, >,, , ) vasitəsilə 
tərtib edilir. Operator yerinə yetirildikdə ilk öncə şərt 
yoxlanılır. Şərt ödənildikdə İf identifikatorunun solundakı 
operator yerinə yetirilir. Əks halda növbəti operator yerinə 
yetirilir.  Məsələn,  

Z(t ) =













4),ln(
43,

;3,
2

3

tt
tt

tt
 

funksiyanı hesablamaq üçün proqram-funksiya aşağıdakı kimi 
olacaqdır: 

z( )t ift3 t 3

ift2 3 t 4

otherwiseln( )t

 

Digər alqoritmik dillərdə olduğu kimi Mathcad-da da dövr 
operatoru nəzərdə tutulmuşdur. İki növ dövr operatorundan 
istifadə edilir: 
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1. Dövrün sayı məlum olduqda 

 for< dövr parametri> diskret dəyişmə diapozonu 
və ya vektor  

yazılışa malik dövr operatoru; 
2. Dövrün sayı məlum olmadıqda 

 while <şərt> 

<operator> 
      - - -   
  <operator>  

yazılışına  malik dövr operatoru. 
Fərz edək ki, xf (x) e cos(2x) , x [x0, xk]  funksiyasının 
qiymətlərini müəyyən d  addımı ilə hesablamaq tələb olunur. 
Onda proqramm funksiya aşağıdakı şəkildə olmalıdır. 
 
 
 

 

 
 
 
 
 
Aşağıdakı proqram-funksiya isə kvadrat kökün hesablanmasını 
təmin edir və iterasiya prosesi ikinci növ dövr operatoru 
vasitəsilə yerinə yetirilir. 

sqroot ( ),a eps xc 1.0e10

xn a

while

xc xn

xn
xc

a
xc

2

>abs ( )xn xc eps

xn  

form_tab ( ),,x0 xk d i 1

for

z .exp ( )( )x cos ( ).2 x

yi z

i i 1

x ..,x0 x0 d xk

y



Riyazi proqram paketləri 41

Praktikada dövr operatoru daxilində Continue 
operatorundan da istifadə olunur. Bu operator idarəni dövrün 
əvvəlinə qaytarır. Məsələn, 

x z 0

z z 1

continue

z 10while



 
Proqram funksiyanın gövdəsində istifadə olunan Return 
operatoru isə proqram funksiyanın yerinə yetirilməsini 
dayandırmaqla ondan sonra yazılmış ifadənin qiymətini 
funksiyanın adı vasitəsilə sənədə qaytarır. Qeyd edək ki, 
sənəddə proqramm funksiyaya müraciət onun adı ilə həyata 
keçirilir. Bu zaman formal parametrlər faktiki parametrlə əvəz 
olunur. Buna görə də faktiki və formal parametrlərin sayı eyni 
olmalıdır. Məsələn,  

=sqroot ( ),25 0.0001 5  

Proqram funksiyaya cari sənəddən başqa, digər sənədlərdən də 
müraciət oluna bilər. Məsələn, fərz edək ki, inteqralın 
hesablanması üçün Simpson  adlı proqram funksiya azad.mcd 
sənədində hazırlanmışdır. Digər, məsələn anar.mcd sənədindən 
proqram funksiyaya müraciət etmək üçün ilk növbədə 
İnsertReference əmrini  yerinə yetirib, açılan pəncərədə 
anar.mcd faylının ünvanını müəyyən edib OK düyməsini 
sıxmaq lazımdır. Bundan sonra isə proqram funksiyasının adı 
ilə ona müraciət etmək olar. 
1.10 QEYRİ-XƏTTİ TƏNLİKLƏRİN  VƏ TƏNLİKLƏR 

SİSTEMİNİN HƏLLİ 
 

Bir sıra tənliklər, o cümlədən transendent, tərtibi 
dörddən yüksək olan cəbri  tənliklər analitik həll olunmur1. 
Buna görə bu tip tənliklər ədədi üsulla həll olunur. Bu 
                                                           
1 Abel(1802-1829) və Qalua (1811-1832) isbat etmişlər ki, tərtibi 4-dən çox 
olan cəbri tənlikləri analitik həll etmək mümkün deyil 
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məqsədlə Mathcad-da ( ( 1, 2, ), 1, , )root f x x x a bK  funksiyası 
nəzərdə tutulmuşdur, burada ( 1, 2, )f x x K  tənliyin sağ tərəfini 
təyin edən skalyar funksiya, 1, 2,x x K isə funksiyanın skalyar 
arqumentləridir. x1,a,b müvafiq olaraq tənliyin kökünün 
funksiyanın hansı arqumentinə görə axtarıldığını və həllin 
axtarıldığı parçanı təyin edir.  1x -arqumentinə həllin başlanğıc 
yaxınlaşması üçün qiymət mənimsədilməlidir. Həllin başlanğıc 
yaxınlaşması əsasən qrafiki yolla, digər ədədi üsulla təyin edilə 

bilər.  Məsələn, [-3, 3] intervalında 
 2

1 2cos( ) 0
5

x
x





 tənliyini 

həll etmək üçün ilk öncə 
 2

1 2cos( )( )
5

xf x
x





 funksiyasının 

qrafikini  qurub tənliyin həlli üçün başlanğıc yaxınlaşmanı 
təyin etmək lazımdır.  Qrafikdə başlanğıc yaxınlaşma olaraq 

: 1.1x    qəbul edib, ( ( ), ,1.0,2.0)root f x x  funksiyasını tətbiq 
etdikdə tənliyin [1,2]  parçasında kökünu təyin etmək olar. 
(şək.1.10-1) Hesablama avtomatik olaraq proqram tərəfindən 
təyin edilən TOOL=0.001 dəqiqliklə yerinə yetirilir. İstifadəçi 
hesablamanın dəqiqliyini dəyişmək üçün MathOptions 
əmrini yerinə yetirib açılan pəncərədə dəqiqlik üçün başqa 
parametri müəyyən edə bilər. Digər sadə üsul isə sənədə 
TOOL:=<ədəd> sətrini daxil etməkdir. Tapılmış həllin tənliyin 
həlli olduğunu yoxlamaq üçün tapılmış nöqtədə f(x) 
funksiyasının  qiymətini hesablamaq lazımdır.    
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x 3 0.5 3 f x( )
1 2 cos x( )

x 5( )
2



4 3.33 2.67 2 1.33 0.67 0 0.67 1.33 2
0.5
0.35
0.2
0.05
0.1
0.25
0.4
0.55
0.7
0.85

1

f x( )

x

TOl 10
9

 x 1.1 x1 root f x( ) x 1 2( ) x1 1.047

y f x1( ) y 3.358 10
15

  

şək.1.10-1 

Qeyd: Əgər tənliyin  kompleks kökünü  tapmaq tələb olunarsa,  
onda başlanğıc yaxınlaşmanı kompleks ədəd kimi vermək 
lazımdır. 

Əgər tənliyin sağ tərəfi çoxhədli olarsa, tənliyin kökünü 
tapmaq uçun ( )Polyroots v funksiyasından istifadə etmək 
məsləhətdir, burada v -çoxhədlinin əmsallarından ibarət sütun 
vektordur. Tutaq ki, p(x)=x3+2x2-1 çoxhədlisinin kökünü 
tapmaq lazımdır. Bunun üçün ilk öncə v  vektorunu təyin edib, 

( )Polyroots v  funksiyasını daxil edib “=” düyməsini sıxmaq 
lazımdır. Coxhədlinin kökləri “=” işarəsinin sağında vektor 
şəklində əks olanacaqdır. 

v

1

0

2

1















 polyroots v( )

1.618

1

0.618














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Qeyd edək ki, poluroots(v) funksiyası çoxhədlinin kökünü 
Laqqer və ya  qoşma matrislər üsulu əsasında tapır. Konkret 
üsulu istifadəçi kursoru funksiyanın adının üzərinə qoyub,  
siçanın sağ düyməsini sıxmaqla açılan kontekst menyunun 
müvafiq olaraq LaGuerre və Companion Matrix  əmrlərindən 
birini yerinə yetirməklə seçə bilər. 

 Mathcad-da qeyri-xətti tənliklər sisteminin həlli üçün 
ilk öncə başlanğıc qiymətləri daxil etmək, sonra given sözünü 
yazıb, tənliklər sistemini daxili etmək lazımdır. Bu zaman 
bərabərlik işarəsi  «Ctrl+=» qızğın düyməsini sıxmaqla daxil 
olunmalıdır.  Daha sonra Find (x1, x2,…) funksiyasını daxil 
edib klaviaturanın “=” düyməsini sıxmaq lazımdır(şək.1.10-2). 
Qeyd edək ki,  Find funksiyası sistem tənliyin həllinin qoşma 
qradiyent, Kvazi-Nyuton və Levenberq üsulları ilə tapılmasını  
təmin edir və həllin tapılması üçün istifadə olunan üsul adətən 
avtomatik olaraq paket tərfindən müəyyən olunur. Lakin, 
istifadəçi sistem tənliyin həlli üçün  üsulu özü də müəyyən edə 
bilər. Bunun üçün o, kursoru Find funksiyasının üzərinə qoyub 
kontekst menyunun üsula müvafiq Nonlinear → Conjugate 
Gradient, Nonlinear → Quasi-Newton və ya  Nonlinear → 
Levenberg-Marquardt əmrlərindən birini seçmələidir. 

 
x 4 y 8

Given

x 6 y
3

 0

x
2

y 9 0

Find x y( )
2.742

1.482











 
şək.1.10-2 
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İstifadəçi həmçinin kontekst menyunun Nonlinear → 
Advanced Options  əmri vasitəsilə üsul üçün bir sıra əlavə 
parametrlər  müəyyən edə bilər. 

Tənliklər sistemini dəqiq həll etmək mümkün 
olmadıqda, minimal xətanı təmin edən ən yaxşı kökü tapmaq 
üçün Find funksiyasının əvəzinə Minerr funksiyasından 
istifadə edilir.  Given bloku nə qədər tənlik, yaxud 
bərabərsizliyə malikdirsə, Minerr və ya Find funksiyası ona 
bərabər, yaxud ondan az arqumentə malik olmalıdır. Sistemin 
həllini  verilmiş başlanğıc yaxınlaşma ilə tapmaq mümkün 
olmadıqda qırmızı çərçivədə Did not find solution məlumatı 
ekranda əks olunur.  
 
 
 
 
 
 
 
 

1.11 MASSİVLƏR  ÜZƏRİNDƏ ƏMƏLİYYATLAR VƏ 
XƏTTİ  TƏNLİKLƏR SİSTEMİNİN   HƏLLİ 

 
Bir sıra riyazi, fiziki məsələlərin həlli matrislər və 

vektorlar üzərində müəyyən hesablama əməliyyatları 
aparılmasını tələb edir.  Bu məqsədlə Mathcad-da bir sıra 
vasitələr nəzərdə tutulmuşdur. Mathcad-da matrisi və ya 
vektoru təyin etmək üçün ilk növbədə hesablama blokunda 
klaviaturadan matrisin və ya vektorun adını və mənimsətmə 
işarəsini-“:=” daxil etmək, Matrix alətlər panelinin  alətini 
sıxmaqla və ya menyunun İnsert → Matrix əmrini yerinə 
yetirməklə açılan dialoq pəncərəsində matrisin və vektorun 
ölçüsünü: matrislər üçün sətir və sütunların, vektor üçün isə 
elementlərin sayını  müəyyən etmək lazımdır. Bu zaman 
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mənimsətmə işarəsindən sağda əks olunan şablon sahəsində  
istifadəçi  matrisin və ya vektorun elementlərini daxil 
etməlidir. 

Massivlər üzərində əməliyyatlar Symbolics menyusunun 
müvafiq əmrləri (bax: Simvolik hesablamalar), Matrix alətlər 
panelinin alətləri, xususi funksiyalar vasitəsilə həyata keçirilir. 
Matrix panelinin alətləri aşağıdakı funksiyaları yerinə yetirir:  

  1. -Matrisin və ya vektorun  ölçülərinin  müəyyən 
edilməsini; 

  2. - Matrisin və ya vektorun aşağı indeksinin təyin 
edilməsini; 

  3.  -Matrisin və ya vektorun tərs matrisinin 
hesablanmasını;   

  4. -Matrisin determinantının, vektorun uzunluğunun 
hesablanmasını; 

  5.  Matrisin elementlərinin hasilinin hesablanmasını; 
  6.  Matrisin sütununun təyini; 
  7.  Matrisin transponirə edilməsini;  
  8.  Vektorların skalyar hasilinin hesablanmasını; 
10. Vektorların komponentlərinin cəminin tapılmasını;  
11. Diskret dəyişənin dəyişmə diapozonunun müəyyən 

edilməsini. 
Alətlər paneli ilə müəyyən əməliyyatı yerinə yetirmək üçün 
matrisi və ya vektoru qeyd etmək və sonra da müvafiq aləti 
sıxmaq lazımdır. 

Qeyd edildiyi kimi, proqramın Symbolics menyusunun 
Matrix → Tranpose, Matrix → İnvient və Matrix → 
Determinant əmrləri   matrisin transponirə olunmasını, 
matrisin tərs matrisinin tapılmasını və matrisin determinantını 
hesablayır. Adi riyazi yazılışda matrisin elementlərinin 
indeksləri birdən başlayaraq nömrələnir. Lakin, Mathcad – da 
avtomatik olaraq indekslər sıfırdan başlayaraq nömrələnir. Bu 
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uyğunsuzluğu aradan qaldırmaq üçün Orgin: =1 əmrini yerinə 
yetirmək kifayətdir. Matrislər üzərində əməliyyat aparmaq 
üçün nəzərdə tutulmuş standart funksiyalar Vector and Matrix 
kateqoriyasında toplanılmışdır və aşağıdakılardan ibarətdir: 

1.Matrix (m, n, f). Funksiya elementləri f funksiyası ilə 
təyin olunan m n  ölçülü matris yaradır. Məsələn, 

f i j( ) i 0.1 j matrix 3 3 f( )

0

1

2

0.1

1.1

2.1

0.2

1.2

2.2















 
2.Diaq (v). Funksiya baş diaqonal elementləri v vektorunun 

komponentlərindən ibarət olan diaqonal matris yaradır. 
Məsələn,  

v

1

2

8

9















 diag v( )

1

0

0

0

0

2

0

0

0

0

8

0

0

0

0

9

















 

3.İndentity (n). Funksiya n tərtibli vahid matris yaradır. 
Məsələn, 

identity 2( )
1

0

0

1











 
4. Augment (A, B). Funksiya ilk sütunları A matrisindən, 

digər sütunları B matrisindən ibarət yeni matris yaradır. (A və 
B matrisləri eyni sayda sütunlara malik olmalıdır). Məsələn, 
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A

1

0

1

3

3

8

6

4

5

4

6

5















 B

2

1

5

6

5

9

6

5

7

8

7

9















 augment A B( )

1

0

1

3

3

8

6

4

5

4

6

5

2

1

5

6

5

9

6

5

7

8

7

9

















 

5. Stack (A, B). Funksiya ilk sətirləri A matrisindən, yerdə 
qalan sətirləri B matrisindən ibarət yeni  matris yaradır. 
Məsələn, 

A

1

0

1

3

3

8

6

4

5

4

6

5















 B

2

1

5

6

5

9

6

5

7

8

7

9

















stack A B( )

1

0

1

3

2

1

5

6

3

8

6

4

5

9

6

5

5

4

6

5

7

8

7

9





























 

6. Submatrix (A, ri, rj, ci, cj). Funksiya sətirləri  A 
matrisinin ri sətirlərindən rj sətirlərinə qədər sətirlərdən, 
sütunları ci sütunundan, cj sütununa qədər sütunlardan təşkil 
edilmiş yeni matris yaradır ( ri rj, ci cj  ). Məsələn, 

A

11

3

0

12

4

1

13

2

4













 submatrix A 1 2 0 1( )
3

0

4

1











 

7. tr (A). Funksiya kvadrat A matrisinin izini hesablayır. 
Məsələn, 
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A

1

5

5

9

3

1

7

8

4

3

8

2

6

4

9

3















 tr A( ) 13

 

8.Rank (A) . Funksiya A matrisinin ranqını hesablayır: 

A

1

5

5

9

3

1

7

8

4

3

8

2

6

4

9

3















 rank A( ) 4

 

9. Max (A)  və Min (A) . Funksiya A matrisinin müvafiq 
olaraq ən böyük və ən kiçik elementini hesablayır. Məsələn, 

A

1

4

9

4

5

23

6

8

45

1

9

1













 max A( ) 45 min A( ) 1

 

10. Cols (A) və Rows (A). Funksiyaları müvafiq olaraq A 
matrisinin sütunlarının və sətirlərinin sayını hesablayır. 
Məsələn, 

A

1

4

9

4

5

23

6

8

45

1

9

1













 cols A( ) 4 rows A( ) 3

 

11. Last (v). Funksiya vektorun son komponentinin 
indeksini tapır. Məsələn, 
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V

1

2

3

5

2

3























 last V( ) 5

 
12. Length (v). Funksiya vektorun komponentlərinin sayını 

tapır. Məsələn, 

V

1

2

3

5

2

3





















 length V( ) 6

 
13.Norm(A), norm2 (A), norme(A), normi(A). Funksiyalar 

müvafiq olaraq kvadrat A matrisinin 1L , 2L  və Evklid 
fəzalarında normasını   və max-normanı hesablayır. Məsələn,  

A

1

3

0

3

4

1

1

2

4













 norm1 A( ) 8 norm2 A( ) 6.776

norme A( ) 7.55 normi A( ) 9

 

14.Rref (A). Funksiya A matrisini vahid bazis minorlu  
pilləvari matrisə çevirir. Məsələn, 
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A

1

4

9

4

5

23

6

8

45

1

9

1













 rref A( )

1

0

0

0

1

0

0

0

1

3.073

1.587

1.404















 

15.Eigenvals (A). Funksiya kvadrat matrisin məxsusi 
ədədlərini təyin edir. Məsələn, 

A

11

3

0

12

4

1

13

2

4













 eigenvals A( )

14.751

1.033

3.216















 

16. Eigenvec (A,I). Funksiya I məxsusi ədədinə uyğun A 
matrisinin məxsusi vektorunu təyin edir. Məsələn, 

C

1

0

3

2

1

4

3

2

1













 eigenvecs C( )

0.625

0.321

0.711

0.76

0.611

0.222

0.415

0.432

0.801















L eigenvals C( ) eigenvec C L2 
0.76

0.611

0.222















 
17. Eigenvecs (A). FunksiyaA kvadrat matrisinin məxsusi 

vektorlarını hesablayır.  Funksiyanın tətbiqi sütunları A 
matrisinin məxsusi ədədlərinə uyğun vektorlar olan matris 
verir. Məsələn, 
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A

11

3

0

12

4

1

13

2

4













 eigenvecs A( )

0.962

0.273

0.025

0.587

0.767

0.259

0.342

0.58

0.74















 
18. Sort(V), csort(A,i), rsort(A,i), reverse(V) funksiyaları 

müvafiq olaraq  V vektorunun elementlərinin, A matrisinin i-ci 
sütununun elementlərini, A matrisinin i-ci sətirinin 
elementlərini ədədi qiymətlərinin artma ardıcıllığı ilə və V 
vektorunun elementlərini indeksin azalma ardıcıllığı ilə 
nizamlayır. Məsələn, 

V

1

3

2













 sort V( )

3

1

2













 reverse V( )

2

3

1















 

A

1

2

4

3

0

34

5

9

6











 csort A 1( )

4

1

2

34

3

0

6

5

9













rsort A 0( )

3

0

34

1

2

4

5

9

6













 
Matris və vektorlarla yuxarıda qeyd olunan əməliyyat 

vasitələrindən istifadə etməklə matrislər nəzəriyyəsinin bir sıra  
təklif, teorem və lemmalarını isbat etmək olar. Misal olaraq, 
aşağıdakı təklifin doğruluğunu isbat edək: 

Təklif:  1 1det A
det A

   

Doğrudan da, verilmiş A matrisi  
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A
a11

a21

a12

a22










a22

 
üçün 

A a11 a22 a12 a21 1

A

1

a11 a22 a12 a21(


A 1 1

a11 a22 a12 a21( )


 
Xətti tənliklər sistemi  Mathcad-da bir sıra vasitələrlə həll 

edilə bilər. Bunlardan bir neçəsi ilə tanış olaq: 
 Given-Find hesablama bloku vasitəsilə1; Məsələn, 

x 9 y 1 z 0

Given

x 5 y 2 z 1

0.7 x 2 y 5 z 2.9

3 x 2 y 4 z 23

Find x y z( )

9.865

1.392

0.953















 
 Lsolve(A,b) funksiyasını tətbiq etməklə; İlk öncə sistem 

Ax b şəklinə salınmalı və A matrisi və b-vektoru daxil 
edilməli, sonra isə funksiya tətbiq edilməlidir. Məsələn, 

A

1

0.7

3

5

2

2

2

5

4













 b

1

2.9

23













 lsolve A b( )

8.727

1.534

0.028















 
Nəticənin yoxlanılması: 
                                                           
1 Blok qeyri-xətti tənliklər sisteminin  həllində olduğu kimi tətbiq olunur.   
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A lsolve A b( )

1

2.9

23















 
 Sistemin həllini 1x A b  kimi təyin etməklə; Məlumdur  ki, 

bunun üçün  Ax b  şəklində verilmiş sistem qeyri-
sinqulyar olmalıdır. Məsələn, 

A

1

0.7

3

5

2

2

2

5

4













 b

1

2.9

23













 x A
1
b x

8.727

1.534

0.028















 
 Konkret ədədi üsulu tətbiq etməklə; Misal olaraq xətti 

tənliklər sistemini Qauss və Zeydel üsulu ilə həll edək: 

1.Qauss usulu.  Bu üsulla  













23922
113124
65213

zyx
zyx
zyx

 

xətti tənliklər sistemini həll etmək üçün aşağıdakı əməliyyatları 
yerinə yetirməliyik: 

1.Sistemi matris -Ax=b formasına gətirib, A matrisini və 
b vektorunu Mathcad sənədinə daxil etməli; 

A

13

4

2

2

12

2

5

3

9













 b

6

11

23















 
2. A matrisinin genişlənmiş Ar matrisini yaratmalı; 

Ar augment A b( )
 

3. Ar- matrisini pilləvari matrisə gətirməli; 
Ag rref Ar( )  
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4. Pilləvari formaya gətirilmiş matrisin son sütunu sistemin 
həlli olduğündan, matrisdən sistemin həlli olan x 
vektorunu təyin etməli; 

x submatrix Ag 0 2 3 3( ) x

0.902

1.912

2.78















 
5.Alınmış vektorun sistemin həlli olduğunu yoxlamalı. 

A x

6

11

23















 
2. Zeydel  üsulu. Zeydel  üsulunun mahiyyəti ondan ibarətdir 
ki, Ax =b tənliklər sistemi x=c+Bx formasına gətirilir və 
sistemin həlli x(k)=c+B x(k-1), k=1,2 … ardıcıllığının  limiti kimi 
təyin edilir.  Qeyd edək ki, üsulun yığılması üçün 

||B||  1 və 
(к) (к 1)

(к)

|| х х ||
|| х ||




  

şərti ödənilməlidir. Burada ||.|| -matris və vektorun norması,    
isə qəbul edilmiş xətadır. 

Məsələnin Mathcad-da həlli aşağıdakı alqoritmlə yerinə 
yetirilir: 

1. Sistemin A matrisi və b vektoru daxil edilir; Məsələn, 

ORIGIN 1
A

15

2

2

2

3

16

3

3

4

4

17

4

5

5

5

18















 b

13

1

17

50

















 
2. Sistem  x=Bx+c formasına gətirilir, B matrisi və c 

vektoru təyin olunur; 
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PB A n( )

Bi j 0 i jif

Bi j
Ai j

Ai i
 i jif

j 1 nfor

i 1 nfor

B

 Pc A b n( )

ci
bi

Ai i


i 1 nfor

c



 
B PB A 4( )

B

0

0.125

0.1176470588

0.1111111111

0.2

0

0.1764705882

0.1666666667

0.2666666667

0.25

0

0.2222222222

0.3333333333

0.3125

0.2941176471

0

















 

c Pc A b 4( )

c

0.8666666667

0.0625

1

2.7777777778

















 
3.Yığılma üçün kafi şərt: ||B||  1 yoxlanılır; 

normB B n( )

si

1

n

j

Bi j




i 1 nfor

max s( )



normB B 4( ) 0.8  
4. Başlanğıc yaxınlaşma vektoru daxil edilir; 
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x0

0

1

1.2

2

















 
6.Ardıcıl yaxınlaşmalar hesablanır: 
zeid B c n k x0( ) y x0

x y

u 0

j 1

u u Bi j yj

j j 1

1 j iwhile

j i 1

u u Bi j xj

j j 1

i j nwhile

yi u ci

i 1 nfor

rezm i yi

i 1 nfor

m 1 kfor

rez



 
y zeid B c 4 10 x0( )  
7.Üsulun xətası hesablanır və sistemin həlli təyin edilir. 

i 1 4 d i y 10 i x i max d( ) 6.7149530381 10
8


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y10 i
1.4529914397
0.3760684432

1.7606837815

-3.3931624075



 
 
 
 

1.12 ADİ DİFERENSİAL TƏNLİKLƏRİN HƏLLİ 
 

1.12.1 Adi diferensial tənliklər üçün Koşi məsələsinin  həlli. 

Mathcad-da diferensial tənliklər yalnız ədədi üsullarla 
həll olunur və bu üsulları tətbiq etmək üçün konkret 
funksiyalara müraciət etmək lazımdır. Normal diferensial 
tənliklər sistemi üçün Koşi məsələsi aşağıdakı funksiyalar 
vasitəsilə həll olunur: 

 Rkfixed(y,x1.x2,n,D)1, 
 Rkadapt(y,x1.x2,n,D)2,  
 Rkadapt(y,x1.x2,acc,n,D,kmax,s)3,  
 Bulstoer(y,x1.x2,n,D)4, 
 Bulstoer(y,x1.x2,acc,n,D,kmax,s)5 , 

burada y-başlanğıc şərtlər vektoru, x1- inteqrallama parçasının 
başlanğıc, x2- bu parçanın son və ya qeyd olunmuş nöqtələri, 
n-inteqrallama parçasının  düyün nöqtələrinin sayı, D 
elementləri ),( yxfi  olan vektor,  acc-inteqrallama addımı 
avtomatik seçiləndə həllin xətasını tənzimləyən parametr, 

                                                           
1 Məsələni parçada sabit addımlı Runqe-Kutta üsulu ilə həll edir. 
2 Məsələni parçada dəyişən addımlı Runqe-Kutta üsulu ilə həll edir. 
3 Məsələni qeyd olunan nöqtədə dəyişən addımlı Runqe-Kutta üsulu ilə həll 
edir. 
4 Məsələni parçada Bulirş-Şter üsulu ilə həll edir. 
5 Məsəlni qeyd olunmuş nöqtədə  Bulirş-Şter üsulu ilə həll edir. 
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kmax- düyün nöqtələrinin maksimal sayı, s-qeyri-bərabər 
addımlı şəbəkə üçün addımın ən kiçik qiymətidir.  

Məsələnin həlli  n+1 sütuna malik  matris və ya qrafik 
şəklində əks olunur. Belə ki, matrisin birinci sütunu 
inteqrallama parçasının düyün nöqtələrindən, ikinci sütun 
düyün nöqtələrində funksiyanın qiymətlərindən, yerdə qalan 
sütunlar isə müvafiq törəmələrin düyün nöqtələrində 
qiymətlərindən təşkil olunmuşdur. Misal olaraq, Volter – Lotki 
sisteminə baxaq. Bu sistem qapalı arealda yırtıcılar  və 
təcavüzə məruz qalan heyvanların sayının artım dinamikasını 
təsvir edir: 

 

 

1
1 1 2 2

2
2 2 1 1

dN N N
dt

dN N N
dt

 

 

 

 
 

Fərz edək ki, başlanğıc anda  yırtıcıların sayı- 1 5N  ,  təcavüzə 

məruz qalan heyvanların sayı- 102 N , 









3,0
1,0

, 









04,0
03,0

 

vaxt interavlı [0;200], inteqrallama nöqtələrinin sayı n=400-dir.  
Məsələni  həll etmək  üçün başlanğıc verilənləri daxil etdikdən 
sonra,  Rkfixed funksiyasını tətbiq etmək və alınan həll 
əsasında  yırtıcı və təcavüzə məruz qalan heyvanların 
populyasiyasının artım dinamikasının qrafikini quramaq 
lazımdır (şək. 1.12-1).

  

ORIGIN 1 t 200 n 400 
0.03

0.04









 N
5

10









 
0.1

0.3











D t N( )

N1 
1


2
N2





N2 
2


1
N1













 Z rkfixed N 0 t n D( )
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k 1 n

0 50 100 150 200

10

20

30

Zk 2

Zk 3

Zk 1

Z

1 2 3

1
2

3

4

5

6

7

8

9

10

11

12

13

14

15

16

0 5 10
0.5 337 229

1 3.82 444

1.5 419 672

2 106 934

2.5 862 241

3 673 599

3.5 528 5.01

4 417 475

4.5 335 991

5 276 556

5.5 238 166

6 216 818

6.5 209 507

7 215 231

7.5 232 985



şək. 1.12-1
 

Yüksək tərtibli diferensial tənliklər normal diferensial tənliklər 
sisteminə gətirildiyindən onlar yuxarıda qeyd olunan  
funksiyalar vasitəsilə həll oluna bilər. Məsələn,  harmonik 
osilyator üçün Koşi məsələsinə  baxaq: 

0ʹ2ʺ 2  yyy  

0)0(ʹʹ y  

1)0(ʺ y  

Asanlıqla baxılan məsələ aşağıdakı sistem tənlik üçün Koşi 
məsələsinin həllinə gətirilir. 

 


















1)0(ʹ
0)0(ʹ

2ʹ
ʹ

2

x
y

yxx
xy
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Məsələnin həlli üçün Rkfixed, Rkadapt, Bulstoer  
funksiyalarını tətbiq edək. Bu zaman baxılan məsələnin həll 
alqoritmi aşağıdakı şəkildə olacaqdır (şək. 1.12-2). Bu üsulla 
hansı funksiyanın məsələni daha dəqiq və sürətlə yerinə 
yetirdiyini təyin etmək olar1. 

Sərt sistemlər halında Koşi məsələsinin həlli üçün 
aşağıdakı funksiyalardan istifadə olunur: 

 Stiffr(y,x1.x2,acc,D,J)2 
 Siffr(y,x1.x2,acc,D,J,kmax,s)3  
 Stiffb(y,x1.x2,acc,D,J)4  

etmək olar. Burada, 

1 1 1

1

2 2 2

1

1

( , ) ( , ) ( , )...

( , ) ( , ) ( , )...
( , )

............... .............. ... ...............
( , ) ( , ) ( , )...

n

n

n n n

x n

f x y f x y f x y
x y y

f x y f x y f x y
x y yJ x y

f x y f x y f x y
y y y

   
    
   
     
 
 
   

    

 

y
0

1









  0.1  1 n 100 D t y( )
y1

2  y1 y0 











 

k 1 n  

                                                           
1 Rkfixed funksiyasından fərqli olaraq Rkadapt funksiyası dəyişən addımlı 
Runqe-Kutta üsuluna əsaslanır və onun əsasında aparılan hesablama daha 
dəqiq olub, daha sürətlə yerinə yetirilir.  Bulstoer  funksiyasını həll hamar 
olduqda tətbiq etmək məsləhətdir. 
2 Sərt sistemlərin həllini parçada Rozenbrok alqoritmi ilə axtarır. 
3 Sərt sistemlərin həllini qeyd olunmuş nöqtədə  Rozenbrok alqoritmi ilə 
axtarır. 
4 Sərt sistemlərin həllini qeyd olunmuş nöqtədə  Bulirş-Şter  alqoritmi ilə 
axtarır. 
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Z2 Rkadapt y 0 5  n D( ) Z rkfixed y 0 5  n D( )

Z2

0 1 2 3
0
1

2

3

4

5

6

7

8

9

10

11

12

13

14

15

16

0 0 1
0.157 0.154 0.957

0.314 0.3 0.892

0.471 0.433 0.808

0.628 0.552 0.706

0.785 0.654 0.591

0.942 0.737 0.465

1.1 0.8 0.331

1.257 0.841 0.194

1.414 0.861 0.056

1.571 0.859 0.079

1.728 0.836 0.208

1.885 0.794 0.328

2.042 0.734 0.436

2.199 0.658 -0.53

2.356 0.568 0.609

2.513 0.467 -0.67

Z

0 1 2

0

1

2

3

4

5

6

7

8

9

10

11

12

13

14

15

0 0 1

0.157 0.154 0.957

0.314 0.3 0.892

0.471 0.433 0.808

0.628 0.552 0.706

0.785 0.654 0.591

0.942 0.737 0.465

1.1 0.8 0.331

1.257 0.841 0.194

1.414 0.861 0.056

1.571 0.859 -0.079

1.728 0.836 -0.208

1.885 0.794 -0.328

2.042 0.734 -0.436

2.199 0.658 -0.53

2.356 0.568 -0.609



Z1 Rkadapt y 0 5  n D( )

Z1

0 1 2

0

1

2

3

4

5

6

7

8

9

10

11

12

13

14

0 0 1

0.157 0.154 0.957

0.314 0.3 0.892

0.471 0.433 0.808

0.628 0.552 0.706

0.785 0.654 0.591

0.942 0.737 0.465

1.1 0.8 0.331

1.257 0.841 0.194

1.414 0.861 0.056

1.571 0.859 -0.079

1.728 0.836 -0.208

1.885 0.794 -0.328

2.042 0.734 -0.436

2 199 0 658 -0 53



 
şək. 1.12-2 

Sərt sistemlərə misal olaraq aşağıdakı sistemin  
'
1 1 2

'
2 1 2

11 9

9 11

y y y

y y y

   


  
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1 2(0) 1, (0) 0y y   şərtlərini ödəyən  həllinin axtarılması 
məsələsinə baxaq.  Məsələni həll etmək üçün inteqrallama 
parçasının düyün nöqtələrinin sayını 20 qəbul edərək,  Stiffr 
funksiyasını tətbiq edək və alınan nəticələr əsasında məsələnin 
inteqral və faza əyrilərini quraq (şək.1.12-3)

  
ORIGIN 1 y

1

0









 D x y( )
11 y1 9 y2

9 y1 11 y2











J x y( )
0

0

11

9

9

11









Y Stiffr y 0 2 20 D J( )

0 0.5 1 1

1

1

2

Y
2 

Y
3 

Y
1 

Y

1 2 3

1

2

3

4

5

6

7

8

9

10

11

12

13

14

15

16

0 1 0

0.1 477 342

0.2 344 326

0.3 276 273

0.4 225 225

0.5 184 184

0.6 151 151

0.7 123 123

0.8 101 101

0.9 083 083

1 068 068

1.1 055 055

1.2 045 045

1.3 037 037

1.4 0.03 0.03

1.5 025 025



Ìÿñÿëÿíèí èíòåãðàë ÿéðèñè
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Y
2 

Y
3 

 Y
1 

 
Ìÿñÿëÿíèí ôàçà ÿéðèñè  
şək. 1.12-3 

Mathcad paketində diferensial tənlik üçün  Koşi məsələsi 
həmçinin, Given/Odesolve  hesablama blokundan istifadə 
etməklə də həll edilə bilər. Məsələn,  fərz edək ki,  

' ln( )y y x x   

(0) 0,5y   

Koşi məsələsini həll etmək lazımdır. Məsələni həll etmək üçün 
sənədə Given sözünü, tənliyi və başlanğıc şərtini daxil etmək 
lazımdır. Bu zaman bərabərlik işarəsi «Ctrl+=» qızğın düyməsi 
vasitəsilə daxil edilməlidir. Daha sonra, ( , )odesolve x b  
funksiyasını tətbiq etmək və nəticəni qrafik şəklində əks 
etdirmək lazımdır (şək.1.12-4).  
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Given

x
y x( )d

d
y x( )

x
5

 sin x( )

y 0( ) 1

y odesolve x 2( )

0 1 2
1

2

3

y x( )

x  
şək.1.12-4 

Eyni qaydada yüksək tərtibli diferensial tənliklər üçün Koşi 
məsələsi həll olunur.  Məsələn,  aşağıdakı yazılış  

" 0,1 ' 0y y y    tənliyini (0) 0.1, '(0) 0y y   başlanğıc 
şərtləri daxilində həll etməyi və nəticənin inteqral əyrisi 
şəklində əks olunmasını təmin edir.   

Given

4
2
t
y t( )

d

d

2
 y t( ) 0

y 5( ) 135 y 0( ) 4

y Odesolve t 5( )  
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0 2 4 6
0

100

200

300

y t( )

t  
Qeyd edək ki, ədədi üsullarla tanış olan istifadəçilər Mathcad-
ın imkanlarından istifadə etməklə diferensial tənliyi digər 
məlum ədədi üsullarla həll edə bilər. Məsələn,  birinci tərtib 

( , )y f x y   üçün Koşi məsələsini  Eyler üsulu[5] ilə həll edək. 
Tutaq ki, ( , ) sin( ) f x y y x x ,  0,1x   və ( ) 1y o  . Koşi 
məsələsini  həll etmək üçün ilk növbədə bölgü nöqtələrinin 
sayı, başlanğıc şərt daxil edilir və addım müəyyən edilir. Sonra 
x və y vektoru  Eyler üsuluna görə hesablanılır və 
hesablamanın nəticəsi cədvəl və qrafik şəklində ekranda əks 
olunur (şək.1.12-5). 

a 0 b 1. f x y( ) y x sin x( )

n 10 h
b a

10


x0 0 y0 1

j 1 n

xj x0 j h

yj yj 1 h f xj 1 yj 1   
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şək.1.12-5 
 
 

1.12-2 Adi diferensial tənliklər üçün sərhəd məsələsi.  
Mathcad-da adi diferensial tənliklər üçün sərhəd 

məsələsinin həll üsullarından biri «atəş» üsuludur.  Üsulun 
ideyası ondan ibarətdir ki, sərhəddə məsələnin həlli üçün 
çatışmayan şərtlər təyin olunur. Konkret məsələnin həllinə bu 
üsulu tətbiq edək. Fərz edək ki,  

02ʺ 2
0  yyy                               (1.12-1) 

 1)0( y , 0)5( y                            (1.12-2) 

sərhəd məsələsini həll etmək tələb olunur. 
Məsəlnin həlli üçün iki tərtibli (1.12-1) tənliyini 

aşağıdakı sistem tənliyə gətirək  

2
02

y z
z z y 

 
    

       (1.12-3) 

və (1.12-2)-( 1.12-3) məsələsinin həllinə «atəş» üsulunu tətbiq 
edək. Bunun üçün Sbval(v,x0,xn,D,load,score) funksiyasından 
istifadə etməliyik, burada x0, xn həllin  axtarıldığı intervalın 
sərhədləri, D(x,y) elementləri tənliklər sisteminin  sağından 

0 0.5 1
1

1.5

2

2.5

y

x

x

0
0
1

2

3

4

5

6

7

8

9

10

0
0.1

0.2

0.3

0.4

0.5

0.6

0.7

0.8

0.9

1

 y

0
0
1

2

3

4

5

6

7

8

9

10

1
1.1

1.209

1.326

1.45

1.579

1.713

1.85

1.99

2.132

2.275


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təşkil olunmuş vektor funksiya, load(xmin,v) - elementləri 
tənliklər sisteminin  həll intervalının solunda axtarılan 
funksiyanın qiymətlərindən ibarət  vektor funksiyadır,  
score(xn,y) - elementləri v vektorunun elementlərinin sayı 
qədər olan vektor funksiyadır və onun hər bir elementi həll 
intervalının son nöqtəsindəki qiymət ilə başlanğıc qiymət 
arasındakı fərqi bildirir. Əgər sol sərhəddə axtarılan 
funksiyanın qiymətlərinin hamısı məlum deyilsə, naməlum 
qiymətlər v vektorunda başlanğıc yaxınlaşma kimi istifadəçi 
tərəfindən verilir. Baxılan məsələ üçün z funksiyasının x0 
nöqtəsində qiyməti  məlum olmadığından onun üçün başlanğıc 
qiyməti v vektorunda veririk və bundan sonra load(xmin,v)  və 
score(xn,y), D(t,y) funksiyalarını təyin edib,  
Sbval(v,x0,xn,D,load,score) funksiyasını tətbiq edərək 
catışmayan şərti təyin edirik. 

x0 0 xn 5  0.1 
0

1 v
0

0.1











 

load x0 v( )
1

v0







 score xn y( ) y0 0

 
 

D t y( )

y1

2  y1 y0 
0




2













S sbval v x0 xn D load score( )

S
12.511

1.151










 

 
Çatışmayan şərt təyin edildikdən sonra Koşi məsələsinin həlli 
üçün nəzərdə tutulmuş funksiyalardan biri, məsələn  Rkfixed 
funksiyasını tətbiq etməklə (1.12-2)-(1.12-3) məsələsinin 
həllini tapmaq olar (şək.1.12-6). 
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y
1

S0







 Z rkfixed y x0 xn 500 D( )

Z

0 1 2

0
1

2

3

4

5

6

7

8

9

10

11

12

13

14

15

0 1 2.511
0.031 1.391 2.395

0.063 1.779 2.268

0.094 2.162 2.129

0.126 2.541 1.979

0.157 2.914 1.819

0.188 3.283 1.648

0.22 3.646 1.466

0.251 4.003 1.275

0.283 4.355 1.073

0.314 4.699 0.862

0.346 5.037 0.642

0.377 5.368 0.412

0.408 5.691 0.174

0.44 6.007 9.927

0.471 6.315 9.671



 
şək.1.12-6 

Sərhəd şərti mürəkkəb formada verildikdə yuxarıda qeyd 
olunan üsulu tətbiq etmək mümkün olmur. Bu halda sərhəd 
məsələsinin həlli sonlu fərqlər üsulu ilə həll oluna bilər [5].  
 
 

 
1.13 XÜSUSİ  TÖRƏMƏLİ  DİFERENSİAL  

TƏNLİKLƏRİN HƏLLİ 
 

Xüsusi törəməli diferensial tənliklərin həll üsullarından 
biri şəbəkə üsuludur. Üsulu tətbiq etdikdə, ilk öncə  həllin 
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axtarıldığı oblastı paralel düz xəttlərlə şəbəkələrə bölüb, 
məsəlinin təqribi həllini şəbəkənin düyün nöqtələrində tapmaq 
lazımdır. Bunun üçün tənlikdə (x,y) nöqtəsini  ,i ix y  düyün 
nöqtəsilə və bu nöqtələrdə törəmələri uyğun sonlu fərqlərlə1 
əvəz edib, alınan fərq  tənliklər sistemini həll etmək lazımdır2. 
Şəbəkə  üsulunu baxılan məsələlərin həllərinin varlığını və 
yeganəliyini fərz etməklə hiperbolik, parabolik və elliptik tip 
tənliklərə tətbiq edək.  

 Hiperbolik tip tənlik 
Misal kimi dalğa tənliyi üçün qarışıq məsələyə  baxaq: 

2

2

22

2 1
t
u

vx
u






  

    ,
50

sin)0,( 


xxu 0)0,( xut ,  sx 0            (1.13-1) 

0),()0,(  stutu  
Tənliyə, başlanğıc və sərhəd şərtlərinə aşkar sonlu fərqlər 

sxemini tətbiq edib, qruplaşdırma apardıqdan sonra  baxılan 
məsələ aşağıdakı tənliklər sisteminin həllinə gətirilir: 

  

  1,,,1,,1

2
2

1, 22  





  jijijijijiji uuuuu
h

vu  

                  miuuiu iii ,0,
50

sin 0,1,0, 


 ,               (1.13-2)           

                               njuu jnj ,00,,0   
2va   və 

2







 
h

k  qəbul edərək, (1.13-2) sistemini Mathcad-da 

matrislər cəbri üçün nəzərdə tutulmuş vasitələrlə həll edib, 
nəticəni cədvəl şəklində əks etdirmək olar (şək.1.13-1).   
                                                           
1 Məsələnin qoyuluşndan asılı olaraq  müxtəlif fərq sxemlərini [5 ] tətbiq 
etmək olar. 
2 Fərq tənliklər  sisteminin həlli məsələnin şəbəkənin düyün nöqtələrində 
təqribi həlli hesab edilir. 
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n 20 m 100 i 0 m j 0 n

ui 0 sin
 i

50









 ui 1 ui 0 u0 j 0 um j 0

a 1 k 0.02

i 1 m 1 j 1 n 1

ui j 1 a
2

ui 1 j 2 ui j ui 1 j  2 ui j ui j 1  

u

13 14 15 16 17 18 19

83
84

85
86

87
88
89

90
91

92
93
94

95
96

97
98

-0.841 -1.085 -0.261 0.858 1.169 0.325 -0.886
-0.792 -1.065 -0.293 0.804 1.151 0.365 -0.827

-0.74 -1.04 -0.325 0.747 1.129 0.404 -0.764
-0.686 -1.012 -0.355 0.687 1.102 0.442 -0.698

-0.628 -0.979 -0.383 0.624 1.07 0.477 -0.629
-0.569 -0.942 -0.41 0.559 1.035 0.511 -0.558
-0.507 -0.902 -0.436 0.492 0.995 0.543 -0.484

-0.443 -0.858 -0.46 0.423 0.952 0.573 -0.409
-0.377 -0.811 -0.482 0.352 0.904 0.6 -0.332

-0.31 -0.761 -0.502 0.279 0.853 0.625 -0.253
-0.241 -0.708 -0.52 0.206 0.799 0.648 -0.174
-0.172 -0.651 -0.536 0.132 0.742 0.668 -0.094

-0.102 -0.593 -0.55 0.057 0.681 0.685 -0.014
-0.031 -0.532 -0.562 -0.018 0.618 0.7 0.067

0.04 -0.468 -0.571 -0.093 0.553 0.712 0.147
0.11 -0.403 -0.578 -0.168 0.485 0.721 0.226



 
şək.1.13-1 

Parabolik tip tənlik 
  Sonlu fərqlər üsulunu istilikkeçirmə tənliyi üçün 
qarışıq məsələnin həllinə tətbiq edək: 

2
2

2

u ua
t x

 


   

( , 0) sin (0 1),u x x x x     
(0, ) 0 (1, ) 1 (0 0, 025)u t u t t     

Qeyri-aşkar fərq sxemini tətbiq etdikdən sonra məsələ   
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    

      
         

M ML  

 
fərq tənliklər sisteminin həllinə gətirilir, harada 

2

a
h
  , 1,0   . 

 Şəbəkənin düyün nöqtələrinin sayını 30n  və  
5  qəbul etsək, məsələnin həlli üçün Mathcad sənədi 

aşağıdakı şəkildə olacaq: 
5: 30:n i 0 n  j 0 n  k 0 n 1 0: m 1 n 1  

ui 0 sin 
i
n






i
n

  

u0 j   u n j   
Ai i 1 2   Am m 1   A m 1 m   

i 0  0     i 0  0    
u j 1  A 1 u j      

 

Elliptik tip tənlik  

 
2 2 2

2 2

2

  2 , ,
      
0,

u u u u uA B C a b cu F x y
x y x yx y

D AC B

    
    

     

  

   (1.13-3) 
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 elliptik tənliyinə sonlu fərqlər üsulunu tətbiq etdikdə  
               , 1, , 1, , , 1 , , 1 , , ,i j i j i j i j i j i j i j i j i j i j i ja u b u c u d u e u f               

fərq tənliklər sitemini alırıq. Sərhəd şərti verildikdə fərq 
tənliklər sisteminə  relax(a, b, c, d, e, f, u, rjac) funksiyasını 
tətbiq etməklə həll etmək olar  və bu həll (1.13-3) tənliyi üçün 
sərhəd məsələsinin şəbəkənin düyün nöqtələrində təqribi həlli 
olacaqdır. Relax funksiyasının arqumentləri olan a, b, c, d, e, f -
elementləri , ,i ja , ,i jb , ,i jc , ,i jd , ,,i j i je f , olan kvadrat matrislər, u-
elementləri axtarılan funksiyanın həll oblastının 
sərhədlərindəki qiymətlərindən və oblastın daxili nöqtələrində 
həllin başlanğıc yaxınlaşmalarından ibarət  kvadrat matris, 
rjas-relaksasiya prosesini idarə edən parametrdir 
və 10  rjac . 

Misal olaraq Laplas tənliyi üçün sərhəd məsələsinə 
baxaq. 

                 
2 2

2 2 0 
 

 
u u

x y                                            (1.13-4) 

yyuyyuxuxu 21),1(,21),0(,1)0,(,1)1,(    (1.13-5) 
(1.13-4)-(1.13-5) məsələsinə uyğun, fərq tənliklər sistemi 
aşağıdakı şəkildə olacaqdır. 

       1
, 1, 1, , 1 , 1

1 ( )
4

k k k k k
i j i j i j i j i ju u u u u

         

                                                                                    (1.13-6) 

n
ju

n
juuu jnjini 21,21,1,1 ,,00,,                           

(1.13-6) fərq tənliklər sistemini  relaksiya üsulu ilə həlli isə 
aşağıdakı  Mathcad sənədində verilmişdir. 

n 16 i 0 n j 0 n

a i j 1 c a d a fi j 0 e 4 a  
u i j 0 u 1 n 1 u 0 j 1 2

j

n
 u i 0 1
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un j 1 2
j

n
 Z relax a b c d e f u 0.95( )
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FƏSİL 2 

 
 

MATLAB 7 
 

  Matlab riyazi proqram paketi keçən əsrin 70-ci illərində 
S.B.Moller tərəfindən yaradılmışdır və əsasən böyük elektron 
hesablama maşınlarında tətbiq edilirdi. 80-ci illərdə Math 
Works İnc. firmasının əməkdaşı Jon Little paketin İBM, VCX, 
Macintosh və Sun tipli fərdi kompüterlərdə və işçi 
stansiyalarda tətbiq edilməsinə nail oldu. Paketin təkmilləşmiş 
versiyası olan, Matlab 7 müxtəlif sinif kompüter və əməliyyat 
sistemi platformasında fəaliyyət göstərən, elm və texnikanın ən 
müxtəlif sahələrində geniş tətbiq olunan sistemdir.  Matlab 
vasitəsilə həll olunan problemlər spektri çox genişdir. Belə ki, 
paket siqnal və təsvirlərin işlənməsi, riyazi fizika, 
optimallaşdırma məsələlərinin, statistik verilənlərin analizi, 
neyron şəbəkələri, qeyri-səlis məntiq, elektrotexniki və 
radiotexniki hesablamaların və s. məsələlərin həllində əvəzsiz 
vasitədir.  
  Matlab  7 müasir ədədi və analitik üsulların həll 
alqoritmlərini reallaşdıran universal bir sistemdir. Bunun 
nəticəsində, məsələlər yüksək dəqiqliklə və operativ həll 
olunur. Paket həmçinin hesablamanın nəticəsinin qrafik və 
animasiya vasitəsilə vizuallığını təmin edir.  Matlab-ın əsas 
xüsusiyyəti onun «açıq» arxitekturaya malik və genişlənə bilən 
olmasıdır. Təcrübəli istifadəçilər nəinki, Matlab‐da reallaşmış 
həll alqoritmlərindən istifadə edə bilər, həmçinin Matlab‐ın  
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proqramlaşdırma vasitələrilə, C və ya Fortran proqramlaşdırma 
dillərində proqram tərtib etməklə fərdi alqoritm kitabxanası 
yarada bilər.  

 Matlab 7-də qrafiki proqram əlavələrin yaradılması 
üçün sadə interfeys vasitələri nəzərdə tutulmuşdur. Bundan 
başqa, paketdə tətbiq olunan API  interfeysi, C və ya Fortran 
dilində yazılmış hazır proqram modullarını Matlab-ın əmr 
sətirindən və ya fayl funksiyasından çağırmağı və əksinə, 
həmin proqram modullarından Matlab funksiyalarını yerinə 
yetirməyi təmin edir.  

 
 

2.1  İNTERFEYS  ELEMENTLƏRİ VƏ ƏSAS 
ANLAYIŞLAR 

 
Proqram yükləndikdə ekranda proqramın əsas interfeys 

pəncərəsi açılır (şək.2.1-1). Pəncərənin ən yuxarı hissəsində 
başlıq sətiri, ondan aşağıda menyu sətiri,  alətlər paneli, işçi 
sahə, ən aşağıda isə cari vəziyyət sətiri yerləşir. İşçi sahənin 
görünüşü View menyusu vasitəsilə tənzimlənir. Adətən, işçi 
sahənin sağ hissəsində Command History pəncərəsi, Launch 
Pad, Workspace, Current  Directory bölmələrindən ibarət 
pəncərə, sol hissəsində isə Command Window pəncərəsi 
yerləşir. İstifadəçi View menyusunun Command  History, 
Command Window, Launch  Pad, Workspace, Current 
Directory əmrlərinin qarşısında  √ işarəsini  götürməklə 
müvafiq bölmə və pəncərələri ekranda görünməz edə bilər1. 
İşçi sahənin ilkin görünüşünü bərpa etmək üçün  menyunun 
Desktop layout→Default əmrini yerinə yetirmək kifayətdir. 
                                                 
1 Qeyd olunan əmrlərdən hər hansı birini təkrar yerinə yetirməklə onların 
qarşısında √ işarəsi yenidən əks olunacaq və  müvafiq pəncərə və ya bölmə 
ekranda təkrar əks olunacaqdır.  
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şək.2.1-2 

Matlab-da hesablamalar əsasən riyazi ifadələr üzərində yerinə 
yetirilir. Riyazi ifadə Command Window pəncərəsinin əmr 
sətirində hər hansı dəyişənin adına mənimsədilə bilər və ya >> 
işarəsindən sonra birbaşa daxil edilə bilər. Qeyd edək ki, 
mənimsətmə işarəsi olaraq «=» işarəsi qəbul edilmişdir. 
Dəyişənin adı hərflə başlamalıdır və maksimum 31 simvoldan 
ibarət olmalıdır.1 Bu zaman kampilyator böyük və kiçik 
hərfləri fərqləndirir. Xüsusi sözlərdən: for, if, then, end, go to 
və s. dəyişən adı kimi istifadə etmək olmaz. İfadəni daxil edib 
Enter düyməsini sıxdıqdan sonra ifadənin qiyməti ekranda əks 
olunur. Əgər ifadə birbaşa əmr sətirinə daxil edilmişdirsə 
ifadənin qiyməti avtomatik olaraq ans adlı sistem dəyişəninə 
mənimsədilir.  İstifadəçi həmçinin hesablamanın nəticəsinin 

                                                 
1 31-ci simvoldan sağdakı simvollar sistem tərəfindən nəzərə alınmır. 
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formatını dəyişə bilər. Bunun üçün o, File→Reference əmrini 
yerinə yetirməli və açılan dialoq pəncərəsinin General 
bölməsində tələb olunan formatı müəyyən etməlidir. İfadə 
təyin olunmamış dəyişənə malik olduqda,  hesablama 
əməliyyatı yerinə yetirilmir və bu halda səhv haqqında 
məlumat ekranda əks olunur. İstifadə olunan dəyişənlərin 
siyahısına baxmaq tələb olunduqda Whose əmri yerinə 
yetirilməlidir. Dəyişənlərin siyahısına həmçinin,  interfeys 
pəncərəsinin işçi sahəsində, Workspace  bölməsinə daxil 
olmaqla da baxmaq olar.  

Matlab-da massiv tipli dəyişənlərdən istifadə olunur. 
Massivlər indeksləşmiş bircins elementlər toplusudur. İndeks 
elementin mövqeyini bildirir. Vektorlar bir indekslə, matrislər 
isə iki indekslə xarakterizə olunur.  Massivi təyin etmək üçün  
massivin adına kvadrat mötərizə ([ ])  daxilində, bir-birindən 
vergül və ya probellə ayrılmaqla massivin elementlərini 
mənimsətmək lazımdır. Vektorlardan fərqli olaraq matrisin  
sətir elementlərini daxil etdikdən sonra nöqtə-vergül (;) işarəsi 
qoymaq və  ya klaviaturanın Enter düyməsini sıxmaq lazımdır. 
Məsələn, 

>> F=[1 3 4; 4 6 7; 6 7 8] 
            F =     

  1     3     4  
   4     6     7 

                    6     7     8 

>> G=[1 2 3 
    2 3 4] 

G = 
      1     2     3 
      2     3     4 

Ədədi massivin elementləri müəyyən addımla fərqlənərsə, 
massiv  siyahı vasitəsilə-a:h:b kimi təyin oluna bilər. Məsələn,   
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>>A=[3:2:11;2:2:10] 
A = 

     3     5     7     9    11 
     2     4     6     8    10 

Müəyyən sinif  massivlər müvafiq funksiyalarla da təyin oluna 
bilər.  Bu məqsədlə aşağıdakı funksiyalar nəzərdə tutulmuşdur: 

 Eye  (n),  eye(n,m)    funksiyaları müvafiq olaraq n n  
ölçülü kvadrat və n m ölçülü düzbucaqlı vahid matrisi; 
Məsələn, 

>>eye(2,3) 
ans = 
     1     0     0 
     0     1     0 

 Hadmarad (n) funksiyası Adamar matrisini; Məsələn, 

>> B=hadamard(2) 
B = 
     1     1     
     1    ‐1    

 Hilb(n),  invhilb  (n) funksiyaları Hilbelt və tərs Hilbelt 
matrislərini; Məsələn, 

>> f=hilb(3) 
f = 
    1.0000    0.5000    0.3333 
    0.5000    0.3333    0.2500 
    0.3333    0.2500    0.2000 
>> g=invhilb(3) 
g = 
        9   ‐36    30 
   ‐36   192  ‐180 
    30  ‐180   180 

 Pascal(n) funksiyası  Paskal matrisini; Məsələn, 
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>> A=Pascal(4) 
A =  
     1     1     1     1 
     1     2     3     4 
     1     3     6    10 
     1     4    10    20 

 Wilkinson(n) funksiyası Uilkinson matrisini; Məsələn, 
>>D=wilkinson(5) 

D = 
     2     1     0     0     0 
     1     1     1     0     0 
     0     1     0     1     0 
     0     0     1     1     1 
     0     0     0     1     2 

 Rosser funksiyası Rosser matrisini;  
>> rosser 
ans = 
   611   196  -192   407    -8   -52   -49    29 
   196   899   113  -192   -71   -43    -8   -44 
  -192   113   899   196    61    49     8    52 
   407  -192   196   611     8    44    59   -23 
    -8   -71    61     8   411  -599   208   208 
   -52   -43    49    44  -599   411   208   208 
   -49    -8     8    59   208   208    99  -911 
    29   -44    52   -23   208   208  -911    99 

 Zeros(n),  Zeros(n,m)  funksiyaları  müvafiq olaraq 
kvadrat və düzbucaqlı sıfır matrislərini; Məsələn, 

>> zeros(3) 
ans = 
     0     0     0 
     0     0     0 
     0     0     0 
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 Ones(n), ones(n,m)  funksiyaları müvafiq olaraq kvadrat 
və düzbucaqlı vahid matrisləri təyin edir. Məsədən, 

>>ones(3,2) 
ans = 

     1     1 
     1     1 
     1     1 

Qeyd edək ki, Matlab vektoru, 1 n , ədədləri isə 1 1  tərtibli 
matris kimi qəbul edir. Əmr sətirində size(A)1 funksiyasını 
tətbiq etməklə buna əmin olmaq olar. Məsələn,  

>> A=7; 
>> size(A) 
ans = 

     1     1 
>> A=[1 2 3]; 
>> size(A) 
ans = 

     1     3 

Massivin ölçüsü haqqında məlumat almaq tələb olunduqda 
ndims(A) əmrini yerinə yetirmək lazımdır. Massivin konkret 
elementlərinə müraciət onun indeksi vasitəsilə həyata keçirilir. 
Məsələn, vektorun 4-cü elementini müəyyən etmək üçün V(4) 
yazılışından istifadə olunur. A(:, 4) yazılışı isə A matrisinin  4-
cü sütununu təyin edir.  

Massivlər üzərində bir sıra  əməliyyatlar aparmaq olar. 
Bunlardan bir neçəsini qeyd edək: 
1) Matrisdən konkret sətir və sütunu ləğv etmək olar. Bunun 

üçün verilmiş matrisin konkret sütununa və ya sətirinə boş 
matris mənimsətmək kifayətdir. Məsələn, 
>> A=[2 3 4;4 5 6; 5 6 7]; 

                                                 
1A-ixtiyari massivdir. 
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>> A(1,:)=[] 
A = 
     4     5     6 
     5     6     7 

2) Eyni tərtibli massivləri toplamaq və çıxmaq olar. Bu zaman 
matrislər nəzəriyyəsinin məlum xassələri ödənilir: 
a) A  (B C)=(A B)  C 
b) A B=B A 
c) A  [0]=A 1  

Məsələn, 
>> A=[2 3  4;4 5 6 ;3 2 1] 
A = 
     2     3     4 
     4     5     6 
     3     2     1  

>>A‐zeros(size(A)) 
ans = 

 2     3     4 
 4     5     6 
 3     2     1 

3) Eyni tərtibli massivlərin elementlərinin hasilini tapmaq 
olar.  Bu əməliyyat «.*» operatoru vasitəsilə yerinə yetirilir 
və bu zaman aşağıdakı xassələr ödənilir: 
a) iiiiiiijijijijijij cbacbacbacba  )()(;)()(  

b) )()();()( iiiiijijijij abbaabba   

4) Eyni tərtibli massivlərin elementlərinin sağ və sol 
nisbətlərini tapmaq olar. Bu əməliyyatlar müvafiq olaraq 
«./»   və «.\» operatorları vasitəsilə yerinə yetirilir. Aydındır 
ki, iiiiijijijij abbaabba //;//  . 

                                                 
1 [0] ilə ölçüsü A massivi ilə eyni olan sıfır matris işarə olunmuşdur.. 
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5) Matris və vektorlarının  hasilini tapmaq olar. Bu əməliyyat 
«*» operatoru vasitəsilə yerinə yetirilir. Nəzərə almaq 
lazımdır ki, matrislərin riyaziyyatdan məlum olan 
vurulması qaydasına görə birinci matrisin sətir 
elementlərinin sayı ikinci matrisin sütun elementlərinin 
sayına bərabər olmalıdır və matrisləri hasili üçün aşağıdakı 
xassələr ödənilir: 

a) A (B C)=(A B) C 
b) (A+B) C=A C+B C 
c) C (A+B)=C A+C B 
d)     BABA  , ( -ixtiari skalyar ədəddir). 

6) Massivi transponirə etmək olar. Bu əməliyyat «.’» 
operatoru vasitəsilə yerinə yetirilir. Məsələn,  
>> d=[12 3 4] 
d = 

    12     3     4 
>> d.ʹ 

ans = 
           12 
             3 
             4 

7) Massivin kompleks qoşmasını tapmaq olar.. Bu əməliyyat  
«’» operatoru vasitəsilə yerinə yetirilir. Məsələn, 
>> d=[1 2‐2i 3+4i]; 
>> dʹ 
ans = 

   1.0000           
   2.0000 + 2.0000i 
   3.0000 ‐ 4.0000i 

8) Massivi qüvvətə yüksəltmək. Bu əməliyyat «^» operatoru 
vasitəsilə yerinə yetirilir və aşağıdakı xassələr ödənilir: 

 qpqp AAA  ,    pqqp AA        

84    
Fəsil 2  Matlab 7   

 

Məsələn, 
>> A=[2 3  4;4 5 6 ;3 2 1]; 
>> A^3*A^4 
ans = 

     2557622     2791961     3026300 
     4311804     4706831     5101858 
     1827833     1995214     2162595 

>> A^(3+4) 
ans = 

     2557622     2791961     3026300 
     4311804     4706831     5101858 
     1827833     1995214     2162595 

>> (A^2)^3 
ans = 

      257948      281557      305166 
      434846      474665      514484 
      184297      201213      218129 

>> A^(2*3) 
ans = 

      257948      281557      305166 
      434846      474665      514484 
      184297      201213      218129 

10) Massivlərin sağ və sol nisbətini tapmaq olar. Bu əməliyyat 
müvafiq olaraq «\» və «/» operatorları vasitəsilə yerinə 
yetirilir.  

11)Verilmiş matrisləri şaquli və üfüqi istiqamətdə birləşdirmək 
olar. A, B matrislərini üfüqi istiqamətdə birləşdirmək üçün 
[A B], şaquli istiqamətdə birləşdirmək üçün isə [A: B] 
əmrini yerinə yetirmək lazımdır. Məsələn,  
>> A=[2 4; 4 5]; 
 >>B=[3 4; 5 6]; 
 >>C=[A B] 
  C= 
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 2     4     3     4 
 4     5     5     6 

>> C=[A;B] 
 C = 

  2     4 
  4     5 
  3     4 
  5     6 

Həmçinin vektorlara ədədi çoxluq kimi baxmaqla, ədədi 
çoxluqların birləşməsini, kəsişməsini və fərqini təyin etmək 
olar. Bunun üçün müvafiq olaraq, union(x,y),  intersect(x,y), 
setdiff(x,y) funksiyaları nəzərdə tutulmuşdur. Məsələn, 

>> x=[2 3 4]; y=[4 56 7]; 
>> union(x,y) 
ans = 
            2     3     4     7    56 
>> intersect(x,y) 
ans = 
            4 
>> setdiff(x,y)  
ans = 
           2     3  

Massivlər üzərində hesablama əməliyyatı aparmaq üçün 
həmçinin, aşağıdakı funksiyalardan da istifadə olunur: 
 length(A) funksiyası A vektorunun uzunluğunu təyin edir. 
Məsələn,  

>> a=[2 4 5 6 7]; length(a) 
ans = 
           5 

 diag(A) funksiyası elementləri A matrisinin diaqonal 
elementlərindən təşkil edilmiş vektoru təyin edir. Məsələn,  

>> B=[1 2 3; 
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     13 14 15; 
     15 16 17]; 

>> diag(B) 
ans = 

     1 
    14 
    17 

 fliplr  (A) funksiyası matrisin soldan sağa sütunlarının yerini 
dəyişir. Məsələn,  

>>B=[1 2 3; 
    13 14 15; 
    15 16 17]; 

>>fliplr(B) 
ans = 

     3     2     1 
    15    14    13 
    17    16    15 

 flipud  (A) funksiyası matrisin yuxarıdan aşağıya sətirlərin 
yerini dəyişir; Məsələn, 

>> B=[1 2 3; 
    13 14 15; 
    15 16 17]; 

>> flipud(B) 
ans = 
    15    16    17 
    13    14    15 
     1     2     3 

 repmat  (A, m,  n) funksiyası eyni matrisdən təşkil edilmiş 
çoxbloklu matrisi yaradır1; Məsələn, 

                                                 
1 m və m müvafiq olaraq şaquli və üfüqi istiqamətlərdə blokların sayını 
bildirir. 
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>> B=[1 2 3; 
      13 14 15; 
      15 16 17]; 

> repmat(B,2,1) 
ans = 

      1      2      3 
    13    14    15 
    15    16    17 
      1      2      3 
    13    14    15 
    15    16    17 

 reshape(A, m1, n1) funksiyası m n tərtibli matrisin tərtibini  
m1 n1 -ə dəyişir. Bu zaman matrisin forması dəyişir. Aydın 
məsələdir ki, m n m1 n1    olmalıdır. Məsələn,  

>> B=[1 2 3; 
      13 14 15; 
      15 16 17]; 

>> C=repmat(B,2,1) 
C = 

     1     2     3 
    13    14    15 
    15    16    17 
     1     2     3 
    13    14    15 
    15    16    17 

>> reshape(C,2,9) 
ans = 

  1   15   13   2   16   14   3   17    15 
 13    1   15  14    2  16   15    3    17 

 rot90 (A, k) funksiyası matrisi saat əqrəbi istiqamətində 90k 
dərəcədə fırladır. Məsələn, 

>> c=[2 3 4 5; 3 4 5 6] 
c = 

 2     3     4     5 
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     3     4     5     6 
>> rot90(C,3) 
ans = 

     3     2 
     4     3 
     5     4 
     6     5 

 tril (A), triu (A)  funksiyaları müvafiq olaraq aşağı və yuxarı  
üçbucaq matrisi yaradır. Məsələn, 

>> D=[1 2 3 4; 2 3 4 5;6 7 8 9;3 4 5 6]; tril(D) 
ans = 
     1     0     0     0 
     2     3     0     0 
     6     7     8     0 
     3     4     5     6 
>> triu(D) 
ans = 

     1     2     3     4 
     0     3     4     5 
     0     0     8     9 
     0     0     0     6 

 sum(A),  prod(A)  funksiyaları müvafiq olaraq, vektorun 
elementlərinin cəmini və hasilini, matrisin isə sütun vektorunun 
elementlərinin cəmini və hasilini  hesablayır.  Məsələn, 

>> A=[2 3 4;4 5 6]; sum(A) 
ans = 

     6     8    10 
>> prod(A) 
ans = 

     8    15    24 
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 sort(A) funksiyası vektorun elementlərini , matrisin isə sütun 
vektoru  elementlərini artma ardıcıllığına görə nizamlayır. 
Məsələn, 

>> A=[‐2 3 4;4 ‐5 6]; 
>> sort(A) 
ans = 

    ‐2    ‐5     4 
     4     3     6 

 det(A) funksiyası  matrisin determinantını hesablayır. 
Məsələn, 

>> D=[1 2 3;2 4 5;3 5 6];det(D) 
ans = 

    ‐1 

 rank(A) funksiyası matrisin ranqını hesablayır. Məsələn, 

>> D=[1 2 3;2 4 5;3 5 6]; rank(D) 
ans = 

     3 

 inv (A) funksiyası kvadrat matrisin tərs matrisini hesablayır. 
Məsələn, 

>> D=[1 2 3;2 4 5;3 5 6]; inv(D) 
ans = 
    1.0000   ‐3.0000    2.0000 

                     ‐3.0000    3.0000   ‐1.0000 
                       2.0000   ‐1.0000         0 

 norm  (A,k) funksiyası matrisin normasını hesablayır. k=inf 
yazılışı normanı iji j

A max a   düstüru ilə, k=-inf yazılışı 

normanı ijj i
A max a   düstüru ilə, k=2 yazılışı isə  normanı 
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norma
2

ij
i, j

A a   düstüru ilə  hesablanmasını təmin edir. 

Məsələn, 
>> A=[2  3  4  5;   4  5  6   7; 6   7  8   9; 3   4  5   6]; 

 
   

      
>> norm(A,2) 
ans = 

   22.2393 
>> norm(A,inf) 
ans = 

      30 
>> norm(A,‐inf) 
ans = 
         30 

 trace(A) funksiyası  matrisin izini hesablayır. Məsələn,  

>>>> A=[2  3  4  5;   4  5  6   7; 6   7  8   9; 3   4  5   6]; trace(A) 
  ans = 

        21 
 cross(X,Y) funksiyası üç elementli X və Y vektorlarının 

hasilini hesablayır. Məsələn, 
>> X=[1 2 3]; Y=[2 3 4]; cross(X,Y) 
ans = 
         ‐1     2    ‐1 

 
 

2.2 QRAFİKLƏR VƏ DİAQRAMLARIN QURULMASI 

Ədədi informasiyaların vizuallığını təmin etmək üçün 
Matlab-da qrafik və diaqramların qurulması imkanı nəzərdə 
tutulmuşdur. Qrafiklər adətən iki və artıq ədədi çoxluqlar 
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arasında birqiymətli funksional asılılığı əks etdirir.  Matlab-da 
iki ölçülü qrafiklərin qurulması onluq və loqorifmik şkalada 
Dekart və polyar koordinat sistemlərində yerinə yetirilə bilər. 
Onluq şkalada qrafikin qurulması üçün əmr sahəsində Plot(x, 
y) əmrini yerinə yetirmək lazımdır. Burada   x,  y əvvəlcədən 
təyin edilmiş eyni ölçülü ixtiyari vektorlardır. Əmri yerinə 
yetirdikdə açılmış qrafik Figure<n>1 adlı qrafik pəncərəsində 
əks olunur. Qrafikin pəncərədə optimal görünüşünə nail olmaq 
üçün proqram avtomatik olaraq miqyas müəyyən edir. Polyar 
koordinat sistemində qrafiklərin qurulması üçün polar(f,r) 
əmrini yerinə yetirmək lazımdır (şək.2.2-1).  
>> f=0:0.01:2*pi; r=sin(2.*f).*cos(2.*f); h=polar(f,r) 

 

şək.2.2-1 
Bir koordinat müstəvisində bir neçə qrafikin əks olunması üçün 
plot(x1,g,x2,f,…,xn,y)əmri yerinə yetirilir. Məsələn, 

                                                 
1  n-açılmış qrafik pəncərənin nömrəsini bildirir. 
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    


( ) sin( 1), ( ) exp( 0.2 ) ,
1

xf x x g x x х
x

Є[0, 5] 

 funksiyalarının qrafikinin qurulması üçün əmr sahəsində 
aşağıdakı əmrlər daxil edilməlidir (şək.2.2-2).  

>>x=[0:0.1:5]; g=exp(‐0.2*x)‐x/(x+1);f=sin(x+1); 
>>plot(x,f,x,g) 

 

şək.2.2-2 

Qeyd edək ki, bir koordinat müstəvisində bir neçə qrafikin 
qurulması həmçinin növbəti qrafikin qurulmasından əvvəl əmr 
sahəsinə daxil edilən hold on əmri vasitəsi ilə  yerinə yetirilə 
bilər. Məsələn, yuxarıda qeyd olunan funksiyaların 
qrafiklərinin qurulması aşağıdakı əmrləri yerinə yetirməklə də 
mümkündür.  

>>x=[0:0.1:5];g=exp(‐0.2*x)‐x/(x+1); f=sin(x+1);plot(x,g) 
>> hold on 
>> plot(x,f) 
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Bir koordinat müstəvisində iki funksiyanın qrafikinin 
qurulması zamanı,  hər hansı funksiyanın qiymətlər oblastı 
digər funksiyanın qiymətlər oblastından bir neçə tərtib 
fərqləndikdə, plot(x1,g,x2,y)  əmrini yerinə yetirdikdə, qiymətlər 
oblastı kiçik olan funksiyanın qrafiki “görünməz”  olur. Bu 
halda plotyy  (x1,g,x2,f) əmrini yerinə yetirmək lazımdır. 
Nəticədə qrafiklər funksiyaların qiymətlər oblastına müvafiq 
miqyasda ordinat oxlarına malik koordinat müstəvisində əks 
olunacaqdır və qrafiklərin rəngi ordinat oxunun rənginə 
müvafiq olacaqdır. İki ölçülü qrafikin loqarifmik şkalada 
qurulması üçün loglog  (x, y),  semilogx  (x, y),  semilogy  (x,  y) 
əmrlərindən isitfadə olunur. Müvafiq olaraq bu əmrlər qrafikin, 
absis və ordinat  oxları, yalnız absis və yalnız ordinat oxu 
loqarifmik şkalaya malik koordinat müstəvilərində əks 
olunmasını təmin edir. Eyni qayda ilə, loqarifmik şkalalı  
koordinat müstəvisində bir neçə qrafik əks oluna bilər. 

İstifadəçi qrafikin tərtibatını öz təlabatına uyğun 
tənzimləyə bilər. Məsələn, istifadəçi qrafikin rəngini, əyrinin 
tipini, əyri üzərində markerlərin tipini seçə bilər. Bunun üçün 
Plot(x,y,<parametrlər>), loglog (x,y,<parametrlər>), semilogx 
(x,y <parametrlər >), semilogy (x, y, <parametrlər>) əmrlərini 
yerinə yetirməlidir. Parametrlər apastrof daxilində yazılır, bir-
birindən vergüllə ayrılır və müvafiq olaraq  qrafik əyrisinin 
rəngini, markerin tipini və əyrinin stilini bildirir. Parametrlərin 
aldığı qiymətlər  aşağıdakı cədvəldə əks olunmuşdur.  

Cədvəl 2.2-1 

Rəng Markerin tipii Xəttin tipii
y Sarı · nöqtə — Bütöv xətt
m Çəhrayı ○ kiçik radiuslu çevrə : punktir xətt
c Mavi X  -. nöqtəli qırıq 
r Qırmızı +  - - ştrix xətt
g Yaşıl * * 
b Göy S  
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Rəng Markerin tipii Xəttin tipii 
w Ağ D  
k Qara V  
 ^  
 >  
 < 

 P  
 H  

 Məsələn, 

>> x=[0:0.1:5]; g=sin(x+1);f=cos(x+1); plot (x,f,ʹr:ʹ, x,g,ʹkdʹ) 

 yazılışı müxtəlif stilli əyrilərin qrafik pəncərəsində əks 
olunmasını təmin edəcək (şək.2.2-3). 

 
şək.2.2-3 



Riyazi proqram paketləri 

 

95

Üçölçülü qrafiklər ikidəyişənli funksiyalar əsasında 
qurulur. Bunun üçün ilk növbədə funksiyanın təyin oblastı 
meshgrid funksiyası vasitəsi ilə şəbəkəyə bölünür və şəbəkənin 
düyün nöqtələrində funksiyanın qiymətləri hesablanır. Daha 
sonra mesh  (x,  y,  z) və ya surf  (x,  y,  z) əmrləri vasitəsi ilə 
funksiyanın qrafiki qurulur. mesh  (x,  y,  z) funksiyası 
«karkasşəkilli» qrafik qurur. surf (x, y, z) funksiyası isə hər bir 
xanası rənglənmiş «karkasşəkilli» qrafiki qurur. Rəng çaları x, 
y, z, vektorlarının qiymətlərinə uyğun olur. Rəng palitrasının 
ədədi qiymətlərdən asılılığını qrafiklə birlikdə əks olunması 
üçün əlavə olaraq colorbar  əmrini yerinə yetirmək lazımdır 
(şək.2.2-4). Məsələn,  

>> [X,Y]=meshgrid(0:0.1:1,‐2:0.1:1); 
>> Z=4*sin(X).*cos(Y); 
>> surf(X,Y,Z) 
>> colorbar 

 
şək.2.2-4 
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Rəngli, üçölçülü səth fiquru əldə etmək üçün isə yuxarıdakı 
yazılışa Shading  interp əmrini əlavə etmək lazımdır.  Bu əmr 
«karkas» xətlərini görünməz edir. Təkrar karkas xətlərini əks 
etdirmək tələb olunduqda Shading  faceted əmrini yerinə 
yetirmək kifayətdir. Hidden  off və  hidden  on  əmrləri isə 
əyrinin «görünməz» hissələrinin ekranda əks olunmasını 
tənzimləyirlər. 

Praktikada kontur qrafiklərindən geniş istifadə olunur. 
Kontur qrafik qurmaq üçün Contour(X,Y,Z,n) əmrini yerinə 
yetirmək lazımdır. Burada n-səviyyə xəttlərinin sayını bildirir. 
Əgər n istifadəçi tərəfindən müəyyən olunmayıbsa, sistem 
avtomatik olaraq n=10 qəbul edir (şək.2.2-5). Məsələn, 

>> [X,Y]=meshgrid(0:0.1:1,‐2:0.1:1); 
>> Z=4*sin(X).*cos(Y); 
>> Contour(X,Y,Z) 
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şək.2.2-5 

Əgər istifadəçini funksiyanın səviyyə xətlərində aldığı 
qiymətlər də maraqlandırırsa, onda əlavə olaraq clabel 
əmrindən istifadə edilməlidir (şək.2.3-6). Məsələn, 
>> [X,Y]=meshgrid(0:0.1:1,‐2:0.1:1); 
>> Z=4*sin(X).*cos(Y); 
>> clabel(CMatr,h)  
>> [CMatr,h]=contour(X,Y,Z) 

 

 
şək.2.2-6 

Qrafikin tərtibatı üçün aşağıdakı elementlər: xlabel (,<mətn>,), 
ylabel (,<mətn>,) funksiyaları vasitəsilə koordinat oxlarının adı, 
title (,<mətn>,) funksiyası vasitəsilə qrafikin sərlövhəsini, 
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legend  (,<mətn>,) funksiyası vasitəsilə əyrilər haqqında şərh 
daxil edilir (şək.2.2-7). Məsələn, 

>> [X,Y]=meshgrid(0:0.1:1,‐2:0.1:1); 
>> Z=2*sin(X)‐cos(Y); 
>> surf(X,Y,Z) 
>> Title(ʹ     Q R A F I K          ʹ) 
>> ylabel(ʹYʹ);xlabel(ʹXʹ);zlabel(ʹZʹ); 
>> shading interp 

  
şək.2.2-7 

Koordinat müstəvisində şəbəkənin əks olunması üçün grid on 
əmrindən istifadə edilməlidir. Hər bir qrafikin ayrı qrafik 
pəncərəsində əks olunması üçün figure əmri vasitəsilə yeni 
qrafik pəncərəsi açılmalıdır. Bir qrafik pəncərəsində bir neçə 
qrafikin əks olunması üçün isə subplot  (i,j,n) əmrini yerinə 
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yetirmək lazımdır. Burada i,j – üfüqi və horizontal istiqamətdə 
qrafiklərin sayı, n isə cari qrafikin nömrəsini bildirir (şək.2.2-
8).  Məsələn, 

>> [X,Y]=meshgrid(0:0.1:1,‐2:0.1:1); 
>> Z=‐1*sin(X)+cos(Y);subplot(3,2,2); 
>> surf(X,Y,Z) 
>> subplot(3,2,1);mesh(X,Y,Z) 

 
şək.2.2-8 

Matlab vektor və matris vasitəsilə verilmiş ədədi 
informasiyalar əsasında diaqramların qurulmasını da təmin 
edir. Bunun üçün Bar(X,k),  Bar3(X,k),  pie(X),  pie3(X), 
pie(X,y),  pie3(X,y)  əmrləri nəzərdə tutulmuşdur. Belə ki, 
Bar(X,k),  Bar3(X,k)  funksiyaları X ədədi massivi əsasında 
sütunvari iki və üçölçülü diaqram qurulmasını təmin edir. k 
parametri ilə  sütunların eni təyin edilir. Əgər k parametri 
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verilməyibsə, paket avtomatik k=0.8 qəbul edir (şək.2.2-9, 2.2-
10).  pie(X),  pie3(X),  pie(X,y),  pie3(X,y) funksiyaları isə 
müvafiq olaraq, Y vektoru əsasında iki və üçölçülü dairəvi 
diaqram və ayrılmış sektorlu diaqram qurulmasını təmin edir 
(şək.2.2-11, 2.2.-12). Burada b vektoru  ayrılmış sektoru təyin 
edir. b vektoru  0 və 1 elementlərindən təşkil olunmuşdur və 
length(Y)=length(b).  1 elementinin  indeksi  ayrılacaq 
sektorun  dairədəki mövqeyini xarakterizə edir. Məsələn, 

>> X=[1 2 3 4;1 2 4 5;2 3 4 8;7 8 9 1]; 
>> Y=[12 34 56 67]; 
>> Bar(X,0.85) 

 
şək.2.2-9 

>> X=[1 2 3 4;1 2 4 5;2 3 4 8;7 8 9 1]; 
>> Bar3(X,0.85) 
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şək.2.2-10 

>> Y=[12 34 56 67]; 
>> pie3(Y) 

 
şək.2.2-11 

>> X=[1 2 3 4;1 2 4 5;2 3 4 8;7 8 9 1]; b=[0 1 0 0]; pie(Y,b) 
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şək.2.2-12  

 
 

2.3 QRAFİKLƏRİN REDAKTƏ OLUNMASI 
   

Matlab obyekt yönümlü sistem olduğundan bütün 
qrafiki elementlər: qrafiki pəncərə, koordinat oxları, əyrilər, 
səthlər, mətn sahəsi müstəqil obyektlər hesab olunur və bu 
obyektlərin xassələri xüsusi funksiyalar vasitəsilə istifadəçi 
tərəfindən idarə oluna bilər. Belə ki, bu məqsədlə nəzərdə 
tutulmuş Set(<obyekt>) funksiyası cari qrafiki obyektin xassəsi 
üçün yeni qiymət müəyyən edilməsini, get (<obyekt>) əmri isə 
obyektin xassəsi haqda məlumat əldə etməyi təmin edir. Bu 
funksiyaların arqumentləri üçün aşağıdakı standart 
funksiyalardan istifadə olunur: 

 gcf – cari qrafiki pəncərə; 
 gca – cari koordinat oxu; 
 gco – cari qrafiki obyekt. 

  Qeyd edək ki, bu obyektlər üçün xassələr aşağıdakı 
cədvəldə əks olunmuşdur. 
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Cədvəl 2.3-1 

Xassənin 
adı Aldığı qiymətlər Mənası 

Koordinat oxları üçün 
Box On, off Çərçivə 
Color R, G, B Rəng 
Font Angle Normal, italic Şriftin stili 
FontName Məs.Arial Şriftin adı 
FontSize 8,10,…,72 Şriftin ölçüsü 
FontWeight Normal, bold, light, 

demi 
Şriftin qalınlığı 

Gridline Style  -, --, :, -, none Şəbəkə xətlərinin 
tipi 

Visible On və ya off Oxların 
görünməz olması 

Line Width Tam ədəd Oxların qalınlığı 
XColor, YColor R, G, B Rəng 
XDir, YDir Normal, reverse  Oxun istiqaməti 
X Axislocation Top, botom 
Y Axislocation Right, left 

Oxların 
yerləşməsi 

Xlim, Ylim [a, b] Aldığı qiymətlər 
intervalı 

XScale, YScale Linear, log Şkala 
XTick, YTick Vektor Bölünmə 

markerlərinin 
koordinatları 

Ticklabel Zero, one, three, 
Vive 

Bölünmə 
markerlərinin adı 

Əyri  üçün 
Color  R, G, B Rəngi 
Line Style -, --, :, -, none Xəttin növü 
Line Width Tam ədəd Xəttin qalınlığı 
Marker o, s,…. (bax cədvəl Markerin tipi 
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Xassənin 
adı Aldığı qiymətlər Mənası 

2.2-1) 
Marker Edge Color R, G, B Markerin 

sərhəddinin rəngi 
Marker Face Color R, G, B Markerin rəngi 
Marker Size Tam ədəd (punkt) Markerin ölçüsü 

 Obyektə yeni xassə mənimsətmək üçün Set (<obyektin adı> və 
ya <obyekt göstəricisi>, <xassə>, <qiymət>) yazılışından 
istifadə edirlər. Məsələn, >>  set(gsa,ʹXGridʹ,ʹonʹ) yazılışı absis 
oxu boyu şəbəkənin əks olunmasını təmin edir. Obyekt 
göstəricisi olaraq figure,  axes,  plot,  mesh,  surf sözlərindən 
istifadə olunur. İstifadəçi özü obyekt göstəricisi yaradıb, 
xassələri dəyişməklə də qrafiki redaktə edə bilər. Məsələn,  

>>t = [0:0.1:7]; 
>>x = sin(t); 
>>y = cos(t); 
>>HFig = figure; 
>>HAx = axes; 
>>HLines = plot(t,x,t,y); 
>>set(HAx,ʹXGridʹ,ʹonʹ) 
>>set(HLines(1), ʹColorʹ, ʹkʹ) 
>>set(HLines(1), ʹLineWidthʹ, 3) 
>>set(HLines(2), ʹColorʹ, ʹkʹ) 
>>set(HLines(2), ʹMarkerʹ, ʹoʹ) 
>>set(HLines(2), ʹMarkerFaceColorʹ, ʹwʹ) 
>>set(HLines(2), ʹMarkerEdgeColorʹ, ʹkʹ) 



Riyazi proqram paketləri 

 

105

 
şək.2.3-1 

Obyektin xassəsi üçün yeni qiymətlər mənimsətməklə yanaşı 
qrafikə yeni obyektlər: koordinat oxu, əyri, səth əlavə etmək və 
ləğv etmək olar. Bunun üçün hold  on  və delete  (<obyekt 
göstəricisi>) əmrlərindən istifadə olunur.  Məsələn, aşağıdakı 
yazılış qrafik pəncərəsinə yeni əyri əlavə edir. 

>>z = log(t+1);axes(HAx);hold on 
>>HLog = plot(t,z);set(HLog, ʹColorʹ, ʹkʹ); 
>>set(HLog, ʹLineStyleʹ, ʹ‐‐ʹ);set(HLog, ʹLineWidthʹ, 3); 
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şək.2.3-2 

Obyektin xassəsini həmçinin obyekt göstəricisinin arqumenti 
kimi də vermək olar.  Məsələn, axes  (ʹx Gridʹ,  ʹonʹ). Bundan 
əlavə, qrafiki pəncərənin və koordinat oxlarının yerləşməsini 
də idarə etmək olar. Bunun üçün pəncərənin və koordinat 
oxlarının Position xassəsinin yeni qiymətlərini müəyyən etmək 
lazımdır. Bu zaman ekranın vizual imkanları nəzərə 
alınmalıdır. Məsələn, 

>>SCRsize = get(0, ʹScreenSizeʹ) 
>>left = SCRsize(1); 
>>bottom = SCRsize(2);width = SCRsize(3); 
>>height = SCRsize(4)‐19; 
>>figure(ʹPositionʹ, [left bottom width height], ʹMenuʹ, ʹnoneʹ)1. 

                                                 
1Bu yazılış ekranda menyusuz qrafiki pəncərə yaradır.    
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Qrafiklərin sərlövhəsini, koordinat oxlarının adlarını yazmaq 
üçün Text mətn obyektindən istifadə olunur. Mətn obyekti öz 
növbəsində  aşağıdakı xassələrə malikdir: 

Cədvəl 2.3-2 

Xassə Qiymət Mənası 
Color R,G,B və onların kombinasiyası Şrift üçün rəng 

Font Angle Normal, italic Şriftin mailliliyi 

Font Name Courier, arial və s. Şriftin Adı 

Font Size  8,10,…,72 Şriftin ölçüsü 

Font Width Normal, bold, light, demi Şriftin qalınlığı 

İnterpreter Tex, none TEX formatının 
müəyyən edilib, 
edilməməsi 

Horizontal 
Alignment 

Left, center, right Mətnin üfüqi 
istiqamətdə 
nizamlanması 

Position 2 və ya 3 elementli vektor Mətnin mövqeyi 

Rotation Tam ədəd Mətn üçün 
dönmə bucağı 

String İxtiyari mətn Mətn 
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Xassə Qiymət Mənası 
Units Inches, centimeters, points, 

pixels, normalized, data 
Ölçü vahidi 

Vertical 
Aligment 

Top, cap, midde Şaquli 
istiqamətdə 
nizamlama 

Visible On, off Mətn sahəsinin 
ekranda əks 
olunması 

Məsələn, 
>> HTxt=title(ʹ  Q R  A  F  I  Kʹ) 
>>set(HTxt,ʹFontNameʹ,ʹArialʹ);HAx = axes;x = [‐2:0.01:3]; 
>>y = exp(‐x.^2);plot(x,y) 
>>Xtext = 1.17;Ytext = exp(‐Xtext.^2); 
>>HTxt = text(Xtext, Ytext, ʹ\leftarrow Funksiya {\ity} = 

{\ite}^{‐x^2}ʹ); 
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şək.2.3-3 

2.4 M-FAYLLARI 
 

Matlab-da çoxsaylı əmrlərin yerinə yetirilməsi üçün ən 
əlverişli vasitə M-fayllarından istifadə olunmasıdır. Bunun 
üçün istifadəçi File→New→M‐file əmrini yerinə yetirib, 
açılmış redaktor pəncərəsində əmrləri daxil edib, onu M-fayl 
kimi yaddaşda saxlamalıdır. Daha sonra Debug→Run əmrini 
yerinə yetirməlidir. Qeyd edək ki, istifadəçi M-faylını hissə-
hissə yerinə yetirə bilər. Bunun üçün o, M-faylında müəyyən 
sətirləri qeyd edib, Debug→Run əmrini yerinə yetirməlidir. M-
faylını redaktə etmək üçün File→Open əmrini yerinə yetirib və 
ya əmr sətirində >>edit<M-faylının adını> yazıb, Enter 
düyməsini sıxmaqla onu redaktor pəncərəsinə çağırmaq 
lazımdır.  
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  M-faylını əmr sətirindən yerinə yetirmək üçün cari 
kataloqu müəyyən etmək və əmr sətirində faylın adını yazıb 
Enter düyməsini sıxmaq lazımdır.1 Cari kataloqu müəyyən 
etmək üçün isə  alətlər panelində və ya Current Director 
pəncərəsində düyməsini sıxmaq və açılan Browse For 
Folder dialoq pəncərəsindən tələb olunan qovluğu seçmək 
lazımdır, həmçinin path ( '<ünvan>') əmrini yerinə yetirməklə 
cari kataloqu müəyyən etmək olar. 

   M-faylı iki: fayl-proqram (Script M-File) və fayl 
funksiya (Function M-File) şəklində olur. Fayl-proqram ardıcıl 
daxil edilmiş Matlab əmrlərindən və proqramlaşdırma 
operatorlarından ibarət olur.  Fayl funksiya formal arqumentlər 
əsasında hesablamalar apararaq nəticəni çıxış arqumentlərində 
saxlayır. O, aşağıdakı ümumi yazılış qaydasına malikdir: 
Function <çıxış arqumenti>=<funksiyanın adı (<formal arqument>)> 

<çıxış arqumenti>=<riyazi ifadə> 

 Məsələn, 
Function r = radius3(x, y, z) 
r = sqrt(x.^2 + y.^2 + z.^2); 

Fayl funksiyasını yerinə yetirmək üçün onun adına 
müraciət etmək lazımdır. Bu zaman formal arqument faktiki 
parametrlərlə əvəz olunur. Məsələn, 

 >>r= radius3(1, 1, 1) 
             r= 
                  1.732 
   
 
2.5 MATLABDA PROQRAMLAŞDIRMA VASİTƏLƏRİ 

                                                 
1 Bu zaman proqram cari kataloqda faylın axtarışını həyata keçirir və yalnız 
tapdıqda onu yerinə yetirir. Əks halda səhv haqqında ??Undefined function 
or variable '<faylın adı>'informasiyası əks olunur. 
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Matlab-da proqramlaşdırma vasitəsi kimi aşağıdakı 

operatorlardan istifadə edilir: 
1.Dövr operatoru. Dövr operatoru müəyyən 

əməliyyatların təkrar yerinə yetirilməsinə xidmət edir. İki növ 
dövr operatorundan istifadə olunur: For/End və  While/End.  
For/End operatorundan təkrarlamanın sayı məlum olduqda 
istifadə olunur və o, aşağıdakı ümumi yazılışa malikdir: 

  For  i  =  m1 : m 2 : m 3    
  Matlab-ın əmrlər ardıcıllığı   
  End 

Bu yazılışda i dövr parametri olub, 2m  addımla 1m  -dən m 3 –ə 
qədər qiymətlər alır.  Məsələn,  

figure 
x = [0:pi/30:2*pi]; 
for a = ‐0.1:0.02:0.1 
   y = exp(‐a*x)‐sin(x); 
   hold on 
   plot(x, y) 
end 
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şək.2.5-1 

 While/End operatorundan isə təkrarlamanın sayı məlum 
olmadıqda istifadə olunur. O, aşağıdakı yazılışa malikdir: 

   While  şərt   
        əmrlər   

      End 

 Bu operator yerinə yetirildikdə əvvəlcə şərt yoxlanılır. Əgər 
şərt doğrudursa, dövr daxilində yazılmış operatorlar yerinə 
yetirilir, əks halda isə dövr operatorundan sonra yazılmış 
operator yerinə yetirilir. Məsələn, sin(x) funksiyasını sıraya 
ayırmaqla qiymətlərini hesablayaq: 

function s = mysin(x) 
s = 0; 
k = 0; 
while abs(x.^(2*k+1)/factorial(2*k+1))> 1.0e‐5 
   s = s + (‐1)^k*x.^(2*k+1)/factorial(2*k+1); 
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   k = k + 1; 
end 
>> >> mysin(3) 
ans = 
        3.1416 

 Qeyd edək ki, dövrdən vaxtından əvvəl çıxmaq üçün break 
operatorundan istifadə olunur. 
  2.Keçid operatoru. Keçid operatoru yalnız müəyyən 
şərt ödənildikdə müəyyən əməliyyatların yerinə yetirilməsinə 
xidmət edir. Ümumi halda operator aşağıdakı kimi yazılır: 

if  şərt 1   
 əmrlər   
else if  şərt 2   

 əmrlər   
else 

 əmrlər   
End. 

 Şərt olaraq istənilən məntiqi ifadə işlənə bilər.  Operator 
yerinə yetirildikdə ilk öncə şərt 1  yoxlanılır, əgər bu şərt 
ödənilməyibsə, digər şərt yoxlanılır. Bu şərt də ödənilmədikdə 
isə else identifikatorundan sonrakı əmrlər yerinə yetirilir. Qeyd 
edək ki, şərtin sayı bir olduqda operatorun qısa yazılışından 
istifadə olunur: 

 if  şərt   
   əmrlər   
End 
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 Məsələn,  y(x)=


















xx
xx

xx

,cos
,/
,sin

 funksisyasını hesablamaq 

üçün şərti keçid operatrundan istifadə etmək olar. 
Function y=pwun(x) 

if x  <‐pi   
y=sin(x) 
else if (x <pi) and x >‐pi 
y=x/pi 
else 
y=cos(x) 
End 
>> x=[‐3:0.01:10]; 
y=pwfun(x); 
>> plot(x,y) 

 
şək.2.5-2 
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 4.Variant operatoru. Variant operatoru dəyişənin 
qiymətindən asılı olaraq müəyyən əməliyyatı yerinə yetirir. 
Operatorun  yazılış forması ümumi olaraq aşağıdakı kimidir: 

  Switch  dəyişən   
 Case  qiymət1   

     əmr   
 Case  qiymət2   
 other wise 

     əmr   
 End 

 Hesablamanın nəticəsini fayla yazmaq və verilənlərin 
başlanğıc qiymətlərini fayldan «oxumaq» olar. Bunun üçün ilk 
öncə mövcud faylı çağırmaq və ya yeni fayl yaratmaq lazımdır. 
Bunun üçün fopen (  faylın adı  ,  parametr  ) operatorundan 
istifadə olunur. Parametr faylın atributunu bildirir və aşağıdakı 
qiymətlərdən birini alır: 

rt-açılan fayl yalnız oxumaq üçündür; 
rt+-açılan fayl oxumaq və yazmaq üçündür; 
wt-yeni yaradılan fayl yalnız yazmaq üçündür; 
wt+-yeni yaradılan fayl həm oxumaq, həm də yazmaq 
üçündür. 

 Fayldan informasiya oxunması fscanf operatoru 
vasitəsilə yerinə yetirilir. Fayl  fclose əmri ilə bağlanır. 
İnformasiya fayla fprintf (  faylın adı  ,  informasiya  ) 
operatoru ilə yazılır. 

 
2.6 M –FAYLLARININ KOMPİLYASİYA EDİLMƏSİ 

 
M-faylının sürətlə yerinə yetirilməsini təmin etmək 

üçün onu kompilyasiya etmək məsləhətdir. Bu zaman fayl 
funksiyası  C dilində yazılmış koda çevrilir və MEX-faylı 
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adlanan “.dll”  genişlənməsinə malik dinamik modul yaranır. 
Bunun nəticəsində fayl funksiyasını C dilinin kampilyatoru 
vasitəsilə yerinə yetirmək olar. MEX-faylında M-faylından 
fərqli olaraq alqoritm istifadəçi üçün gizli qalır. Fayl 
funksiyasını yerinə yetirmək üçün ilk öncə mex – setup  əmrini  
yerinə yetirmək lazımdır. Bu zaman Command Window  -əmr 
pəncərəsində kompulyatorun seçilməisni təklif edən aşağıdakı 
məlumat əks olunur:   

Please  choose  your  compiler  for  building  external  interface 
(MEX) files:  
Would you like mex to locate installed compilers [y]/n? 

İstifadəçi klaviaturanın «y» düyməsini sıxdıqda mümkün 
kompilyatorların siyahası əks olunur: 

Select a compiler:  
[1]  Digital  Visual  Fortran  version  6.0  in  C:\Program 
Files\Microsoft Visual Studio  
[2] Lcc C version 2.4 in C:\MATLAB6P5\sys\lcc  
[3]  Microsoft  Visual  C/C++  version  6.0  in  C:\Program 
Files\Microsoft Visual Studio  
 [0] None  
 Compiler: 

 Əgər kompüterdə fortran və C dilinin  kompilyatorları 
yüklənməyibsə, onda Lcc  C  Version  2.4  in  c:\Matlab\sys\lcc  
variantına uyğun düyməni (bizim halda «2») sıxmaq lazımdır. 
Bundan sonra fayl funksiyasını kompilyasiya etmək olar. 
Məsələn, fərz edək ki, azad.m fayl funksiyasını kompilyasiya 
etmək lazımdır. Bunun üçün cari kataloq olaraq fayl 
funksiyasının saxlanıldığı qovluğu müəyyən edək və mcc–  x 
azad  əmrini yerinə yetirək. Kompilyasiya prosesi zamanı cari 
kataloqda azad.c, azad.h, azad_mex.c və azad.dll faylları 
yaranacaq. Qeyd edək ki, azad.dll mex faylını yerinə yetirmək 
üçün iistifadəçi əmr sətirindən >>  azad əmrini yerinə 



Riyazi proqram paketləri 

 

117

yetirməlidir. Qeyd edək ki, azad.c, azad.h, azad_mex.c faylları 
Matlab vasitəsilə MEX faylını yerinə yetirmək üçün zəruri 
deyil. Bu fayllar yalnız C kompilyatoru vasitəsilə fayl 
funksiyasının yerinə yetirilməsi üçün vacibdir və Matlab 
istifadəçiləri onu poza da bilər.  Əgər fayl funksiyası daxilində 
digər fayl funksiyaya müraciət olunursa, hesablama 
əməliyyatını sürətləndirmək məqsədilə bütün fayl funksiyaları 
kompilyasiya etmək məsləhətdir.  Bunun üçün əmr sahəsindən 
aşağıdakı əmri yerinə yetirmək lazımdır: 
 >> mcc – x <əsas fayl funksiyanın adı> <müraciət olunan 
funksiyanın adı> . 

Məsələn, aşağıdakı aq fayl funksiyası daxilindən digər aq1  
fayl funksiyasına müraciət edilmişdir: 

function d=aq(n) 
d=zeros(1,n); 
for i=1:n 
       A=aq1(i); 
    d(i)=det(A); 
end 
function M=aq1(k) 
M=zeros(k); 
for i=1:k 
    for j=1:k 
        M(i,j)=1/(i^2+j^2); 
    end 
end 

  mcc   –x aq   aq1  əmrindən  fərqli  olaraq,   mcc –x aq əmrini 
yerinə yetirdikdə məsələnin həlli üçün daha çox vaxt sərf 
olunacaq. İstifadəçi aşağıdakı əmrləri yerinə yetirməklə  vaxt 
fərqini görə bilər1: 

                                                 
1 Fayl- funksiyanın yerinə yetirilməsi üçün sərf olunan vaxt ıelapsed_time 
dəyişəninə mənimsədilir. 
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>> mcc ‐x aq 
>> tic,v=aq(100);toc 
elapsed_time = 

                  1.8830 
>> mcc ‐x aq aq1 
>> tic,v=aq(100);toc 
elapsed_time = 
                          0.8610 

 
 
 

2.7 MATLABDA ƏDƏDİ HESABLAMALAR 
 
  Matlab məsələlərin ədədi üsulla həlli üçün çox böyük 
alqoritmlər kitabxanasına malikdir. Kitabxananın konkret 
alqoritminə müvafiq funksiyalarla müraciət olunur. Bu vasitə 
ilə analizin, cəbrin diferensial və inteqral tənliklərinin variasiya 
hesabı, riyazi proqramlaşdırma, avtomatik və optimal 
idarəetmə  nəzəriyyələrinin çoxsaylı    məsələləri həll edilir. 

 Qeyri-xətti transtendent tənliklərin həlli üçün fzero 
(func, x0) funksiyasından istifadə etmək olar. Burada func – 
tənliyin sol hissəsinə üyğun fayl- funksiya və ya funksiya, x0 - 
isə axtarılan  kök üçün başlanğıc yaxınlaşmadır. Aydın 
məsələdir ki, tənliyin bir neçə kökü olduqda bu funksiyanı 
kökün sayı qədər təkrar tətbiq etmək lazımdır. Əsas məsələ 
tənliyin köklərinə uyğun başlanğıc yaxınlaşmaları düzgün 
müəyyən etməkdir1. Əgər qeyri-xətti tənliyin sol tərəfi 
çoxhədlidirsə, onda tənliyin bütün köklərini təyin etmək üçün  
roots (p) funksiyasından istifadə etmək məsləhətdir. Burada p- 
çoxhədlinin əmsallarından tərtib olunmuş vektordur. Məsələn, 
                                                 
1Adətən tənliyin köklərinə uyğun başlanğıc yaxınlaşmaları qrafiki üsulla 
təqribi  təyin edirlər.  
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fərz edək ki, x7+2x5-6x4-0,5x2-x+5=0  tənliyini həll etmək 
lazımdır. Bunun üçün əmr sətirinə aşağıdakı sətirləri daxil 
etmək və ENTER düyməsini sıxmaq lazımdır: 

>> p=[1 0 2 ‐6 0 ‐0.5 ‐1 5]; 
>> roots(p) 

Onda çoxhədlinin kökü olaraq alırıq: 
ans = 

 ‐7.5964e‐001 +1.8704e+000i 
 ‐7.5964e‐001 ‐1.8704e+000i 
  1.3535e+000               
  1.0580e+000               
  2.0952e‐003 +9.7770e‐001i 
  2.0952e‐003 ‐9.7770e‐001i 
 ‐8.9633e‐001               

Matlab-da həmçinin coxhədlinin qiymətini arqumentin ixtiyari 
nöqtəsində hesablamaq üçün  polyval(p,x),  çoxhədlinin 
törəməsini hesablamaq üçün plolyder  (p),  iki çoxhədlinin 
hasilinin tapılması üçün conv(p, q), qalıqla birlikdə qismətinin 
tapılması üçün deconv(p,  q), hasilin törəməsini hesablamaq 
üçün plolyder (p,q) funksiyaları nəzərdə tutulmuşdur, burada d 
– nisbət, r – qalıq çoxhədliləridir. Məsələn, 
           p=[1, 0, 1, 0, 0,1]; 

q=[1, 2, 3]; 
s=conv(p, q) 
s= 

1 2 4 2 3 1 2 3 
[d, r]=deconv(p, q); 
d= 
     1  ‐2  2  2 
r= 
      0  0   0  0  ‐10  ‐5 

   >>pd=polyder(p,q) 
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   pd= 
           7   12   20   8   9   2   2 

>>p1=polyder(p) 
   p1= 

        5   0   3   0   0 
Çoxhədlilərdən cədvəl vasitəsilə verilmiş birdəyişənli 

funksiyaların interpolyasiyası üçün də istifadə olunur. Bu 
məqsədlə polyfit  (x,  y,  n)1 funksiyası nəzərdə tutulmuşdur, 
burada x,y –vektorlar, n0 olub, interpolyasiya çoxhədlisinin 
tərtibini bildirir. Funksiyaların interpolyasiyası üçün həmçinin 
interp1(x, y, n, options), interp2, interp3, inter n (x, y, n, 
options) funksiyalarından da istifadə etmək olar. Bu 
funksiyaları müvafiq olaraq bir, iki, üç və n ölçülü funksiyaları 
<options> parametri vasitəsilə təyin olunan  üsüllarla 
interpolyasiya edir. <options> parametri birdəyişənli 
funksiyalar üçün nearest2,linear3,‘spline4, ikidəyişənli 
funksiyalar üçün nearest, bilinear5,‘bicubic6  qiymətləri ala 
bilər. Aşağıda verilmiş  fayl funksiya cədəvl vasitəsi ilə 
verilmiş funksiyanın qeyd olunan  üsullar ilə  
interpolyasiyasını, funksiyanın qrafikini və müvafiq 
interpolyasiya əyrilərinin qurulmasını təmin edir. 

x = [0.1 0.2 0.4 0.5 0.6 0.8 1.2]; 

                                                 
1 polyfit (x, y, n)  funksiyası birdəyişənli funksiyanın kiçik kvadratlar üsulu 
ilə  interpolyasiya çoxhədlsini təyin edir. 
2 Parametr  qonşu düyün nöqtələrinə görə funksiyanın interpolyasiyasını 
təmin edir. 
3Parametr xətti interpolyasiya üsulu ilə  funksiyanın interpolyasiyasını 
təmin edir. 
4 Parametr kubik splayn üsulu ilə  funksiyanın interpolyasiyasını təmin edir. 
5 Parametr bixətti interpolyasiya üsulu ilə funksiyanın interpolyasiyasını 
təmin edir. 
6 Parametr bikubik splayn üsulu ilə  funksiyanın interpolyasiyasını təmin 
edir. 
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y = [‐3.5 ‐4.8 ‐2.1 0.2 0.9 2.3 3.7]; 
plot(x, y, ʹkoʹ) 
xi = [x(1):0.01:x(length(x))];ynear = interp1(x,y,xi,ʹnearestʹ); 
yline = interp1(x,y,xi,ʹlinearʹ);yspline = interp1(x,y,xi,ʹsplineʹ); 
hold on 
plot(xi, ynear, ʹkʹ, xi, yline, ʹk:ʹ, xi, yspline, ʹk‐.ʹ) 
title('Funksiyanın interpolyasiya tipləri') 
xlabel(ʹ\itxʹ) 
ylabel(ʹ\ityʹ) 
legend(ʹ(nearest)ʹ, ʹ (linear)ʹ,  (spline)ʹ,4) 

 
şək.2.7-1 

  Müəyyən inteqralın hesablanması üçün quad(ʹfunʹ, 
a,b,e,n)  və quad8(ʹfunʹ,  a,b,e,n)  funksiyalarından istifadə 
olunur. Burada a,b inteqralın sərhədlərini, e hesablamanın 
dəqiqliyini, n isə bölgü nöqtələrini sayını bildirir. Funksiyalar 
inteqralı müvafiq olapaq Simpson və Nyuton-Kotteks düsturu 
ilə hesablayır. Ümumiyyətlə, e və n parametrləri buraxıla bilər. 
Bu zaman paket  avtomatik olaraq 310e , 10n qəbul edir. 
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n parametri aşkar şəkildə verildikdə funksiyanın qrafiki qrafiki 
pəncərədə əks olunur. İkiqat inteqralın hesablanması üçün  
dblquad(func,  a,  b,  s,  d,  e,  n)  funksiyasından, parametrdən 
asılı inteqralın hesablanması üçün isə quad(func, a, b, p1, p2,… ) 
funksiyasından istifadə olunur, burada p1, p2…  prametrlədir. 
.  Matlab-da diferensial tənliklər üçün Koşi və sərhəd 
məsələsinin həlli üçün nəzərdə tutulmuş funksiyaları solver 
adlandırırlar. n tərtibli diferensial tənlik üçün Koşi məsələsini 
həll etmək üçün onu birtərtibli diferensial tənliklər sisteminə 
gətirmək, sistem tənliklərə uyğun fayl funksiyanı tərtib etmək, 
məsələyə uyğun solveri tətbiq etmək və tənliyin həllinin 
qrafikini qurmaq lazımdır. Koşi məsələsinin həlli üçün ode45, 
ode23,  ode113,  ode15S,  ode23t,  ode23tb, sərhəd məsələsinin həlli 
üçün isə bvp4C solverləri nəzərədə tutulmuşdur1. Məsələn  
         tyyy sin102 '''                                                 (2.7-1) 
        0)0(,1)0( '  yy                                                    (2.7-2) 
 Koşi məsələsini həll etmək üçün ilk öncə o, aşağıdakı 
məsələnin həllinə gətirilir: 

      





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

tsiny10y2y 

yy

12
'
2

2
'
1                                         (2.7-3) 

      
1)0(y
0)0(y

2

1




                                                                     (2.7-4) 

Sonradan (2.7-3)-(2.7-4) məsələsinin həlli üçün aşağıdakı M-
faylları hazırlanır: 

function F = oscil(t, y) 
F = [y(2);   ‐2*y(2)‐10*y(1)+sin(t)]; 

                                                 
1 Bu solverlər Runge-Kutta üsuluna əsaslanır. 
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Y0 = [1; 0];[T, Y] = ode45(ʹoscilʹ, [0 15], Y0);plot(T, Y(:,1), ʹrʹ) 
hold on 
plot(T, Y(:,2), ʹk‐‐ʹ) 
title(ʹ {\ity} \prime\prime+2{\ity} \prime+10{\ity}=sin{\itt}ʹ) 
xlabel(ʹ\ittʹ) 
ylabel(ʹ{\ity},  {\ity} \prime ʹ) 
legend(ʹkoordinatʹ, ʹsuretʹ, 4) 
grid on 
hold off 

M-faylını yerinə yetirdikdə məsələnin həll  qrafiki qrafiki 
pəncərədə əks olunacaq(şək.2.7-2) 

 
şək.2.7-2 

Bir sıra riyazi və elmi-texniki məsələlərin həlli funksiyanın 
müəyyən oblastda minimum, maksimum və müəyyən şərtləri 
ödəyən qiymətəlrin tapılması məsələsinə gətirilir. Matlab-da 
birdəyişənli funksiyaların verilmiş [a,b] parçasında 
minimumunun tapılması üçün fminbnd(ʹfunʹ,a,b), çoxdəyişənli 
funksiyaların minimumunun tapılması üçün  isə fminsearch 
(ʹfunʹ, a,b) funksiyaları  nəzərdə tutulmuşdur. Əgər minimum 
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nöqtəsində funksiyanın qiymətini də tapmaq tələb olunarsa, bu 
zaman müvafiq olaraq [x,f]=fminbnd(ʹfunʹ,  a,b)  və  [x,f]= 
fminsearch(ʹfunʹ, [a,b]) yazılış formalarından istifadə olunur. 
Burada funksiyanın minimum nöqtələrinin qiymətləri x  
dəyişəninə, minimum nöqtələrində funksiyanın qiymətləri isə f 
dəyişəninə mənimsədilir.  

 
 

2.8 PDE ToolBox 
  

İstilikkeçirmə, elektrostatika, elektrodinamika, maye 
axını, mexanika və fizikanın bir sıra məsələlərinin həlli xüsusi 
törəməli diferensial tənliklər üçün sərhəd və qarışıq məsələlərin 
həllinə gətirilir. Matlab 7-da bunun üçün xüsusi ToolBox-PDE 
ToolBox nəzərdə tutulmuşdur. PDE ToolBox istifadəçiyə sadə 
qrafiki işçi mühit təklif edir. İstifadəçi interfeys elementləri - 
alətlər paneli, menyunun əmrləri və açılan pəncərələr vasitəsilə 
həll oblastını, tənliyin tipini və əmsallarını, sərhəd və başlanğıc 
şərtlərini müəyyən edib oblastı sonlu elementlərə böldükdən-
trianqulyasiya əməliyyatı apardıqdan sonra məsələ həll olunur 
və məsələnin həlli vizual şəkildə PDE pəncərəsində əks olunur.  

İstilikkeçirmə tənliyi üçün qarışıq məsələnin misalında 
PDE ToolBox-un iş prinsipi ilə tanış olaq.  Bu məqsədlə dairəvi 
deşiyə malik oblastda 20 san müddətində istiliyin yayılması 
məsələsinə baxaq. Fərz edək ki, oblastın sərhədi istilik 
keçirmir. Deşiyin sərhədində istilik mənbəyi vardır və istilik 
zamana mütanasib artır. Başlanğıc zamanda oblastın bütün 
hissəsində temperatur sıfra bərabərdir.    

Məsələni həll etmək üçün ilk növbədə əmr sətirindən 
pdetool  əmrini yerinə yetirmək lazımdır1. Açılan PDE 

                                                 
1 PDE ToolBox-u interfeys pəncərəsinin LaunshPad bölməsininToolboxes 
siyahısından seçmək olar. 
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ToolBox pəncərəsinin koordinat müstəvisi üzərində,   aləti 
vasitəsilə düzbucaqlı oblast müyəyyən etdikdən sonra, kursoru 
çəkilmiş oblastın üzərinə qoyub siçanın sol düyməsini iki dəfə 
sıxmaq və açılan dialoq pəncərəsində oblastın ölçülərini, sol və 
yuxarı koordinatlarını müəyyən etmək lazımdır (şək.2.8-1). 
Daha sonra Draw→Ellipse/Cricle əmrini yerinə yetirməklə 
düzbucaqlı oblastın mərkəzində dairəvi oblast ayırmaq, kursoru 
ayrılmış oblastın üzərinə qoyub siçanın sol düyməsini iki dəfə 
sıxmaqla açılan dialoq pəncərəsində dairə mərkəzinin 
koordinatlarını və radiusunu müəyyən etmək və PDE ToolBox 
pəncərəsinin düstur sətirinə R1-C1 daxil etmək lazımdır 
(şək.2.8-1,2.8.2). 

 
şək.2.8-1 

 
şək.2.8-2 
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Növbəti addımda ardıcıl olaraq Options→ Applsation → Heat 
Transfer1 və PDE → PDE Mode2 əmrini, daha sonra PDE → 
PDE  Specification əmrini yerinə yetirmək, açılan dialoq 
pəncərəsində tənliyin tipini-Parabolic və tənliyin əmsallarını-
k 200 , C=1, rho=1,Q=0, h=0,Text=0 müəyyən edib OK 
düyməsini sıxmaq lazımdır(şək2.8-3). 

 
şək.2.8-3 

Ardıcıl olaraq oblastın sərhədlərində sərhəd şərtlərini təyin 
etmək lazımdır. Bunun üçün sərhəd xəttlərini qeyd etmək, 
Boundary→Specify  Boundary  Conditions əmrini yerinə 
yetirmək və açılan dialoq pəncərəsində sərhəd şərtlərini  
müəyyən etmək lazımdır. Bundan sonra başlanğıc şərti və 
zamanın dəyişmə intervalını vermək üçün Solve→Parameters 
əmrini yerinə yetirmək, açılan pəncərədə başlanğıc şərt, zaman 
intervalını və hesablamanın xətasını  müəyyən etmək lazımdır. 
Sonra Solve→Solve Mode əmrini yerinə yetirib, məsələni həll 
edirik və  məsələnin nəticəsi ekranda əks olunur (şək.2.8-4).  

                                                 
1 Əmr məsələnin tipinin-istilikkeçirmə məsələsi olduğunu müəyyən edir. 
2 Əmr differensial tənliyin tipini müəyyən edir 
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şək.2.8-4 

Temperaturun yayılma dinamikasını vizual olaraq 
izləmək üçün Plot→Plot Selection→Animation əmrini yerinə 
yetirib açılan Plot  Selection  dialoq pəncərəsində Animation 
variant sahəsini aktivləşdirmək və Options düyməsini sıxmaq 
lazımdır. Açılan növbəti Animation Options dialoq 
pəncərəsində animasiya kadrların və təkrarlamanın sayını 
müəyyən etmək lazımdır (şək. 2.8-5). 

 
şək.2.8-6 
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2.9  TOOLBOX   SYMBOLIC MATH 
 

ToolBox Symbolic Math Maple riyazi proqram paketinin 
kitabxanasından istifadə edərək simvolik hesablama əməliyyatı 
yerinə yetirir. Simvolik ifadələr iki üsulla yaradılır: 
1. İlk öncə >>syms <dəyişənin adı> əmrini yerinə yetirməklə 

dəyişənlər təsvir olunur. Sonra isə operatorlar  vasitəsilə 
ifadə tərtib edilir. Məsələn, 
  >>syms a, b 
   >> d=a^2+b/2 

2. İfadə Sym fyunksiyasının arqumenti olaraq apastrof 
daxilində yazılır. Məsələn,  
>>Sym (‘a^2+b/2‘). 

Simvolik ifadənin «təbii» yazılışının ekranda əks olunması 
üçün pretty(<simvolik ifadə>) funksiyası nəzərdə tutulmuşdur.  
Məsələn, pretty (d) əmrini yerinə yetirdikdə ekranda aşağıdakı 
yazılış əks olunacaq: 

                                      a2 + 1/4 b3  

  Kompleks simvolik dəyişənləri təsvir etmək üçün    syms 
<dəyişənin adı> unreal  əmrindən istifadə olunur. Simvolik 
massivləri təyin etmək üçün isə ilk növbədə onun elementlərini  
syms <elementlər>  əmri vasitəsilə təsvir etmək lazımdır. 
Sonra elementlər massivin adına kvadrat mötərizə arasında, 
bir-birindən  probel və ya vergüllə ayrılmaqla mənimsədilir.  
Məsələn, 

>>syms  a b j d 
 >>A=[a, b; j, d] 
 A= 
       [a, b] 
       [j, d] 
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Simvolik massivlər üzərində matrislər cəbrinin qanunlarına 
uyğun hesablama əməliyyatları: massivlərin toplanması, hasili, 
qüvvətə yüksəldilməsi, transponirə olunması, determinantın və 
tərs massivinin tapılması əməliyyatı  aparılır. Matrisin 
transponirə olunması üçün  «.’» operatorundan, matrisin 
determinantını hesablamaq üçün det(<massiv>), tərs matrisini 
tapmaq üçün isə inv (<massiv>) funksiyalarından istifadə 
olunur.  Məsələn, 

Misal 1 
>> syms x a z x c v b n; 
>> A=[x a; z x]; 
>> B=[c v; b n]; 
>> C=A*B 
C = 

[ x*c+a*b, x*v+a*n] 
[ z*c+x*b, z*v+x*n] 

Misal 2 
>> A=[x a; z x]; 
>> B=[c v; b n]; 
 >> C=B^2 
 C = 

[ c^2+v*b, c*v+v*n] 
[ b*c+n*b, v*b+n^2] 

Misal 3 
>> syms x a z x c v b n; 
>>A=[x a; z x]; 
>>B=[c v; b n]; 
>> C=A+B 
C = 

[ x+c, a+v] 
[ z+b, x+n] 

Misal 4 

130    
Fəsil 2  Matlab 7   

 

>> syms x a z x c v b n; 
>> A=[x a; z x]; 
>> A.ʹ 
 ans = 

[ x, z] 
[ a, x] 

Misal 5 
>> syms x a z x c v b n; 
>>B=[c v; b n]; 
>> det(B) 
 ans = 
           c*n‐v*b 

Misal 6 
>> syms x a z x c v b n; 
>>B=[c v; b n]; 
>> inv(B) 
 ans = 

 [ ‐n/(‐c*n+v*b),  v/(‐c*n+v*b)] 
x  i.(‐s*t+m*i)b ‐s.(‐s*t+m*i)j 

Qeyd edək ki, Sym funksiyası həmçinin ədədi massivi simvolik 
massivə çevirir.  Məsələn, 

 >>A=[1.1, 2.3; 3.1, 4.2]; 
 >>B=Sym(A) 
 B= 

[11/10  23/10 
       [31/10  21/5] 

Misaldan göründüyü kimi bu zaman ədəd rasional kəsr 
şəklində yazılır. Simvolik ifadəni tələb olunan dəqiqliklə 
hesablamaq olar. Bu məqsədlə vpa(<simvolik ifadə>,n) 
funksiyası nəzərdə tutulmuşdur, harada n-hesablamanın 
dəqiqliyini bildirən tam ədəddir.  Məsələn, 
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 >> c=sym(ʹsqrt(5)ʹ); d=vpa(c,10) 
   d = 

    2.236067978 

Simvolik dəyişənləri ədədi dəyişənlərə çevirmək üçün isə 
double array (<simvolik dəyişən) funksiyasından istifadə 
olunur. 

Birdəyişənli simvolik funksiyanın qrafikinin qurulması 
üçün  ezplot (<arqument>, <təyin oblastı>) və ezpolyar 
(<arqument>, <təyin oblastı>) funksiyasından istifadə olunur. 
Bu funksiyalar müvafiq olaraq qrafiklərin Dekart və polyar  
koordinat sistemlərində qurulmasını təmin edirlər1. İkidəyişənli 
funksiyaların qrafiklərinin qurulması üçün isə 
Ezsurf(<arqument>, <təyin oblastı>), ezsurfc (<arqument>, 
<təyin oblastı>), ezmech(<arqument>, <təyin oblastı>), 
ezmehc(<arqument>, <təyin oblastı>)  funksiyalarından 
istifadə olunur. Funksiyanın təyin oblastı [<a, b, c, d>] şəklində 
verilir və burada ilk 2 qiymət əlifba sırasında əvvəl təyin 
olunan arqumentin  təyin oblastı hesab olunur.  Məsələn, 

>>f=sym(‘x+x^ 2+a‘); f=ezsurf(f, [2, 3  10, 50])  

Baxılan misalda x arqumenti [10, 50], a arqumenti isə [2, 3] 
parçasında təyin edilmişdir.   
   Symbolic Math Tool simvolik ifadələr  üzərində 
əməliyyatlar aparmaq üçün bir sıra fynksiyalardan istifadə edir: 

1. Collect (<çoxhədli>, <dəyişən>). Funksiya simvolik 
çoxhədli üzərində  müəyyən edilən dəyişənə görə qruplaşdırma 
aparır. Məsələn, 

>>d=sym(ʹx^3‐(x‐a)^2‐x‐5ʹ); 
>>Collect(d,ʹxʹ) 
 ans = 

 x^3‐x^2+(‐1+2*a)*x‐a^2‐5 

                                                 
1 Funksiyanın təyin oblastı verilmədikdə,  sistem arqumentin [-2; 2] 
intervalında dəyişdiyini qəbul edir. 
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2. Expand(<ifadə>). Funksiya simvolik çoxhədlinin və 
triqonometrik ifadənin «açılışını» təmin edir. Məsələn, 

 >> d=sym(ʹsin(2*x)ʹ); 
>> expand(d) 
 ans = 
         2*sin(x)*cos(x) 

 3.Factor(<ifadə və ya ədəd>). Funksiya çoxhədlini 
vuruqlara ayırır, ədədi sadə ədədlərin hasili şəklində göstərir. 

>> a=sym(ʹsin(x)^2‐cos(x)^2ʹ); 
>> factor(a) 
 ans = 

 (sin(x)‐cos(x))*(sin(x)+cos(x)) 
> syms a 
>> a=sym(ʹ245ʹ);  factor(a) 
 ans = 
           (5)*(7)^2 

4. Simple(<çoxhədli>), simplify(<ifadə>). Funksiyalar 
simvolik ifadəni sadələşdirir. Simplify funksiyası daha 
mükəmməl alqoritmə malik olub, çoxhədli ilə yanaşı 
triqonometrik, loqorifmik, eksponensial, hiperbolik, Bessel, 
Qamma funksiyalarını  da sadələşdirir. Məsələn,  

>> a=sym(ʹexp(ln(a))ʹ); 
>> simplify(a) 

5.Horner(<çoxhədli>). Funksiya məşhur Horner sxemi ilə 
çoxhədlini vuruqlara ayırır və qalıq həddini hesablayır. 
Məsələn,  

>> a=sym(ʹx^3‐2*x‐x^2‐1ʹ); horner(a) 
   ans = 
          ‐1+(‐2+(‐1+x)*x)*x 
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6.Sybs (<ifadə>,<‘dəyişən və ya ifadə>,<ifadə>). 
Funksiya  simvolik ifadədə dəyişəni və ya ifadəni  digər ifadə 
ilə əvəz edir. İfadədə dəyişəni konkret qiymətlə əvəz etməklə, 
ifadənin qiymətini hesablamaq olar.  Məsələn, 

>> f=sym(ʹx^3‐x^2‐6ʹ);  f1=subs(f,ʹxʹ,ʹa‐1ʹ) 
 f1 = 
         (a‐1)^3‐(a‐1)^2‐6 
>> f1=subs(f,ʹxʹ,23) 
f1 = 
       11632 

Praktikada bir sıra məsələlərin həllində funksiyanı Teylor 
sırasına ayırmaq tələb olunur.  Matlab-da bu əməliyyat Taylor 
(<f>,<n>, <x>, <a>) funksiyası ilə  yerinə yetirilir. Burada, 
<f> - funksiyanı, <n> həddlərin sayını, <x> hansı dəyişənə 
görə, <a> hansı nöqtənin ətrafında sıraya ayrılmanı təyin edir1. 
<n> verilmədikdə sistem  n =6, <a> verilmədikdə isə a=6 qəbul 
edir. Məsələn, 

>> f = Sym ( ʹ1/(1+x)ʹ); t=taylor (f); 
t = 
      1‐x+ x^2‐x^3 +x^4‐x^5 
 >> syms x; 
>>taylor(exp(x), 4, x,1/2) 
ans = 
      exp(1/2)+exp(1/2)*(x‐1/2)+1/2*exp(1/2)*  
      (x‐1/2)^2+1/6*exp(1/2)*(x‐1/2)^3 

Qeyd edək ki, funksiyanı Teylor sırasına taylortool adlı qrafiki 
əlavə vasitəsilə də ayırmaq olar. Bunun üçün əmr sətirində 
taylortool əmrini daxil etmək açılan əlavə pəncərəsinin f (x) 
səhəsində funksiyanı, N sahəsində hədlərin sayını, “a=” 
sahəsində nöqtəni və arqumentin dəyişmə intervalını müəyyən 

                                                 
1 Çox dəyişənli funksiyalar üçün <x> dəyişənini vermək zəruridir. 
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etmək  lazımdır. Bu zaman funksiyanın teylor sırasına ayrılışı 
və funksiyanın qrafiki pəncərədə əks olunacaq (şək.2.9-1).  

 
şək.2.9-1 

Riyaziyyatın əsas anlayışlarından biri olan sıranın 
hesablanması üçün Symsym (<'hədd'>, <indeks>, <indeksin 
yuxarı sərhədi>, <indeksin aşağı sərhədi>) funksiyasından 

istifadə olunur. Məsələn,  S=  
 










0

12

!12
1

k

k
k

k
x  sırasını 

hesablamaq üçün aşağıdakıları əmr sətirinə daxil etmək 
lazımdır. 

>> syms x k 
>>s=symsum((‐)^(k)*x^(2*k+1)/sym(ʹ(2*k+1)!ʹ),k,0,inf) 
s = 

sin(x) 

Funksiyanın konkret nöqtədə limitinin hesablanması 
üçün  limit(<funksiyanın adı>, <dəyişən>, <nöqtə>), sağ və 
sol limitin tapılması üçün isə müvafiq olaraq limit(<funksiya>, 
<dəyişən>, <nöqtə>, 'Left’), limit (<funksiya>, <dəyişən>, 
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<nöqtə>, 'Right’) funksiyaları nəzərdə tutulmuşdur. Məsələn, 
1
x

x 1
lim(10 x)


  və 
1
x

x 0
lim (10 x)


   hesablayaq. Onda əmr sətirində 

aşağıdakıları  daxil etmək lazımdır. 
>> syms x 
>> limit((10+x)^(1/x),x,0,ʹleftʹ) 
ans = 
          0 
>> limit((10+x)^(1/x),x,1,ʹrightʹ) 
 ans = 

 11 

Funksiyanın ixtiyari tərtibindən diferensialı diff (<funksiya>, 
<dəyişən>,<n-tərtib>) funksiyası vasitəsilə,   qeyri müəyyən 
inteqral int(<funksiya>,<dəyişən>), müəyyən inteqral  
int(<funksiya>, <dəyişən>, <a,b>)1 funksiyaları vasitəsilə 
hesablanır. Çoxqat inteqral isə  int funksiyasını təkrar tətbiq 

etməklə hesablanır.  Məsələn, fərz edək ki, 
d b

c a

ysin xdxdy   

inteqralını hesablamaq tələb olunur. Onda, 
>> f=sym(ʹy*sin(x)ʹ);  ix=int(f,x,a,b); 
>> yx=int(ix,y,c,d) 
yx = 
         1/2(‐cos(b)+cos(a))*(d^2‐c^2) 
 >> diff(atan(1/x),x,1) 
ans = 

‐1/x^2/(1+1/x^2) 

Cəbri tənlikləri və xətti sistem tənlikləri analitik həll 
etmək üçün müvafiq olaraq solve (f,x) və solve (f1, f2, x1, x2…) 
funksiyasından istifadə olunur. Məsələn, 

>> f=sym(ʹx^2‐2*x+1ʹ); p=solve(f) 

                                                 
1 a və  b müvafiq olaraq inteqralın aşağı və yuxarı sərhdlərini təyin edir. 
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 p = 
         [ 1] 
          [ 1] 
>> syms s x1 x2 f1 f2 
>>f1 = sym (ʹx1*(2‐x2)‐ cos (x1)‐ exp (x2)ʹ); 
>>f2 = sym (ʹ2+x1‐x2‐ cos (x1)‐ exp (x2)ʹ); s=solve (f1, f2, x1, x2); 
>> s.x1 
 ans = 

  ‐2.7892533412300041640480097492662‐          
2.4038123717177356373665914548970*i 
>> s.x2 
 ans = 

  1.1881759686903336861349749893128‐     
.11937436768241059658057945114116*i 

 Diferensial tənlikləri analitik  həll etmək üçün isə dsolve 
funksiyasından istifadə olunur. Məsələn,  fərz edək ki, 

1)5.0(' 22  yxyy  Koşi məsələsini  həll etmək tələb 
olunur. Onda aşağıdakı əmri yerinə yetirməliyik: 

>> y=dsolve(ʹDy+y^2=x^(‐2)ʹ,ʹy(0.5)=‐1ʹ,ʹxʹ) 
 y = 

1/2*(1‐5^(1/2)*tanh(‐1/2*5^(1/2)*log(x)+1/2*log(9+4*5^(1/2))‐   

1/2*log(2)*5^(1/2)))/x 
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FƏSİL 3 
 
 

SCIENTIFIC WORK PLACE 5.0 
 

Keçən əsrin 70-ci illərinə qədər elmi-texniki kitabların, 
məqalə və sənədlərin nəşri yanlız mətbəə yığımına əsaslanırdı. 
1979-ci ildə Stanford universitetinin professoru Donald Knut 
tərəfindən TEX dilinin və sonradan onun əsasında AMS-TEX, 
LaTex, Scientific Word, Scientific Work Place və s. elektron 
nəşriyyat sistemlərinin yaradılması,  yüksək poliqrafik 
kefiyyətli məhsulların hazırlanmasını təmin etdi. Bu sistemləri 
dünyanın əksər nəşriyyatları, elmi mərkəzləri istifadə edir. Bu 
səbəbdən, bir sıra jurnal redaksiyaları, beynəlxalq konfrans 
təşkilatçıları məqalə və məruzələrin məhz  TEX sənədi kimi 
hazırlanmasını tələb edir.  

Scientific Work Place 5.0 yüksək poliqrafik kefiyyətli 
elmi-texniki sənədlərin hazırlanması və riyazi, elmi-texniki 
məsələlərin həlli üçün nəzərdə tutulmuş inteqral sistemdir.  
Belə ki, paket özündə Scientific Word mətn redaktorunu, Maple 
və MuPAD riyazi proqram paketlərinin hesablama 
prosessorlarını birləşdirir. Maple və MuPAD hesablama 
prosessorları məsələni analitik və ədədi üsullarla həll etməyi 
təmin edir. 

 Scientific Work Place 5.0 paketi həmçinin, mətnin 
avtomatik yoxlanılması təmin edən orfoqrafik korrektora, digər 
proqramlarda hazırlanmış mətn, şəkil, cədvəl və qrafiklərin 
idxalını təmin edən əlliyə yaxın xüsusi filtrə malikdir. Bundan 
əlavə, paket vasitəsilə istifadəçilərin və tələbələrin bilik 
səviyyəsini təyin etmək üçün elektron testlər hazırlamaq olar. 
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3.1 SCIENTIFIC WORK PLACE  5.0: YENİ SƏNƏDİN 
HAZIRLANMASI 

 
Scientific Work Place 5.0 paketi yükləndikdə Windows 

əlavələri üçün standart qrafiki işçi interfeys pəncərəsi açılır. 
İnterfeys pəncərəsi başlıq, menyu sətrindən, alətlər 
panellərindən, sənəd pəncərəsindən, Tag panelindən,  cari 
vəziyyət sətrindən ibarət olub, istifadəçinin avtomatlaşmış İşçi 
Yeri hesab olunur. Onun vasitəsilə istifadəçi sənəd yaradıb, 
onu səhifələyə, redaktə və çap edə, hesablama əməliyyatı 
yerinə yetirə, müəyyən riyazi məsələləri həll edə bilər.  

Yeni sənəd konkret sənəd tipinə uyğun stil əsasında  
sənəd pəncərsində yaradılır. Proqram yükləndikdə avtomatik 
olaraq açılan sənəd pəncərəsində sənəd  elmi məqalələr üçün 
nəzərdə tutulmuş Blank- Standart LaTEX Article stilinə 
əsaslanır1. Avtomatik müəyyən olunan stildən fərqli stildə 
sənəd yaratmaq tələb olunduqda, File→New əmrini yerinə 
yetirmək, açılan pəncərədə sənədin növünə müvafiq digər stili 
seçmək və OK düyməsini sıxmaq lazımdır. 

 Sənəd  özündə mətn, düstur, hesablamanın nəticəsini,  
riyazi məsələnin həllini, qrafikləri, şəkilləri, cədvəlləri əks 
etdirə bilər. Sənədə mətn əsasən  klaviatura vasitəsilə  daxil 
olunur2. Bu zaman  mətni daxil etmə rejimini aktiv etmək 
lazımdır. Bunun üçün standart alətlər panelində Togglr/Math 
                                                 
1 Proqram yükləndikdə açılan sənəd pəncərəsində yeni sənədlər üçün 
nəzərdə tutulmuş  stili istifadəçi yenisi ilə əvəz edə bilər. Bunun üçün 
Tools→User Setup əmrini yerinə yetirib açılan eyni adlı dialoq 
pəncərəsində Start-up-Document bölməsində Shell Directories  siyahısından 
konkret sənəd növünü, Shell  Files siyahısından isə ona müvafiq stili seçib 
OK düyməsini sıxmaq lazımdır 
2 Mətn həmçinin  digər sənədlərdən mübadilə buferi vasitəsilə daxil edilə 
bilər. 
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aləti T formasında olmalıdır. Düsturlar, hesablama üçün 
nəzərdə tutulmuş riyazi ifadələr,  «təbii» yazılışla, riyazi 
rejimdə1  daxil edilir. Bu zaman düsturlar və riyazi ifadələr 
ekranda qırmızı rəngdə əks olunur2. Düsturu və ya ifadəni  cari 
sətrin mərkəzinə doğru nizamlamaq  üçün onu qeyd edib, 
İnsert→Display əmrini yerinə yetirmək və ya «Ctrl+D» qızğın 
düyməsini sıxmaq lazımdır. Riyazi simvollar arasına probel 
daxil etmək üçün probel düyməsini «Shift» düyməsi ilə birlikdə 
sıxmaq lazımdır. Dusturların və riyazi ifadələrin tərtibi zamanı 
Math Objects, Math Templates və Symbol Panels alətlər 
panelinin alətlərindən (şək.3.1-1) istifadə edilə bilər. 

 
şək.3.1-1 

TEX dilini bilən istifadəçilər  riyazi simvolları həmçinin dilin 
yazılış elementləri əsasında  klaviaturadan daxil edə bilər. 
Məsələn,  hərfinin yazmaq üçün o, /alfa  yazmalıdır[27]. 
  İfadənin təbii yazılışında bəzi hallarda istisnalara riayət 
etmək tələb olunur. Belə ki, bir sıra funksiyaların  yazılışı 
fərqlənir [27]. Digər tərəfdən proqram cosxy yazılışını xy-i 
funksiyanın arqumenti kimi deyil, cos(x)y kimi qəbul edir. Belə 
halda, cos(xy) yazmaq məsləhətdir. 

Mürəkkəb düsturların və riyazi ifadələrin yazılışında 
makroslardan istifadə etmək məsləhətdir. Makroslar düstur və 
riyazi ifadələrin daxil edilməsini sürətləndirməyə xidmət edir. 

                                                 
1 Bunun üçün standart alətlər panelində Togglr/Math aləti M formasında 
olmalıdır 
2 Standart funksiyalar, məsələn sin, cos və s.istisna olmaqla. 
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Məsələn,     
b d

c

b

a
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)()()(   (3.1-1) 

düsturunu yazmaq üçün üç inteqral daxil  etmək lazımdır. Bu 
düsturu daxil olunmasında makrosu tətbiq edək. Bunun üçün 

Math Objects panelinin köməyi ilə 
b

dxxf
0

)(  dusturunu daxil 

etdikdən sonra onu qeyd edib mübadilə buferində saxlayaq və 
Tools→Automatic Substitution əmrini yerinə yetirib makros 
yaradaq. Bunun üçün əmri yerinə yetirdikdə açılan Automatic 
Substitution dialoq pəncərsində Substitution səhəsinə «Ctrl+C» 
qızğın düyməsini sıxmaqla mübadilə buferindəki düsturu daxil 
edək. Keystrokes  sahəsində makorsa müəyyən ad, məsələn 
integ məniməsədib Save düyməsini sıxaq. (şək.3.1-2). 

 
şək.3.1-2 

Düsturun tərkib hissəsi olan ikinci və üçüncü inteqralı daxil 
etmək üçün sadəcə olaraq sənəddə onların yerinə makrosun 
adını, yəni integ sözünü klaviaturadan daxil edirik və bu zaman 

sənədə daxil olunan makrosa uyğun 
b

dxxf
0

)( düsturu üzərində  

kiçik redaktə işi aparmaqla (3.1-1)  düsturunun  yazılışına nail 
oluruq. 
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Sənədə cədvəl daxil etmək üçün İnsert→Table əmrini 
yerinə yetirib, açılan pəncərədə sətir və sütunların sayını, 
sütunların nizamlama parametrini müəyyən etmək və OK 
düyməsini sıxmaq lazımdır (şək.3.1-3).  

 
şək.3.1-4 

Daha sonra ekranda əks olunan cədvəl şablonunda müvafiq 
xanalara informasiya daxil etmək lazımdır.  Cədvələ yeni sətir 
və sütun əlavə edilməsi və cari sütunun ləğv edilməsi kontekst 
menyunun İnsert Row(s), İnsert Column(s), Delete Columns 
əmrini, qeyd olunmuş xanaların birləşdirilməsi isə Merge Cells 
əmrini yerinə yetirməklə təmin olunur. Cədvəlin formatlaşması 
isə Edit→Table Properties əmrini yerinə yetirdikdə açılan Table 
Properties dialoq pəncərəsinin müvafiq bölmələrində proqram 
tərəfindən avtomatik müəyyən olunan parametrləri (məsələn,  
cədvəlin xanalarının sərhədləri üçün xətt stilini, xanalarda 
informasiyanın nizamlanmasını, xanaların enini və s) 
dəyişməklə həyata keçirilir (şək.3.1-5).  
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şək.3.1-5 

Sənədə şəkil daxil etmək üçün isə File→Import Picture 
əmrini yerinə yetirmək və şəkil faylının ünvanını açılan dialoq 
pəncərəsində müəyyən etmək və Open düyməsini sıxmaq 
lazımdır.  

Yeni sənədin yaddaşda saxlanması  File→Save əmri 
vasitəsilə təmin olunur. Əmri yerinə yetirdikdə istifadəçi açılan 
pəncərədə sənədin ünvanını müəyyən etməlidir.  Proqramla 
seans müddədində yaradılmış bütün sənədlərin hamısını 
yaddaşda saxlamaq üçün File→Save All əmrini yerinə yetirmək, 
sənədi başqa ünvanda yaddaşda saxlamaq üçün isə 
File→SaveAs əmrini yerinə yetirmək, açılan SaveAs dialoq 
pəncərəsində sənədin yeni ünvanını müəyyən etmək lazımdır.  

Paket TEX sənədini HTML sənədinə konvert etməyi də 
təmin edir. Bunun üçün File→Export Document As əmrini 
yerinə yetirmək və açılan eyni adlı dialoq pəncərsində HTML 
sənədinin ünvanını müəyyən etmək və Save düyməsini sıxmaq 
lazımdır. Konvert zamanı  sənəddəki düsturlar istifadəçinin 
təlabatından asılı olaraq şəkil və ya MathML faylı kimi 
yaddaşda saxlanılır. Sənəddəki düsturları MathML faylı kimi 
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yaddaşda saxlamaq üçün istifadəçi Tools→Settings əmrini 
yerinə yetirib açılan dialoq pəncərəsinin Math Export  
sahəsində  Export  Math as  MathML  variantını,  şəkil kimi 
yaddaşda saxlamaq üçün isə  Export as Graphics  variantını və 
Graphics Type For Math Export açılan siyahısında  şəkil 
faylının tipini seçməlidir (şək.3.1-6).  

 
şək.3.1-6 

Hazırlanmış sənədi  LaTex 2 səndi kimi səhifələmək 
üçün  Typeset→ Preview əmrini yerinə yetirmək lazımdır. 
Səhifələnmə uğurlu həyata keçirildikdə eyni adlı dvi 
genişlənməsinə malik fayl yaranır və səhifələnmiş sənəd 
TruTex Dvi Previewer proqram pəncərəsində əks olunur. 
İstifadəçi «Ctrl+*» qızğın düyməsini sıxmaqla sənədin 
səhifəsinin görünüşünü böyüdə, «Ctrl+/» qızğın düyməsini 
sıxmaqla kiçildə, «Ctrl+0» qızğın düyməsini sıxmaqla isə 
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səhifənin ölçüsünün real görnüşünə (1:1 miqyasda) nail ola 
bilər. Səhifələnmiş sənədin görünüşü istifadəçini qane edərsə o, 
File→Print əmrini yerinə yetirməklə sənədi tamamilə, konkret 
nömrəli səhifələri, qeyd olunmuş sənəd fraqmentini  bir və ya 
bir neçə nüsxədə çap edə bilər1.  İstifadəçi sənədi LaTex 2  
sənədi kimi  həmçinin Typeset→Print əmrini yerinə yetirməklə 
də çap edə bilər2. 

 
 

3.2 SƏNƏDDƏ İSTİNADLARDAN İSTİFADƏ 
 

Sənəddə  konkret  düstura, səhifəyə istinad oluna bilər.  
Konkret düstura istinad yaratmaq üçün  düsturu daxil edib, onu 
mərkəzə doğru nizamlamaq, Edit →Properties əmrini yerinə 
yetirmək və açılan Display Properties dialoq pəncərəsində 
Auto variantını seçərək, Key for this line sahəsində istinad 
göstəricisinə ad, məsələn, formula yazıb OK düyməsini sıxmaq 
lazımdır (şək.3.2-1). Bu zaman sətrin sonunda qonur rəngli 
düzbucaqlı  (formula) sahəsi yaranır.  Daha sonra kursoru 
düstura istinad mətninin sonunda yerləşdirib,  İnsert→Typeset 
Object→Cross Reference əmrini yerinə yetirmək və açılan 
dialoq pəncərəsinin (şək.3.2-2) Key sətrində də formula yazıb, 
Object Counter variantını seçmək və OK düyməsini sıxmaq 
lazımdır. Bu zaman isə sənəddə ref:formula sahəsi yaranır. 
Sənədi  LaTex sənədi kimi səhifələdikdə sənəddə nömrələnmiş 
düstur və düstura istinad yaranıdığını görəcəyik.  

                                                 
1 İstifadəçi nüsxələrin sayını və çap diapozonunu əmri yerinə yetirdikdə 
açılan dialoq pəncərəsindən müəyyən etməlidir.    
2 Eyni qayda da, nüsxələrin sayını və çap diapozonunu istifadəçi əmri yerinə 
yetirdikdə açılan dialoq pəncərəsindən müəyyən etməlidir 
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şək.3.2-1 

 
şək.3.2-2 

 Cari səhifəyə istinad yaratmaq üçün ilk öncə,  
İnsert→Marker əmrini yerinə yetirib, açılan pəncərədə markerə 
ad, məsələn ab, verib  OK düyməsini sıxmaq lazımdır (şək.3.2-
3). Bu zaman səhifədə marker:ab sahəsi yaranır. Daha sonra 
kursoru səhifəyə istinad mətninin sonunda yerləşdirib, 
İnsert→Typeset Object→Cross Reference əmrini yerinə yetirmək 
və açılan dialoq pəncərəsinin  Key sətrində daxil edilmiş 
markerin adını-ab yazıb Page Number variantını seçib OK 
düyməsini sıxmaq lazımdır (şək.3.2-2). 
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şək. 3.2-3 

Nəticədə sənəddə səhifəyə istinad mətnindən sonra pageref.:ab 
sahəsi yaranır ki, Typeset→ Preview əmrini yerinə yetirdikdə 
True TeX Dvi Preview pəncərəsində onun yerində avtomatik 
olaraq səhifənin nömrəsi əks olunur. 
   Sənəddə müəyyən termin və fikirlərə izah vermək üçün 
səhifənin sonunda verilən izahatlara istinad etmək olar. Bunun 
üçün İnsert→ Note əmrini yerinə yetirib, açılan Note dialoq 
pəncərəsində Type of Note açılan siyahısından istinadın tipini- 
footnote variantinı seçmək və istinadın mətnini daxil edib, OK 
düyməsini sıxmaq lazımdır (şək.3.2-4).  

 
şək.3.3-4 

3.3 ƏDƏBİYYAT SİYAHISININ TƏRTİB EDİLMƏSİ VƏ 
ƏDƏBİYYATA İSTİNAD 

Fərz edək ki, Chapter3.tex adlı sənəd hazırlamışıq.  Bu 
sənədinin sonunda ədəbiyyat siyahısı tərtib edək və sənədin 
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mətn hissəsindən siyahının ikinci ədəbiyyatına istinad edək. 
Sənədin sonunda ədəbiyyat siyahısı tərtib etmək üçün ilk 
növbədə kursoru sənədin sonunda yeni sətirdə yerləşdirib, 
Typeset→Bibliography Choise əmrini yerinə yetirmək və açılan 
Bibliography Choise dialoq pəncərəsində Manual Entry 
variantını seçib OK düyməsini sıxmaq lazımdır. Sonra Item 
Tag1 panelində teqlər siyahısından Bibliography item teqini 
seçmək lazımdır. Bu zaman sənəddə bibitem sözü yaranır və 
Bibliography İtem Properties dialoq pəncərəsi açılır, burada 
Label sahəsində 1 və  Key açılan siyahısında  konkret nişan, 
məsələn sid  yazıb OK düyməsini sıxmaq lazımdır (şək.3.3-1). 

 
şək. 3.3-1 

Sonrakı addımda, sənəddə yaranan və  1 (sid) ilə başlayan yeni 
sətirdə ədəbiyyatın biblioqrafik təsvirini (məsələn, Knuth D.E. 
The TEX book.-Addison-Wesley Publishing Company, 1986) daxil 
etmək və ENTER düyməsini sıxmaq lazımdır. Təkrarən açılan 
Bibliography İtem Properties pəncərəsinin Label sahəsində 2 
və  Key açılan siyahısında  isə pet yazıb yenə  ENTER 
düyməsini sıxmaq və yeni yaranan 2 (pet) sətrində ikinci 
ədəbiyyatın biblioqrafik təsvirini daxil etmək lazımdır. Bu 
qayda ilə digər  ədəbiyyatların təsviri də siyahıya daxil edilir. 
Siyahıya yeni ədəbiyyat təsvirinin daxil olunmasını 
dayandırmaq üçün ENTER düyməsini sıxdıqda təkrarən açılan 

                                                 
1 Panel interfeys pəncərəsinin  sol aşağı küncündə üzərində yaşıl ox 
piktoqramı olan Remove İtem Tag -Teqin ləğvi alətinin yanında yerləşir. 
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Bibliography İtem Properties pəncərəsinin Cancel düyməsini 
və bundan sonra Remove İtem Tag alətini1 sıxmaq lazımdır.  

Sənədin mətn hissəsindən ədəbiyyat siyahısının konkret 
ədəbiyyatana istinad etmək üçün İnsert→Typeset 
Object→Citation əmrini yerinə yetirmək və Citation dialoq 
pəncərəsinin Key açılan siyahısından istinad olunan 
ədəbiyyatın nişanını, məsələn, baxdığımız misalda siyahıda 
ikinci ədəbiyyata istinad etmək üçün   pte seçmək və OK 
düyməsini sıxmaq lazımdır. Bu zaman sənəddə qonur rəngli 
sahə-site:pet sahəsi əks olunur. Typeset→Preview əmrini yerinə 
yetirib sənədi LaTex sənədi kimi səhifələdikdə, TrueTeX DVİ 
Previewer pəncərəsində sənəddə [2] şəklində ikinci ədəbiyyata 
istinad yarandığını görərik. 

 
 

3.4 MÜRƏKKƏB STRUKTURLU SƏNƏDLƏRİN 
HAZIRLANMASI 

 
Mürəkkəb strukturlu sənəd olaraq kitab hazırlanması 

texnologiyası ilə tanış olaq. Fərz edək ki, kitab  mündəricatdan, 
üç fəsildən, ədəbiyyat siyahısından, mövzu, şəkil, cədvəl 
göstəricilərindən  və kitaba əlavədən ibarətdir. Fəsillər, kitaba 
əlavə və ədəbiyyat siyahısı  Standart LaTex Book stili əsasında 
ayrıca sənəd kimi  hazırlanmışdır və müvafiq olaraq 
Chapter1.tex, Chapter 2.tex, Chapter3.tex, Mapp.tex, Biblio.tex 
fayllarından ibarətdir.  

İlk öncə kitab  üçün mövzu göstəricisi yaradaq. Bunun 
üçün Chapter1.tex, Chapter 2.tex, Chapter3.tex, Mapp.tex 
sənədlərində kursoru  göstəriciyə daxil olunacaq termindən 
sonra və ya əvvəl yerləşdirib İnsert→Typeset Object → İndex 
Entry  əmrini yerinə yetirək və açılan İndex Entry  dialoq 
pəncərəsində  Primary İndex Entry  sahəsində termini daxil 
                                                 
1 Alət interfeys pəncərəsinin  sol aşağı küncündə yerləşib, yaşıl rəngli ox 
piktoqramına malikdir.  
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edək. Əgər termin bir neçə sözlə ifadə olunursa Primary İndex 
Entry  sahəsində terminin birinci,  Secondary İndex Entry  
sahəsində ikinci, Tertiary İndex Entry sahəsində isə üçüncü 
sözü daxil edərək, termin üçün yazı stilini  və  Page Number 
variantını seçib, OK düyməsini sıxırıq (şək3.4-1). Bu zaman  
cari sənəddə index və termin sözünün qeyd olunduğu 
düzbucaqlı çərçivə  yaranacaq1.  Daha sonra, Book.tex adlı 
master sənəd yaradaq. Bunun üçün Standart LaTex Book stili 
əsasında yeni sənəd pəncərsi açıb, onu Book.tex faylı kimi 
yaddaşda saxladıqdan sonra  sənəddə aşağıdakı əməliyyatları 
yerinə yetirmək lazımdır: 

1.Typeset→Options and Packages əmrini yerinə yetirmək 
və açılan eyni adlı dialoq pəncərəsinin Class Options 
bölməsində Modify düyməsini sıxmaq və açılan növbəti 
pəncərədə kitab üçün parametrləri-səhifənin və şriftin 
ölçüsünü, düsturların nömrəsinin yerləşmə istiqamətini və s. 
seçmək lazımdır (şək.3.4-2). Packages Options bölməsində isə 
Add düyməsini sıxıb termin göstəricisi yaratmaq üçün makeidx 
paketini əlavə etmək (şək.3.4-3), sonra Typeset→Preamble 
əmrini yerinə yetirib açılan Latex Preamble  dialoq pəncərəsinə 
makeindex sətrini daxil etmək lazımdır; 

                                                 
1 Əgər View menyusunda İndex Entries əmri aktivdirsə. 
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şək. 3.4-1 

 
      şək.3.4-2                                
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şək.3.4-3 

2.Book.tex sənədində İnsert→Typeset Object → 
Subdocument əmrini yerinə yetirib, açılan dialoq pəncərəsində 
Chapter1.tex, Chapter 2.tex, Chapter3.tex, Mapp.tex, Biblio.tex 
fayllarının adlarını əlavə etmək lazımdır. Bu zaman sənəddə 
qonur rəngli  [Include Chapter1], [Include Chapter2,  [Include 
Chapter3, [Include Mapp],  [Include Biblio]  çərçivələri əks 
olunacaqdır; 

3.Kursoru [Include Mapp  çərçivəsinin əvvəlinə qoyub, 
appendix fraqmentini ekranın aşağı sağ küncündə yerləşən 
Fragments panelindən daxil etmək lazımdır1 (şək.3.4-4); 

         4.Şəkil göstəricisi yaratmaq üçün  İnsert→Typeset 
Object→Tex Field əmrini yerinə yetirib, açılan pəncərədə 
Encapsulated sahəsini aktivləşdirmək, Name sahəsinə LOF, 
ondan aşağıdakı mətn sahəsinə isə  \listoffigures  sətirlərini 
daxil edib OK düyməsini sıxmaq lazımdır (şək.3.4-5). Bu 
zaman sənəddə qonur rəngli düzbucaqlı çərçivə- LOF yaranır. 

      

                                                 
1 Fragments panelinin ekranda əks olunması View →Toolbars əmri 
vasitəsilə tənzimlənir. 
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şək.3.4-4 

      .  

şək.3.4-5 

5. Cədvəl göstəricisi yaratmaq üçün  İnsert→Typeset 
Object→Tex Field əmrini təkrar yerinə yetirib, açılan pəncərədə 
Encapsulated sahəsini aktivləşdirmək, Name sahəsinə LOT, 
ondan aşağıdakı mətn sahəsinə isə  \listoftables  sətirlərini daxil 
edib OK düyməsini sıxmaq lazımdır (şək.3.4-5). Bu zaman 
sənəddə qonur rəngli düzbucaqlı çərçivə- LOT yaranır 

 6. Mövzu göstəricisi yaratmaq üçün isə  eyni qaydada, 
İnsert→Typeset Object→Tex Field əmrini yerinə yetirib, açılan 
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pəncərədə Encapsulated sahəsini aktivləşdirmək, Name 
sahəsinə TOC, ondan aşağıdakı mətn sahəsinə isə \ 
tableofcontents  sətirlərini daxil edib OK düyməsini sıxmaq 
lazımdır (şək.3.4-5). Bu zaman sənəddə qonur rəngli 
düzbucaqlı çərçivə- TOC yaranır 

7. Kursoru [Include Biblio sahəsinin əvvəlinə qoyub, 
Fragments panelindən index fraqmentini daxil etmək lazımdır. 
Bu zaman sənəddə qonur rəngli  Plac Index Here çərçivəsi 
yaranır.  

8.Typeset→Compile əmrini yerinə yetirib, açılan Compile 
dialoq pəncərəsində Generate an İndex parametrini 
aktivləşdirib OK düyməsini sıxmaq lazımdır (şək.3.4-6).  Bu 
zaman sənəd kompilyasiya olunur. Əməliyyat müvəffəqiyyətlə 
yerinə yetirildikdə book.ind1, book.lot2, book.lof3, book.toc4 və 
book.dvi faylları yaranır. book.dvi faylına TruTex Dvi 
Previewer proqram pəncərəsində baxdıqda mündəricatdan, üç 
fəsildən, ədəbiyyat siyahısından, mövzu, şəkil, cədvəl 
göstəricilərindən, əlavədən ibarət kitab əks olunduğunu 
görərik.   

 
şək.3.4-6 

 
3.5 ELEKTRON TESTLƏRİN YARADILMASI 

 

                                                 
1 Mövzu göstəricisi faylı 
2 Cədvəl göstəricisi faylı 
3 Şəkil göstəricisi faylı 
4 Mündəricat faylı 
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Scientific Work Place 5.0 paketi istifadəçinin bilik, 
intellekt səviyyəsini müəyyən etmək üçün əvəzsiz vasitədir. O, 
elektron testlərin yaradılmasını təmin edir. İstifadəçi sualın 
cavabını təklif olunan variantlardan seçir. Bu zaman düzgün 
cavab 1, səhv cavab -1 ilə qiymətləndirilir. Suala cavab 
verilmədikdə həmin sual üçün «0» qiyməti hesablanır. Sual və 
cavablar ixtiyari qaydada istifadəçiyə təklif olunduğu üçün 
testlərin tərtibi üçün aşağıdakı təsadüfi ədəd funksiyalarından 
istifadə olunur: 

 rand(n) – (0, n-1) intervalında təsadüfi ədəd; 
 rand(m, n) (m<n) – [m,n] parçasında təsadüfi tam ədəd; 
 rand(<çoxluq>) – verilmiş çoxluqdan təsadüfi tam ədəd; 
 randmat(m, n, k, D) – nm  ölçülü, elementləri D 

çoxluğundan olan təsadüfi ədədlərdən ibarət matrisi təyin 
edir (k=1 olduqda matris ixtiyari, k=2 olduqda matris 
simmetrik, k=3 olduqda isə matris asimmetrik formaya 
malik olur). 
Konkret misal üzərində testin yaradılması ilə tanış olaq. 

Fərz edək ki, cəbrdən test yaratmaq tələb olunur. Bunun üçün 
ən sadə üsul Quizzess qovluğunda yerləşən hər hansı bir 
şablonu, məsələn,   Statistics.tex faylını seçib, açılmış sənədi 
File→Save As əmrini yerinə yetirməklə yeni adla, məsələn, 
test1.tex faylı kimi yaddaşda saxlayaq. Bundan sonra sənəddə 
Exam sözünü Test, Statistics sözünü ALGEBRA, Question 
sözünü Sual, Your Name sözünü isə S.A.A. ilə əvəz edək. Daha 
sonra sənəddə soyadın daxil edilməsi sahəsindən sonra 
yerləşən Setup sahəsində test üçün əsas parametrləri müəyyən 
etmək  üçün aşağıdakı sətirləri daxil edək: 

Choice Space: 21 
Choices: No Break, Radio Button1 

                                                 
1 Choice Space parametri cavab variantları arasında buraxılan boş məsafəni 
bildirir.  
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 Choices: Permute2 
 Submit: Results. 

Sonra Statement sahəsində sual daxil edilməlidir. Növbəti 
addımda sualın cavab variantları müəyyən edilir. Bunun üçün 
variant düymələrindən sonra cavablar daxil edilir.  Cari variantı 
düzgün cavab kimi fiksə etmək üçün File →Import Fragment  
əmrini yerinə yetirib açılan eyni adlı dialoq pəncərəsində 
Correct choice.frg  faylını seçmək və Open düyməsini sıxmaq 
lazımdır (şək.3.5-1). 

 
şək.3.5-1 

Bu qayda ilə digər sualları və ona uyğun cavab variantlarını 
müəyyən edib File→Export əmrini yerinə yetirib sənədi 
Test1.qiz faylı kimi yaddaşda saxlayırıq. Bundan sonra 
Test1.qiz faylını açırııq. Əgər testin hazırlanmasında səhvə yol 
verilibsə, bu zaman böyük qırmızı hərflərlə səhvin aşkar 
                                                                                                        
1 Choices: No Break, Radio Buton parametrləri cavab variantlarının üfüqi 
istiqamətdə yerləşməsini və düzgün cavabın  variant düymələri ilə  
seçildiyini bildirir. 
2 Cavab variantlarının ardıcıllığının təsadüfi olduğunu bildirir. 
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olunduğu haqqında məlumat əks olunur. Səhv olmadıqda 
istifadəçi öz soyadını, adını, atasının adını daxil edib, təklif 
olunan sualların düzgün cavab variantını seçirik. Bütün suallara 
cavab verdikdən sonra, Click to grade düyməsini sıxmaqla 
testin nəticəsi ilə tanış ola bilərik. Testin nəticəsi olaraq, testin 
cavablarına sərf olunan vaxt1, qazanılan ümumi bal2 və hər bir 
sualın düzgün olub-olmaması  haqqında məlumat və ona uyğun 
bal3 və s. informasiyalar əks olunur (şək.3.5-2). 

 
şək. 3.5-2 

Qeyd edək ki, File→Print əmrini yerinə yetirməklə testi və 
onun nəticəsini çap etmək olar. 
 
 
 

                                                 
1 Elapsed: 0:0:27 
2 Points Possible: 3 
3 a.You selected  (a-b)(a+b). Correct! You get 1 point 
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3.6 QRAFİKLƏRİN QURULMASI 

 
Scientific Work Place 5.0 iki və üç ölçülü koordinat 

sistemlərində funksiyaların qrafiklərinin, diferensial tənliklərin 
həll əyrilərinin və səviyyə xəttlərinin, vektor və qradient 
sahələrinin qurulmasını təmin edir. Funksiyanı qrafikini 
qurmaq üçün ilk öncə funksiya təyin olunmalıdır. Funksiya 
aşkar və ya qeyri aşkar şəkildə təyin edilə bilər. İstifadəçi 
funksiyanı aşkar şəkildə təyin etdikdən sonra koordinat 
sisteminə müvafiq olaraq Compute→Plot 2D → Rectangular, 
Compute → Plot 2D→Polar,  Compute → Plot3D → Rectangular, 
Compute→ Plot 3D→ Cylindrical, Compute→ Plot3D →Spherical 
əmrlərindən birini yerinə yetirməlidir. Belə ki, Compute→Plot 
2D→Rectangular əmri təyin edilmiş funksiyanın qrafikini iki 
ölçülü Dekart, Compute → Plot2D→Polar əmri polyar,  Compute 
→Plot 3D → Rectangular əmri üç ölçülü düzbucaqlı, Compute 
→ Plot 3D →Cylindrical əmri silindirik, Compute→Plot 3D → 
Spherical əmri isə sferik koordinat sistemlərində qrafiklərin 
qurulmasını təmin edir. Funksiya qeyri aşkar şəkildə təyin 
edildikdə isə  iki ölçülü koordinat sistemində qrafikləri qurmaq 
üçün Compute→Plot 2D→Implicit, üç ölçülü koordinat 
sistemində isə Compute→Plot 2D→Implicit əmrini yerinə 
yetirlmək lazımdır. Kompleks dəyişənli funksiyanın qrafikinin 
qurulması isə Compute→Plot 2D→Conformal əmrini yerinə 
yetirməklə təmin olunur. 

Funksiya həmçinin parametrik şəkildə təyin edilə bilər. 
Bu tip funksiyaların qrafiklərinin qurulması üçün Compute→ 
Plot 2D→ Parametric əmri nəzərdə tutulmuşdur. Məsələn, fərz 
edək ki, parametrik şəkildə: tx 5sin , ty cos  verilmiş 
funksiyanın qrafikini qurmaq tələb olunur. Bunun üçun 
Insert→Matrix əmrini yerinə yetirib sənədə (1x2) və ya (2x1) 

ölçülü matris şablonunda  )cos()5sin( tt  və ya 







)cos(

)5sin(
t

t
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daxil etmək və Compute→Plot2D→Parametric əmrini yerinə 
yetirmək lazımdır. Bundan sonra funksiyanın qrafiki sənəddə 
əks olunacaq(şək. 3.6-1). 

 
-sin(5t) cos(t) 

-1

-0.5

0

0.5

1

-1 -0.5 0.5 1

 

şək.3.6-1 

Bir koordinat müstəvisində bir neçə funksiyanın qrafikini 
qurmaq tələb olunduqda, funksiyaların yalnız sağ tərəfi  riyazi 
rejimdə, bir-birindən vergüllə ayrılmaqla sənədə daxil edilməli 
və Compute→Plot 2D→Rectangular, Compute → Plot 2D→Polar, 
Compute→Plot 3D→Spherical, Compute→ Plot 3D→Rectangular, 
Compute→Plot 3D→Cylindrical əmrlərindən biri yerinə 
yetirilməlidir (şək.3.6-2) 

 

 

sin(t),cos(t) 
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şək.3.6-2 

Diferensial tənliyin həllinin və iki tərtibli diferensial 
tənliyin səviyyə xəttinin qurulması üçün tənlik ədədi üsulla həll 
olunmalı və bundan sonra müvafiq olaraq Compute→ Plot 
2D→ODE  və Compute→ Plot 2D→Phase Plane əmrləri yerinə 
yetirilməlidir.  

Misal 1. 

















1)0(
0)0(
1

y
x

xyD
yxD

t

t

 

diferensial tənliklər sisteminin həllinin səviyyə xəttlərinin 
qrafikini qurmalı.  Bunun üçün, ilk öncə Insert→Matrix əmrini 
yerinə yetirib tənliklər sistemini  sənədə daxil etmək, 
Compute→Solve ODE→Numeric əmrini yerinə yetirib sistemi  
ədədi üsulla həll etmək lazımdır. Daha sonra Compute→ Plot 
2D→ODE əmrini yerinə yetirib məsələnin həllinin qrafikini, 
Compute→ Plot 2D→Phase Plane əmrini yerinə yetirməklə isə 
səviyyə xəttlərini qurmaq olar (şək.3.6-3, 3.6-4). 
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şək.3.6-3 

-1
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0
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0.5 1 1.5 2

 
şək.3.6-4 

Funksiyaların qradient və vektor sahələrini qurmaq üçün 
isə müvafiq olaraq funksiya və vektor təyin edildikdən sonra 
iki ölçülü koordinat sistemində Compute→Plot 2D→ Gradient və 
Compute→Plot 2D→Vector Field əmrlərini, üç ölçülü koordinat 
sistemində Compute → Plot 3D → Gradient və Compute→ Plot 
3D → Vector Field əmrlərini yerinə yetirmək lazımdır. Məsələn 
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33 1),( yxyxf   funksiyasının qradient sahəsi aşağıdakı 
kimi olacaqdır (şək.3.6-5). 

-4

-2

0

2

4

y

-4 -2 2 4x

 
şək.3.6-5 

Qeyd edək ki, funksiyanın qrafikləri proqram tərəfindən 
müəyyən olunan parametrlər əsasında qurulur.  İstifadəçi 
Compute→Settings və ya Tools→Computation→Setup əmrlərini 
yerinə yetirib, açılan dialoq pəncərəsinin 2D Plots, 3D Plots, 
Plot Layout, Plot Behavior bölmələrində bu parametrlərlə tanış 
ola və ya onları dəyişə bilər. Hər hansı parametrlərdə dəyişiklik 
edildikdə proqramla cari seans müddətində qurulan bütün 
qrafiklər yeni müəyyən edilmiş parametrlər əsasında 
qurulacaqdır.   

Konkret qrafik üçün avtomatik müəyyən edilmiş 
parametrləri dəyişdirmək və ya başqa sözlə qrafiki 
formatlaşdırmaq uçün qrafiki qeyd edib, kontekst menyunun 
Properties və ya Edit→Properties əmrini yerinə yetirmək 
lazımdır.  Bu zaman Layout, Labeling, Items Plotted, Axes, 
View bölmələrinə malik Plot Properties adlı dialoq pəncərəsi 
açılır (şək.3.6-6). 
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şək.3.6-6 

Dialoq pəncərəsinin Layout bölməsininin Size sahəsində 
qrafikin ölçülərini, Screen Display Attributes və Print 
Attributes sahələrində qrafikin ekran və çap atributlarını 
(məsələn, qrafikin çərçivəsiz əks olunmasını və çap 
olunmasını), Placement sahəsində qrafikin sənəddə 
yerləşməsini tənzimləmək olar. Sənəddə qrafikin altında və 
yuxarısında qrafikə aid şərhin, məsələn qrafikin hansı 
funksional asılılığı bildirməsi, sənəddə qrafikin nömərəsi və s. 
haqda informasiyanın əks olunması üçün istifadəçi dialoq 
pəncərsinin Labeling bölməsinin Caption sahəsində qrafikə aid 
şərhin yerləşməsinə müvafiq olaraq Above (yəni aşağı) və ya  
Below (yəni yuxarı) variantlarından birini seçməli, Text 
Caption mətn sahəsində isə qrafikə aid şərhi yazmalıdır. 
Qrafikin rəngləri isə Items Plotted bölməsinin Plot Color açılan 
rəng siyahısından dəyişdirilə bilər. İstifadəçinin istədiyi rəng 
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siyahıda olmadıqda o, Editor Color düyməsini  sıxıb, açılan 
rəng palitrasından tələb olunan rəngi müəyyən edə bilər. 
Bundan əlavə Plot Style sahəsində qrafikin stilini-xətti və ya 
nöqtəvi  olmasını,  Line Style açılan siyahısında isə xətti stil 
üçün xəttin tipini (məsələn bütöv, qırıq-qırıq və s.) dəyişmək 
olar. Qeyd edək ki, koordinat sistemində bir neçə qrafik əks 
olunmuşsa, Items Plotted bölməsinin Items Numbers siyahısı 
vasitəsilə tələb olunan qrafiki əyrini seçmək olar. Bölmənin 
Expessions and Relations sahəsində seçilmiş qrafikin bildirdiyi 
asılılığın funksiyası əks olunur. İstifadəçi bu funksiyanı 
dəyişməklə qrafiki redaktə edə bilər. Həmçinin  Add Item 
düyməsini sıxıb, Expessions and Relations sahəsində yeni 
funksiya daxil etməklə cari koordinat müstəvisində  yeni 
qrafikin qurulmasını, Delete Item düymələrini sıxmaqla 
seçilmiş qrafikin ləğv olunmasına nail olmaq olar. Plot 
Properties adlı dialoq pəncərəsinin Axes bölməsi koordinat 
oxları üçün parametrləri əks etdirir və onları dəyişdirməklə 
koordinat oxları üçün yeni parametrlər müəyyən etmək olar. 
Belə ki, bölmənin Axes  Type açılan siyahısı koordinat 
oxlarının görünüşünün tənzimlənməsi üçün, Axes Scaling  
sahəsi koordinat oxları üçün bərabər miqyas müəyyən edilməsi 
üçün1, Tick Marks sahəsi koordinat oxları üçün  başlanğıc 
koordinatın müəyyən edilməsi üçün, xAxisLabel, yAxisLabel, 
zAxisLabel2 sahələri koordinat oxlarının adlandırılması üçün 
nəzərdə tutulmuşdur. Dialoq pəncərəsinin View bölməsinin 
View Intervals sahəsində koodinatların dəyişmə intervalını 
dəyişmək olar. View bölməsinin Generate Snapshot düyməsi 
qrafikin, wmf genişlənməsinə malik rəsm faylı kimi yaddaşda 
saxlanmasınını təmin edir. 

 

                                                 
1 Müstəvi düzbucaqlı koordinat sistemi üçün həmçinin xətti və ya 
loqorifmik miqyasın müəyyən olunmasını da tənzimləyir 
2 Bu sahə yalnız üç ölçülü koordinat sistemləri üçün nəzərdə tutulmuşdur. 
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